The Lucky Immigrant: The Public life of Fortunato Rao

Edited with Introductions and Notes By Nicholas DeMaria Harney and Franc Sturino
The Lucky Immigrant: The Public Life of Fortunato Rao

Edited with Introductions and Notes by Nicholas DeMaria Harney and Franc Sturino

Multicultural History Society of Ontario, 2002
CITDPress, University of Toronto at Scarborough, 2002
All photographs and newspaper clippings courtesy of Fortunato Rao, personal collection.

Copyright © Nicholas DeMaria Harney and Franc Sturino 2001.
All rights reserved. No part of this publication may be reproduced or reprinted, other than for research, criticism or review without the permission in writing from the publisher.

This volume is a publication in the ETHNOCULTURAL VOICES series of the Multicultural History Society of Ontario. The series was established to provide a vehicle through which immigrants and their descendants could tell stories of their experiences, aspirations and achievements in their own voices.

The MHSO is a not-for-profit educational institution founded by the late Professor Robert F. Harney. The Society works to publicize the contributions of all ethnocultural groups to the development of the province and to increase understanding of Ontario’s immigrant history.

National Library of Canada Cataloguing in Publication Data
Rao, Fortunato, 1931-
The lucky immigrant : the public life of Fortunato Rao
(Ethnocultural voices series)
Based on a series of interviews between Fortunato Rao and the editors, Nicholas DeMaria Harney and Franc Sturino.
Includes bibliographical references and index.
ISBN 0-7727-6308-9


HD6525.R35A3 2002 331.88’092 C2002-900391-1

Published by the Multicultural History Society of Ontario and the Centre for Instructional Technology Press, University of Toronto at Scarborough.

Printed by DTP International, Toronto, Ontario.
# Table of Contents

Acknowledgements .................................................................................. 6

**Introductions**

The Origins of the Rao Life History  
*Nicholas DeMaria Harney* ...................................................................... 7

The Rao Life History in Historical Perspective  
*Franc Sturino* .................................................................................. 16

Map of Calabria, Italy ........................................................................... 21

Life in Italy ......................................................................................... 23

Emigrating to Canada and Early Years ........................................... 30

Working Life ....................................................................................... 38

Union Work .......................................................................................... 44

Politics, Canadian Citizenship and Labour Activism ....................... 61

Italian Community Involvement ...................................................... 75

**Appendices**

Appendix A: Fortunato Rao: Résumé ................................................. 91

Appendix B: Circolo Mogezio Social Club ......................................... 99

Appendix C: Donations by the Circolo Mogezio ................................ 101

Appendix D: The Rao Family Crest .................................................... 106

About the Author ................................................................................ 107

Endnotes ............................................................................................... 108

Selected Bibliography ......................................................................... 119

Photo Gallery ....................................................................................... 121

Newspaper Clippings .......................................................................... 139
To Luckys’ parents, Annunziato and Concetta Rao
Acknowledgements

This book grew out of several enjoyable afternoons over coffee and biscotti during which Fortunato Rao and the editors discussed the experience of immigrant workers in Canada. The Mariano A. Elia Chair in Italian Canadian Studies at York University, which has done so much to encourage research activities and publications in the field of Italian Canadian studies, helped nurture and develop this book by supplying generous funding. We also benefited greatly from the timely financial assistance of the United Steelworkers of America that made this publication possible. At the Multicultural History Society of Ontario, Carolyn Braunlich provided nuanced and precise copyediting and administrative support, while Carl Thorpe and Dora Nipp offered astute suggestions and encouragement. Without the generosity and creativity of Leslie Chan and William Barak at the Centre for Instructional Technology Development of the University of Toronto at Scarborough this book could not have moved beyond the manuscript stage to print and an electronic version. The editors would like to thank Robert Ketchen for his patience and design creativity and Joan Campbell for her copyediting assistance. Lalita Sood and Monica Stellin provided invaluable critical readings of parts of the manuscript. Stefano and Elizabeth Harney offered encouragement at various stages. If Corrado Paina had not introduced Nick Harney to Fortunato Rao it is unlikely this book would have been possible. Tina Rao always welcomed us with warmth, patience and exquisite cuisine. To all these wonderful people we say thank you and absolve them of responsibility for any errors we may have committed.
THE ORIGINS of THE RAO LIFE HISTORY
Nicholas DeMaria Harney

THIS BOOK RECOUNTS THE STORY of the public life of Fortunato “Lucky” Rao, a post-World War II Italian immigrant from Calabria, the southern-most peninsular region of Italy. Rao’s life is the story of an immigrant who found his place in the world of work, community and social justice in Ontario.

I first met Lucky while I was doing fieldwork for my doctoral dissertation in 1994. Trying to glimpse the worlds of Toronto’s Italians, I had been looking for gathering places in the urban landscape to meet people of Italian heritage. These journeys into urban fieldwork took me to a few worksites, community festivals and political rallies, but mostly to places of leisure and family events such as cantinas, backyards, espresso bars, banquet halls and bocce courts. One evening I had offered a new acquaintance, Corrado Paina, a ride to the suburban subway stop where he was to meet a labour leader – Fortunato “Lucky” Rao. Acting as an Italian community liaison for the New Democratic Party, which governed Ontario in the first half of the 1990s, Corrado had a keen sense of the many people who might interest me and so he suggested I exchange cards with Lucky. That night Lucky said he would be happy to be interviewed.

After a month or so I arranged to meet at Lucky’s home near Villa Colombo, the Home for the Aged built by Italian Canadians in the early 1970s. As I would find out later, Lucky was a member of the admissions committee for Villa Colombo and his social club made regular donations to support it. This northwest Toronto neighbourhood is heavily settled by Italian immigrants and had become a central point of reference for things Italian in the city. As I turned onto Lucky’s street from Dufferin Street that spring morning I was struck by the organized landscapes of each house. From my own observation and interviews I already knew of the practicality of worker-peasants: they expected the yards of their homes to be productive, not merely decorative. I could glimpse the land turned for planting, the
grape arbours and fruit trees in the backyards, the clean cement porches enclosed by wrought iron fences. Yet Lucky’s home stood out even among these. It was a modest but comfortable two-storey house with an addition at the back. Unlike the other homes which tended to use the back for planting, Lucky’s front yard was covered with twelve-foot apple, pear, cherry and peach trees, some grafted to bear two or three varieties of the same fruit, and all planted within a meticulously manicured grass lawn. Later on, Lucky told me a story that linked his passion for his land with his left-wing politics and support for the NDP in the middle of a political riding whose Italian, Jewish and other immigrant voters usually supported the Liberal Party, provincially and federally. A neighbour asked him why his fruit trees were so healthy and his gardens yielded so much food. Lucky said he replied with a grin, hoping to provoke his neighbour: “Because God smiles on those who support the NDP.”

The backyard, I would discover, allowed one to walk out from the first floor to look over a swimming pool and an elaborate and bountiful garden filled with leafy greens, zucchini, tomatoes, basil, eggplant and bean stalks rising twelve to fourteen feet, thriving vegetables and fruits supported not by rusting metal trellises or decaying wooden two-by-fours but by clean, strong and light aluminium poles Lucky had acquired from friends through his years with the Steelworkers. Over the years I would come to know that a visitor to Lucky’s home always bore away a gift of fruit, vegetables or homemade wine that Lucky himself had been given by a cousin.

The passionate shaping of the outdoor landscape hinted at the vitality, energy and passion I would discover that Lucky brought to all aspects of his life. When I entered his house through the side door to the cool, clean tiled floors of his living and dining rooms, I knew right away this would be no normal interview. The walls were thickly covered with framed photographs of Lucky with his wife Tina, the children, or family and friends, and dozens of framed diplomas and honorary certificates from labour unions, the Catholic church and governments both in Italy
Introduction

and Canada. Finally, displayed prominently on the living room wall was an oil painting of his Italian hill town, San Giorgio Morgeto, in brilliant rusts, yellows, and ochre set in the surrounding greenery of the valley below.

Lucky asked me to sit at the dining room table, which was draped in a beautiful lace tablecloth and further protected by a thick, clear, plastic cover from Lucky’s neat but abundant mounds of paperwork. Over his shoulder, a fax machine on a side table screeched with activity and dozens of videotaped recordings of his Labour Show were piled nearby. The dining room table evidently doubled as his office desk, stacked with workers’ claims, government regulation manuals, photographs of Italian community events and clippings from the Corriere Canadese, Lo Specchio, La Gazzetta or Vita Italiana.\(^1\) Assembling these bits and pieces of newspapers, often paper-clipped with a few photocopies of key articles, I would find out, was another passion of Lucky’s. He is an inveterate collector of material that he uses to illustrate his passions to others. That first taped session we had in his dining room over an espresso and biscotti prepared by Tina, his wife, became the inspiration for my wanting to know more about Lucky’s experiences and laid the foundation for this book.

Lucky was different in many ways from others I had interviewed. First, the narrative structures he used in our first conversation were clear and precise. He knew the story he wanted to tell and it seemed as if he had rehearsed it in his thoughts dozens of times. It was the story of an Italian immigrant from San Giorgio Morgeto who found a home in Canada through his work in the Steelworkers and his passion to help people in their fight against exploitation and their efforts to navigate the impersonal, legalistic, bureaucratic rules of the state. His story, as you will see, is not a sentimentalized recounting by acquaintances, a reflective, introspective retelling of family life nor a self-aggrandizing account of his role in every major event confronted by Italian Canadians and the Steelworkers over the last fifty years.
Instead, it is an ardent statement by a man whose passion lies in fighting for the rights of humble and ordinary working men and women.

Lucky is a man who extends his sense of paesi and paesani beyond the locality of the town to encompass anyone in need. His early experiences in San Giorgio exposed him to both the kindness and meanness of those in positions of power and moulded his later actions. Forced to work by the untimely death of his father in a house fire, Lucky had to support his mother, brother and sister. In postwar southern Italy, left with the marks of Allied invasion and German retreat, work was scarce. Government officials, however, because they knew of his family’s tragedy, let him work longer than usually permitted clearing bush, containing fires and fixing roads with il forestale. At the same time, city officials in San Giorgio Moregeto gave Lucky an early understanding of exploitation when he saw that his mother received assistance at il municipio only when she brought a gift of eggs and a bottle of liquor. If, as Tonkin says, “the past is not only a resource to deploy, to support or assert a claim, it also enters memory in different ways and helps structure it” then Lucky’s early experiences with inequality shaped his understanding of social life and influenced his life choices.

With only a little formal education in Italy and no knowledge of English, Lucky arrived in Toronto in February of 1952. He settled in the College Street area of the city, an area of considerable immigrant presence, into the supportive world of paesani, with an obligation to support his mother and younger siblings back in Italy, a pair of construction boots and a desire to work. In his first ten years in Toronto, Lucky initially laboured in construction, then in manufacturing and finally in a foundry, but he found his calling as a union organizer and advocate for the less privileged—work that would occupy his time for the next forty years.

The small hill town of San Giorgio Moregeto in the Le Serre Mountains on the edge of the Aspromonte, Reggio Calabria, sent hundreds of its people in search of work after the war. Many
of these migratory travelers made connections with kith and kin in other parts of the industrializing world, re-establishing what historians and social scientists have termed chain migration networks. These had existed since the late 19th century as southern Italians left Italy in search of opportunity for themselves and their families. Fortunato could have followed fellow paesani to South America, Australia, or northern Italy and other parts of Europe. Instead, he followed a cousin, who offered to sponsor him, to Toronto, thereby reinforcing a link to Canada that his grandfather had made in his search for work at the turn of the century. Ontario’s need for labour and, more specifically, Toronto’s requirement for construction and manufacturing workers, created an opportunity for immigrants after World War II. Lucky was just one of many who came in 1952, at the beginning of nearly twenty years of massive Italian migration to Canada.

Part of the charm of ethnographic fieldwork for me as an anthropologist is to encounter people such as Lucky whose everyday lives cross-cut so many activities and social worlds. The models of the social analyst cannot contain the full humanity of such people who let us into their lives. A brief recounting of Lucky’s various social worlds will give the reader a sense of this man’s energy and complexity.

The conjunction of Lucky’s work life and union activity with the United Steelworkers is intriguing and provides a useful example with which to explore the relationship among immigrant labour, unions and, ultimately, the New Democratic Party (NDP) in Ontario. However, the man refuses to be easily categorized. In the 1960s and 1970s Lucky was the driving force behind a religious organization that celebrates the two patron saints of his Calabrian hometown: San Giorgio and San Giacomo. Moreover, since 1974 he has been the President of the Circolo Morgezio, a social club for people from San Giorgio in Toronto. The club meets annually for a dinner dance, participates in the Good Friday procession centred around St. Francis’ church in the heart of the College Street “Little Italy” neighbourhood and raises money for
charities in Toronto and around the globe.

Lucky’s social worlds extend beyond the paesi and the union. Through his San Giorgesi club he participates in activities with immigrants and their children from Calabria in the greater Toronto area. In the 1990s, he was part of a group of people of Calabrian heritage who unsuccessfully sought Ontario government support to build an affordable housing complex for seniors, a Casa Calabria, which would also have housed a cultural centre and banquet hall. It was to have been a focal point of Calabrese activity in Toronto, fostering cultural and economic linkages with the Region of Calabria.

Lucky has also participated in broader Italian Canadian projects such as the work of Villa Charities. A community-based cultural and social service association that runs Villa Colombo, a Home for the Aged, apartments for seniors, a cultural center and numerous programs, Villa Charities is a hub of Italian Canadian social life. Lucky was also active, through the Steelworker’s union and his social club, in encouraging and sponsoring Canadian citizenship classes for immigrants from all backgrounds. The citizenship ceremonies themselves were held in community centres and union halls, away from the confines of Ontario citizenship courts whose institutional formality and impersonal legality intimidated some immigrants.

One way Lucky pursued his citizenship interests was through an innovative weekly community cable-television program called the Labour Show that he created in the 1970s. He hosted it every Sunday evening for several decades. Through the show’s weekly themes, workers could find out more about the practical issues that they faced every day in the workplace. How would proposed legislation in the provincial parliament affect the livelihood of workers? Weekly topics included everything from overtime to sick leave to how to find help for chronic pain that was caused by a work injury. Where might an immigrant worker go to upgrade her skills, take English language classes or apply for citizenship? The show spoke to the everyday needs
of people in a practical, straightforward way and Lucky's clear, forceful, accented English had the effect of putting guests at ease. He would explain complex issues such as changes to the Canadian Pension Plan or workers’ compensation rules in a no-nonsense, accessible manner. Lucky would invite not just government officials or frontline service providers in the community as guests but also ordinary workers who offered practical advice from their own experiences facing challenges in the workplace or adjusting to the requirements of new legislation. Lucky's guests included politicians, workers, doctors, union leaders, community activists, fellow San Giorgesi and artists. Here, too, Lucky used the opportunity to link the frequently adversarial and difficult world of work with an underlying theme of shared humanity and the pleasures of community life. Annually, a show chronicled the San Giorgesi dinner dance, emphasizing the way communal pleasure could lead to support for those less fortunate at home and abroad through charitable donations raised at such events.

Lucky's view of the world and of his place within the circuits of Italian Canadian community activities make his story crucial for creating a fuller, more textured picture of immigrant life. His is not only the story of a labour radical nor of a peasant greenhorn sent on a migration journey by circumstances. Fortunato “Lucky” Rao reminds us that in the flow of labour to capital there are creative and complex people whose stories need to be heard.

In our first meeting, Lucky told me that he wanted to write a book and asked if I would help him. In the middle of fieldwork for my doctorate, I could not imagine taking on another project but I promised to give him some guidance. I had already encountered numerous Italian immigrants who wanted to have someone write their life stories. I taped interviews with Lucky three times over a four-year period, but also had many informal sessions during which I would take handwritten notes or simply come away with a batch of photocopied newspaper accounts of his social club events, provincial politics or information about injured
workers and government programs to assist them.

While I was working on my doctorate, I was intrigued by the way in which local worlds and attachments intertwined with global imaginations and ideas among Lucky and his fellow San Giorgesi whom I met in Toronto. Later, as a postdoctoral fellow of the Mariano A. Elia Chair in Italian Canadian Studies at York University, I had the opportunity to explore more fully the vibrant world of Lucky Rao. After compiling the taped interviews with some handwritten notes of informal conversations with Lucky into a first draft manuscript, I asked Franc Sturino, my colleague at York University and an expert on chain migration and Calabrese migration in particular, if he would comment on the work and provide editorial advice. From there, we decided to work together to publish the manuscript, augmented by introductions and end-notes. We reworked the interviews along thematic lines to enhance the accessibility and clarity of Lucky’s story. We have also tried to offer a glimpse of Lucky’s impressive holdings of archival materials by placing in the text two sections of photographs and newspaper clippings from his personal collection.

The Appendices include two documents that may serve to present Lucky and his fellow San Giorgesi to the wider world. Appendix A is a prose-style résumé by Lucky, himself, that he distributes to those interested in the work he does. It shows Lucky dividing his life’s work into sections that reveal not only his commitment to helping others but also his desire to understand how to survive in a modern, bureaucratic state. Appendix B is a brief history of San Giorgio, Calabria, produced by the executive of Lucky’s hometown club, Circolo Morgezio, of which he is the president. This history was distributed to all club members in 1991. Appendix C details the extensive and varied list of donations to charitable causes made by the Circolo Morgezio. The impressive acts of consistent generosity displayed by Lucky and his fellow San Giorgesi are a useful corrective to the widespread dismissal of southern Italian immigrants as uniformly parochial. Appendix D is a reproduction of the Rao coat of arms that Lucky
hired a genealogical firm in Italy to find for him over the last few years. It demonstrates Lucky’s interest in establishing his place in the world, past and present.

In a review of an oral history produced in England in the 1970s, Raymond Williams commented on the presence of the author in the production of meaning despite the author’s literary convention of claiming that he intended to let the people speak for themselves. The author, the listener, is present in the text by the selection, editing, spelling and sequencing of recorded speech. The author structures the conversations with the person being interviewed with his questions. Anthropologists have argued for some time that the life histories we gather are part of a process of dialogue and collaboration, and we, as much as those we interview, are actors in the creation of the text.

In the case of this life history, Lucky read the manuscript at various stages, provided some commentary, and corrected facts, dates and names. Each time the manuscript was redrafted we asked again for his comments. He made detailed lists of topics he wished to cover. This was not a random selection of topics that happened to come up in casual conversation about a person’s life but focused on union organizing, Canadian citizenship, workers’ rights, ways to access government services, the New Democratic Party and his San Giorgio social club. As editors we encouraged Lucky to elaborate on certain themes or stories that reflected our interests in the field of migration studies. Although the final approval of the text came from Lucky, the editorial decisions were very much collaborative.
The Rao Life History in Historical Perspective

Franc Sturino

Over the past thirty years within the scope of North American immigration studies, there has been a burgeoning of research dealing with the Italian immigrant experience. Italians have joined others such as the Irish, Jews, and Slavs as one of the most studied of diaspora peoples. Although Italian immigration and ethnicity has been investigated from the vantage point of various disciplines—sociology, psychology, history and anthropology—the attempt to understand the Italian immigrants on their own terms has been relatively recent.

Italians first came to the attention of social scientists as a consequence of the great wave of mass migration at the turn of the twentieth century. Reflecting both the anxieties and assumptions of superiority on the part of the established Anglo-Protestant mainstream of the time, Italians, like other new groups from Southern and Eastern Europe, were essentially seen as part of a pervasive “immigrant problem.” The “New Immigration” was closely linked to the growth of urban slums, crime and immorality, and political subversion. While such social problems were, at root, the consequence of unregulated capitalism, it was the new immigrants who were blamed. The solution to the multi-pronged immigrant problem was aggressive assimilation within North America and draconian restrictions at the borders. It is telling that Italian immigrants were a favourite topic of research within the emerging new profession of social work and, indeed, remained so well into the 1950s. Nonetheless, due to eventual integration and upward mobility, after World War II the linkage between Italians and various social problems was broken—except for one. Despite a great deal of evidence to the contrary, the stereotype that Italians share a predisposition for crime and violence has remained stubbornly tenacious; at least in part be-
cause it has proven extremely profitable to the media and entertainment industries.

In the 1960s, the Black civil rights movement in the United States and French-Canadian nationalism in Quebec rocked the cultural and political foundations of North America. A major result of the new assertiveness of large, newly-powerful minorities was that the discourse of cultural pluralism replaced the diktats of assimilation. In Canada this resulted in an official government policy of multiculturalism in 1971.

Closely connected to these developments was the sea change that occurred in the realm of scholarship. In the 1960s, immigrants, along with other minorities, started to be considered on their own terms. Increasingly, an attempt was made to understand the immigrant experience from within rather than judging it from without. With regard to the Italian case, social historians led the way in breaking new ground. In Canada work on Italian sojourners and immigrants was pioneered by Robert F. Harney, founder of the Multicultural History Society of Ontario at the University of Toronto; in the United States, it was originated by Rudolph J. Vecoli, who established the Immigration History Research Centre at the University of Minnesota. Their endeavours quickly attracted a new generation of scholars who, over the decades, have produced an impressive array of research papers, articles and books on Italian migration. Scholarship has included work on the paese background, the role of padroni and kin, the ambiente of the Little Italies, the influence of political radicalism, labour movement participation, and family economy.

Given the relative recentness of Italian mass migration to North America—in the United States between 1890 and 1920, and in Canada between 1950 and 1970—it is surprising that only a handful of life histories or autobiographies exist. In part this has to do with low literacy rates of early immigrants and the humble background of the great majority, which led many observers to think their experiences were not worth recording. But it also reflects the general attitude of academics who
believed that they could better represent the reality of the immigrant experience than could the immigrants themselves. Even the younger scholars, while shattering ethnocentric stereotypes, have often erected their own rarefied images. Italian immigration is frequently seen as a Via Dolorosa by which simple peasants are transformed into self-conscious proletarians, Southern Italian “backwardness” is transmuted into enlightened liberation, and heavy-handed patriarchy is overthrown by individualism and feminism. The human reality of complexity, contradiction and nuance is often missing from these studies, though their fundamental merit of presenting the immigrant experience from the “bottom up” cannot be denied. From studies which stressed the historical actor’s point of view, it is an appropriate logical step to having immigrants speak for themselves. But here the tools of the social historian have reached their limit and the skills of the cultural anthropologist are required, both in order to make the transition from the past to the present and in order to engage in a meaningful dialogue with the immigrant as a living, rather than historical, actor.

The relevance of the present life history—the story of Fortunato Rao—is that at various points it breaks the moulds in which the Italian immigrant experience has been cast: both the pre-1960 mould of the immigrant as a problem to be solved and the more recent mould of the immigrant as a person to be liberated. Fortunato’s family background is not that of the Southern Italian peasantry, but, as he himself labels it, “middle-class.” Upon emigrating to Canada in the early 1950s, he settles in Toronto’s Little Italy, but easily negotiates with the wider society, as evidenced by his early reconnaissance of shopping bargains outside his “urban village.” Within the world of work, he rises to become an effective union and political organizer, but holds fast to his ethnic roots, especially as defined by loyalty to paese and popular religion and piety. But even here the mould is broken, for while he is president of his Calabrese hometown society, the club is open not just to co-nationals but also to non-Italians;
moreover, as well as organizing paese-centred events, the club engages in fundraising for charitable causes that are national and international. There is little doubt that “Lucky,” as his friends call him, is proud of his identity as an honest workingman and assiduous union/political organizer, but he is equally proud of his ancestral lineage stretching back to the seventeenth century, which he commissioned to be researched by an Italian heraldic institute.

Now retired, Fortunato still resides in the house he bought decades ago in a low-density suburb that has become a middle-class neighbourhood for Toronto’s Italians. Over the years extensive additions have been built to the original bungalow, and in the back yard there is a characteristically Italian vegetable garden, replete with beanstalks clinging to long poles and overhanging grape vines supported by lattices.

Fortunato Rao’s life history provides a sense of just how closely Old World allegiances were intertwined with new relationships in urban North America. The on-going debate as to which was primary in shaping the immigrant experience of overseas Italians: class or ethnicity, economic or social factors, almost appears nonsensical given the manner in which the two spheres overlapped in Lucky’s life. Furthermore, while Lucky’s history as a working class, social democratic activist is clear, it is equally clear that he accomplished significant upward mobility during his career. This mobility is reflected both by his later socio-economic status and in a lifestyle that is, at least partially, within the middle-class mainstream. In academic terms, while Italian immigrants could undergo “proletarianization” within the North Atlantic economy, they could also undergo “embourgeoisement,” and in all likelihood, many experienced both. Individual immigrants, rather than falling neatly into the academic’s categories, are generally multi-layered and multi-dimensional, and often self-contradictory.

It would be presumptuous, of course, to argue that an immigrant life history can “prove” this or that thesis, theory or
ideology. In fact, such biographies “prove” little, except that there are endless variations on the theme of immigration. The present life history, likewise, does not “prove,” but rather vividly illustrates the depth and range of many immigrant lives. It is certainly a testament to Lucky’s determination to make the best of the abilities bestowed on him by nature and the opportunities provided by fate. What rings true in the Rao biography, echoing many other Italian life histories, is the conviction of strong, definite values (such as productive hard work and forthright honesty), the commitment to community (kin, paesani, and other co-nationals) and the belief in a realizable, better future for family, community and polity.

It will be noted that in Fortunato’s life history very little is reported about individual problems, interpersonal strife or even family relationships. It is obvious that Fortunato wishes to present first and foremost his public life and struggles, not the trials and tribulations of the private sphere. While some might perceive this as a lack, it is indicative of the strength of character and sense of dignity reflected in other biographical accounts of the immigrant experience. Indeed, in an era given to endless personalizing, psychologizing, and facile public confessions, it is both refreshing and reassuring that, at least for those of a certain generation or cultural formation, a proper distinction can still be made between public and private. Throughout his account, even when discussing heated issues or adversaries, Fortunato remains ever the gentleman, and indeed the highest compliment one can be paid by Lucky (when he is not being ironic) is to be called a “gentleman,” a word he often uses when judging others. It is evident that, ultimately, what matters to Fortunato is not one’s ascriptive status (ethnicity, class, or gender) but rather what used to be called one’s “character.” Lucky judges the people he comes across on their individual merits, and treats them accordingly. By example, he invites the reader to do the same when encountering him. In this sense, Rao’s account is an exercise in freedom, the freedom of the individual actor who refuses to be reduced to an academic category.
The Lucky Immigrant: The Public Life of Fortunato Rao
I am from San Giorgio Morgeto part of Calabria in the province of Reggio Calabria. It is a beautiful place. I recall before the Second World War people from the north coming to my place. People with cameras taking pictures. I laughed. What did they see that was so special about this place that they wanted to take a picture? Until I was a teenager I did not appreciate the beauty of my birthplace. Edward Lear, an English writer and painter who went everywhere in Calabria, described the city of San Giorgio Morgeto and the main spots in Calabria. He went there in the 1800s shortly after an earthquake in which everything was destroyed in Calabria. The only thing that was standing in Calabria was San Giorgio Morgeto and its surrounding area. He described not just the city that had survived the earthquake but he observed the customs of the people also. The men and women he described as very good looking. Even in the 1940s when I was young, the older people dressed the way they had when Lear was there. They had white socks made of wool, special pants that went to the knee and were closed with buttons and not a zipper, and a vest made of velluto [velvet] in brown and black and you could see the stitches. Many of them had gold earrings. I remember I once asked an older man why he wore a gold earring. He said it helped to keep his vision clear as he got older.

We lived at the entrance of the city in le case populare. Here the comparison is with public housing. Not equal but close. There, to have una casa popolare at that time, you needed to be lucky. Here anybody can get Ontario Housing, more or less anyone who is on the waiting list will have one.

My grandmother on my father’s side owned some land in the countryside. We used to go in the summer to eat and cook there. It was a nice piece of land in the summer. My grandfather, also known as Fortunato Rao, was an artigiano who worked the land. He was in Canada in the early part of this century. He worked on the railroad near Guelph and Georgetown where
many Calabresi worked. He returned to Italy in 1913. I remember a story about one of those blessed card-reading gypsies who said to him that if he ever bought a black animal he would be in danger. The gypsy told him his young son might face some kind of danger in the forty-sixth anniversary of his life. When my grandfather returned home from Canada the first thing he did was buy a black donkey, not brown, not red or turquoise, but black! My grandmother said, “but you should not buy black animals.” He replied, “Don’t listen to those stories.” He then went to an animal auction and bought a number of black chickens. In August 1914, he took some people to the Adriatic Sea and on his return, near Zappino, an area not far from San Giorgio, he climbed the side of the mountain to pick up some wood. Even though he had a brand new pair of boots he slipped on some gravel and fell 200 metres down onto the road. The donkey returned home by himself. My father was twelve at the time my grandfather was killed on August 6th, 1914.

My father, when he was single, lived and worked in Torino [Turin]. He was working for Fiat, I think in Torino but then he moved south because he preferred to work near home. Once they had built the railway near San Giorgio and he heard about it, he returned home around 1924. When he applied to get a job on the railroad, he was lucky to get one because they were sought after. At first, he was on the train checking tickets, but he didn’t like the job because he missed being home with his family. He asked to be transferred to the “Union Station” at San Giorgio Morgeto and Polistena. He was then home every night with his family for dinner, and much happier.

In short, he was working for the railroad—at that time, the private local line Calabro-Lucane, not the Ferrovia dello Stato. The track is a metre wide but the lo stato is two metres, so they have a bigger boxcar, engine, etcetera. The Calabro-Lucane is five or six cars long. The State train is maybe ten or fifteen cars long and goes further. The Calabro-Lucane line goes a shorter distance. The run was about thirty-five kilometres
from Gioia Tauro to Cinque Frondi. Gioia Tauro is at sea level in Reggio Calabria, at the same level as Rosarno, Palmi, and Villa San Giovanni. Then it branches out into the heart of Reggio Calabria—Gioia Tauro, Gioia Tauro Est, Villa Cordapatri, Rizzigoni, Cannava, Amato, San Martino, Taurianova, Cittanova, San Mauro, San Giorgio Morgeto, Polistena and Cinque Frondi. I just mention the big stops. The Gioia Tauro line was going to Palmi, Sinopoli and Via di Seguito, then branching out into l’Aspromonte. This line was branching more or less north and Calabro-Lucane was, I think for the first thirty years, a private line but today I think it belongs to the state. I am talking between 1927 and 1948, when my father died. First, he was a conductor and second he was working at the station either doing the tickets or checking the people who were going aboard as a stationmaster.

I was born 1931, July 12th. It was Sunday that day. Whenever I go back to San Giorgio Morgeto I return to the spot where I passed the best days of my life playing soccer and a game like bocce. We were a middle-class family. My father had a good job and each year we took a vacation. We went to the north of Italy almost every year—to Torino, Roma, Genoa, Milano. I had a good picture of Italy when I was young and even during the war we went for those trips.

Before I was born, before the war, Italian people had emigrated to Canada, the United States, South America and Europe to find work. Some stayed and some returned to Italy. They bought a piece of property and built a house. In those days Mussolini was calling people back from North America and the Depression. He was offering jobs. The Italian lira was doing well. Mussolini had everything under control with a really closed fist. I remember the war was tough, but my father was still around so we managed. It was after the war, when he died, that we faced starvation. He wasn’t called up for military service because he worked on the railway.

During the war it was hard to find bread or pasta. What-
ever you needed you bought on the black market. Nobody was against or for Mussolini that we knew. If you spoke against him, it could lead to bad things. My father more or less joined the crowd and said “Viva Mussolini.” At first, Mussolini was popular because of what he did for law and order and education. The people were working and there was no need for war. The first day of the war my father said that it was crazy. Italy was doing well. Many people returned to Italy who had gone to Abyssinia.

I saw Italy turned upside down—the bombs, the planes, the disasters—everything that happened in Italy during the war. The situation was very bad. I never forgot one day after a stay in Torino we were in Naples on the train and everything was shaking. I said to my father, “What is that?” He said it was nothing; maybe the weather was bad. Eventually, the train pulled out. Not too far from the railway station, there was a tunnel and we stopped there. I asked my dad, “Why are we stopping here?” He said, “Well, I guess there is not enough gasoline in the engine.” After a while we continued to Calabria. I noticed a train with holes in the cars when we got off the train at Gioia Tauro. I said to my father that these trains look like someone had shot at them. He said what had happened was that bombs had fallen, exploded at the main station in Naples, and the shrapnel had made the holes. The train was lucky. After our train left, they destroyed “Union Station” in Naples.

When I was in Calabria they dropped bombs many times nearby, at Messina and Reggio. All the buildings and the ground were shaking during the war years. The planes were bombing nearby, not in our city but nearby. During the day we heard the noise while during the evening we could see fire, smoke and explosions. I remember the windows shaking because only a few kilometres away the bombs were dropping in Cittanova. Under the circumstances at that time, we were interested in saving our skin; school became secondary.

My mother was due for surgery during the war in Messina. That night the Americans destroyed the hospital. I do not know
how she managed, but she returned home. When we heard about the hospital we thought she had died. The evening of the following day she returned home dressed in her pyjamas and wrapped in a blanket. She left everything. She never had that surgery and she was always in poor health after that.

The war devastated everything and many families that had two kids or five, six or eight, found it was difficult to survive. During the war and after there was a mercato where you could buy used pants and shoes because that was all you could afford. In one house there were four brothers. Two were at home and two were working somewhere. The two who were at home were three years apart. One used to go to church with a pair of pants and sweater and the odd time he wore a jacket. He returned home and took off the clean shirt and pants and gave them to his brother so he could go to church. This happened even for girls. The economy was bad. It was really a miserable life—all of this because of the war.

After the war, the situation was bad in Italy for everyone.16 The bombs screwed up everything. Italy had to be rebuilt. There were people starving. You could not even buy salt or bread, the essential stuff was not there. Local farms were producing and doing fine, but the local people were starving. Local farmers used to make their own bread. We had our little piece of land to produce vegetables, but no grain for bread or pasta. There were a lot of kids dying from starvation but also there was no medicine. We were like a third-world country right after the war.

In 1948, my father had an accident in our house. A fire burned everything. My father went in, but he did not come out. The roof and ceiling collapsed and the doors were closed. Antonio Montenegrino pulled my father out and we took him to the hospital at Taurianova. He died in two days, on Holy Saturday, the 27th of March, 1948. After my father’s death, the situation was bad. There were four of us: my mother, my sister who was three years younger and a brother who was seven. We lost my father, the house, everything. We moved into my grandmother’s
house after ours burned down. I became, at the age of sixteen-and-a-half, the breadwinner of the family. We still had a plot of land in the valley, which we made into a garden for our own use. We did not sell. My uncle gave me another piece of land in the contrada of Pontani because he was childless. But it was not enough to sustain anybody. I have no intention of selling it.

My mother, my sister, my brother and I were left to struggle. I was the oldest at sixteen. I had to work for a living. The war had turned everything upside down. I had to work. I never forgot the times my mother went to City Hall in order to get a birth certificate or a death certificate or whatever. If she took a bottle of liquor she was served. If she brought food, like twelve eggs, she was served. If she went with empty hands, she was told to return next week because they said they had no time to do that today. I really resented this because I went through, as I said, a period of starvation. Many times I was not able to sleep because my stomach had such pain from being empty. I was scared at that time. I thought this was complete exploitation going on everywhere in Italy after the war. These people had good salaries but they used to suck the blood of the ordinary people, poor people too. I thought this was not fair.

Rome sent some money to the south and then divided it up. I worked for the forestale in a work gang sponsored by the federal government to maintain roads, make new ones and replant trees for the forest. Each person used to work three months a year to rotate the work. I was the only one who squeezed six months out of the system because the people in charge knew my family was living in hell. They decided to let me get a little more paid time so my family would not starve. I was one of the youngest working there. Every two weeks, I gave my cheque to my mother. With it she bought salt, oil, beans, potatoes and a little bit of bread. Many times I did not keep any money to go to the movies; my pockets were clean of spending money. It was difficult. Neither my brother nor my sister was working. My mother was not well. Many evenings I went to bed
without being able to sleep because there was no food in my stomach. I am not ashamed to say this. The experience gave me consideration for others. I was for the Repubblica. I was too young to vote for the referendum on the monarchy. In the elections, if I could, I would have voted for a leftist party, or the social democrats. I am clear on that.

As a result of all the starvation and problems, lots of people were emigrating in the years 1945, 1946, and 1947 to Australia and South America. Canada, not until later.

I had the intention to leave Italy after my father died in 1948 to support my family. But I stuck around for a good three years after he died. One day I went to a nearby city, Polistena, which was a recruiting centre, to make an application to go somewhere in South America. I did not know the difference, whether it was to Paraguay or Uruguay. The office was closed. Those gangsters! They had sucked the money from the people as a fee to arrange the emigration but they took off before doing anything. A lot of people applied. I was another sucker who went. You had to pay to get the application, but I was lucky they were closed when I went. These were fly-by-night operators. They were funny like a three-dollar bill. There were a lot of San Giorgesi in South America, everywhere. The people, they emigrated every day of the week. A lot of people went to the north of Italy but instead I wanted to go overseas. I had been up north during the war and everything was upside down there. I had a friend in Australia who said he would sponsor me to come there. I had cousins in Canada who offered to sponsor me too. I received the sponsorship and necessary papers in 1951 and arrived in Canada in February 1952. I was twenty-one years old.
Emigrating to Canada and Early Years

I had some opportunity to work in Australia and I had some opportunity to work in South America, but there was no work in Italy. It was a disaster and people emigrated to wherever they could. Some of them went to northern Italy. Meantime, the government was sponsoring me to go in the army. I’d already gone for the inspection. So then I had a friend who went to Australia and we were good friends. He said, “As soon as I get there I will do everything I can do to get you over there.” My cousin came from Canada and said, “If you wish to come I will sponsor you.” And I said, “Do it fast.” In no time, in 1951, he sent me the call. My cousin was here in Toronto and he sponsored me. When he asked me whether I was willing to come, I said yes I would die to come. I came very fast. Luigi Rao sponsored me. He came here a year and a half before I did. I came in 1952 and I believe he came in ’50, early part of ’51. He was doing not too bad. At least he was working and surviving. He was the first cousin of my father. They were the sons of two brothers. He was a bricklayer and there was not much to do in Italy. Even if you were lucky enough to have a job, they would withhold pay month after month. You worked on credit. My cousin said this is not the way to go and left for Canada.

In 1951 I went to Rome and Canadian consular officials gave me the visa for landed immigrant status and then on 7th of February of 1952 I left San Giorgio and headed for Naples. From Naples I took the boat Saturnia. The voyage was killing me. I felt sick and I said, “I will return home when we hit Palermo.” Then the boat stopped and I felt better and I said, “Well, let’s forget about getting off, I can make it to Canada.” I did not think that stopping was any better than travelling. When we reached Halifax I was not able to stand on my feet; I had been seasick from Palermo. I could not eat anything. I was the only one from San Giorgio on that particular trip.

I was surprised when we got the train from Halifax to
Toronto. In Italy I was travelling by train all the time. The train was in really bad shape here in Canada. Then, the first thing we had was sliced bread which is soft. I said, “My God, this bread is good for people who have no teeth, but not for me.” We were used to homemade bread and I thought this was awful. It took two days from Halifax to Toronto and I believe I got here on the 21st of February. When we got to Toronto, Luigi was there at Union Station. It was a different world altogether. It was cold when I got here. In Italy it was warm with no need of a coat. It was February and I said, “Jesus, the weather is rough.”

The first place I lived at was 97 Brunswick Avenue. A Jewish family owned it. We lived on the top floor. In July the heat was awful. We had to go upstairs from the entrance with our shoes in our hands. When we went out we put our shoes on outside. I was renting there with Luigi and Nunziato. Then we moved to 148 Clinton Street, north of College Street and south of Harbord Street. There was an Italian, a paesano, by the name of Furfaro, who owned that house. One of his sisters, Piovena, had married someone who had been born here, Jim Alvaro. Jim had gone back to Italy to get married in 1947. Right afterwards they sponsored Piovena’s family, and Jim and his brother-in-law, Giorgio Furfaro, bought the home together.

Anyway, I opened my suitcase that first day because I brought a bottle of liquor for my paesano from San Giorgio. This other cousin, Joe Magnoli, spotted my construction boots in the suitcase. He said, “What do you have those shoes for here in Toronto.” I said, “My dear cousin, I came here to work.” He was pulling my leg again and said, “Don’t you go to work in the office or some place?” I said, “My real aim is to go into construction so I came well-prepared.” I used those shoes; there is no question about it.

I never forgot Giuseppe Magnoli’s wife, Speranza Magnoli, who made a beautiful supper on February 21, 1952. Everything was there on the table: steak, pasta, you name it. I was really hungry, but I had to wait until after Joe Magnoli gave me a
speech for twenty minutes. I was listening to him: “Don’t forget that you left your mother in Italy who is depending on you. You left a younger brother and a sister. They depend on you. Don’t think that you are here and they are forgotten. Try to hang out with people better than you or at least at par with your level, not with others, because you can end up in trouble or jail. You are here to try to build yourself up. Don’t burn what you earn. Be a good administrator of your cheque. Don’t forget that money is round—if you are a lousy administrator, this money will roll away from your hands.” My reply to my cousin was, “I am in Canada and I have the intention to work and to honour my family and the community. I thank you all for your help towards my family by bringing me here so I can earn a living.”

Another cousin sponsored my cousin Luigi who got here in the 1950s. Oh, you would be surprised what a chain of people linked Canada to Calabria. I sponsored my sister and brother, who are seven or eight years younger than me, in 1957, and my mother in 1959. In 1959 we bought this house here. This is the first house and this is the only house, which I’d never change with any other in the world. I sponsored an uncle and other people too. I sponsored a good number, I would say.24 Where I was not able to sponsor them, I found some employers to sponsor them. They had a trade and they came in.

A lot of people were sponsored because Canada was in need of people like bricklayers. Sam Sorbara sponsored God knows how many people. We heard he received twenty-five dollars for his trouble to arrange the immigration in a legal way. He also arranged mortgages for immigrants and had real estate connections, and made money in this too.25

Some people came on contract with the Canadian government. In San Giorgio people found out about these contracts from travel agents who advertised them. Then they had to go to the Canadian consulate in Rome to make the arrangements. People on contract with the government came to clear the bush, or for the mines in Timmins, or to work in the West.26 But for one
reason or another they didn’t like it. Some were not ready for
the environment. If they came in the winter they weren’t suit-
ably dressed; they came only with light clothing. They served six
months or a year and then they went to the city and sponsored
other people.

There were Italians here before the war who could spon-
sor you. Even if you did not have relatives in Canada before the
war you could, we would say, “catch up Italian style.” Let’s say
I am Rao and you are Sturino but we’re not relatives. We say
that from San Giorgio, my mother and your mother are relatives
on the women’s side. In other words, they connect first cousins,
second cousins. So even if they were not cousins, we claimed it
through the women’s side. That way we had everything planned
when we went up to the consulate and they asked us who called
us from Canada. We said, “My cousin.” If the consul asked any
questions in Rome we would reply, oh yes, my mother and his
[the sponsor’s in Canada] were two sisters, and we are first
cousins. Everything was fabricated about us being cousins. We
didn’t need any affidavit. There were lots of people in Canada
from San Giorgio: Rao, Ferraro, Fazari, Macri, Sorbara. All of
the surnames were here. Every-\n\nbody started coming. When
they did not have their own sponsors, they went out of the circle
[of kinship] creating the relationship. We used to say we were
related through the mothers when the names were not the same.
This was done who knows how many thousands of times in Italy
and they never figured it out in the 1950s and 1960s.

San Giorgio has people in every city of Italy. We have
people in Germany, France and Switzerland. We have people in,
you name it. We have people in every country of Europe includ-
ing Russia. From San Giorgio we have a large number people in
every country in South America, all over the U.S., Canada and
Australia, you name it. Everywhere you find San Giorgesi and
they went there for only one thing, to work. The people have
emigrated all the time from San Giorgio since the world was cre-
at-
Before the war there were many San Giorgesi here in Canada. I remember Giorgio Consiglio. He was living south of College Street on Clinton Street. One day we went to see him and he was retired at that point. I asked him how long he had been here and he said twenty-five years. I looked at my cousin and said, “Jesus, he had roots here, eh!” I shook my head. And now I have been here nearly fifty years. That fellow, he came here before the war. Others, too, like Sam Sorbara, whose son is Gregory. There is Raffaele Macri with a number of his brothers who came before the war, to Toronto, around 1920. We have a lot of people in Hamilton who came before the war. In Guelph, we had people from a hundred years ago who emigrated from San Giorgio. They were the first in Ontario going back to the last part of the 1800s.

When I first came, there was Luigi Rao and Filippo Magnoli, also my cousin. They were both first cousins of my father. Luigi for me was like a father and I was his son. I would say they were twenty to twenty-five years older than me. They were born between 1910 and 1915. Filippo Magnoli’s and my cousin Luigi’s wives were still in Italy. They sponsored their wives right after I came. Joe Magnoli had his wife here.

I recall my impression of the City of Toronto. Before I came here I had been in Torino, Genoa, Milano, Rome and Naples. I compared Toronto to these Italian cities. The only thing I noticed different was that here there was more space than the cities back there. I recall when we were three or four of us on the sidewalk and saw the police, we took off because if we stayed they would say, “Disperse.” We were not allowed to gather together—even though we were all friends. The police used to say, “Split it up.” I recall that I used to go to the Monarch bar and the other one at Spadina Avenue and College Street and the one at Bloor Street and Brunswick Avenue and they kicked me out many times because I was not twenty-one. Then when I was twenty-one, I took my passport out anytime they asked questions, they could not remove me.
My cousins Luigi and Annunziato Rao, we used to have a lot of fun. I lived on 97 Brunswick Avenue but I shopped on Queen Street because College Street was more expensive. We went there for Italian foods like olive oil and provolone or to the photographer for immigrants. We shopped at Lombardi’s and south on Claremont Street. We were so happy to find Italian products. We would shop on Queen Street for clothes, shoes. We would buy liver, the windpipe, and the intestine of the cow, la trippa, for lo spezzatino. On Queen Street the meat stores were Czechoslovakian and Jewish. We used to have a big pot and I used to get a fork and as soon as it got warm I started to eat.

Then, we had friends! Gino Mammoliti used to live at 451 Manning Avenue, right across from us. One Sunday morning he called me over because three or four friends from Hamilton had arrived and Gino wanted to cook for everybody. There was a stove in the basement with four burners. About twenty-eight men, five per room, used to live in that house. Gino started cooking early. He used the big burner to make meat with some tomatoes for sugo. He took the meat off the stove and placed the big pan with pasta there. But the basement was not finished. The laundry tub was full of socks and underwear from people working in construction. You could not go close because the smell was bad. So when Gino took the pasta off he called me. The toilet was a toilet in the floor with only a cardboard flap as a door. When I went to look at this toilet it was discoloured from white to dark yellow—nobody had cleaned it. He gave me a big wooden spoon, una cucchiaia. He asked me to hold the pan of pasta. I tried to, but Gino was pushing down too hard. Mannaggia la Madonna! The pasta fell in the toilet. We looked at each other and I picked it up. “Who is going to eat this?” Gino said. I said, “We eat it!” Those guys were waiting for us. Gino went up sour. He was nervous. I was laughing. What the hell do I have to
lose? I pretended maybe the pasta was too hot so we got a little water. I used it to clean the pasta. I got the meat. I grabbed the cheese. I said, “Give me your dish—Rosario, Giuseppe, Tony, Giorgio.” I filled those dishes right up! I grabbed the cheese and put it on them. Gino said he didn’t want any. I said, “Don’t make me mad.” I got him a little dish. I ate the whole thing. Gino looked like a small kid, but I nudged him. Those guys, they still compliment us. Ten years later I met them at a wedding and I told the true story to them, their wives and kids. The kids fell from their chairs with laughter. Those guys said, “The pasta was good—I don’t give a shit what you did.”

I got married in 1956 to Tina Salvagna. We have two children: Concetta, “Connie,” and Nunzio, whom we named after my mother and father.31 We met here in Canada by chance, meeting on the street. We got engaged. It took me seven years to buy a house after I came to Canada. I was renting with my cousin Luigi Rao and then my brother-in-law Rocco Pagniello and then my wife at 55 Euphrasia Drive in North York. I bought this house on Glen Long Avenue in 1959.32 It was farmland. I could spot the sign from Dufferin Street in front of the house when I was going to work. There were few Italians up here in 1959, maybe one in back and another across the street.

In 1968 I was in Italy and I went to see my Uncle Fortunato in San Remo, who was working growing flowers there. He asked me if I would sponsor him. I says no problem. He came here in 1969 and I told him to find a job close to home. He agreed with me and I took him to Dufferin Street, south of Glencairn Avenue. There was Fenwick Automotive. I had good relations with the employer, Ruby Fenwick. I asked him to hire my uncle. Ruby said, “Show me your hands.” My uncle showed him his hands and he had a nice pair of calluses.33 “You have the job. When do you want to start? Tomorrow morning okay?” A few days later Ruby called me and asked, “Do you have any more guys like your uncle?” He was to start at seven. He was there at six in the morning. Doing motors for cars, alternators,
starters, rebuilding. And he was there one hour before starting time. He started to come even earlier, but the other people said no. You get paid from seven in the morning, that is when they started. He didn't miss a day of work. During the working day he did not bother to shoot the breeze. In 1983 he returned to Italy. He made a big mistake to return. A lot of people who return from Canada, the US and Australia regret it.
Working Life

The first job I had here was at a factory in the West End. They were making hardwood floors on Roselawn Avenue. I used to go out with the truck driver. I worked over fifty hours a week and I received $17 as my first pay. When I took that paycheque, I said, my God how can I take care of the family with $17? I had to take care of the room in which I was living, the food, send money home. I said no, this cannot be. The second week I had the full amount of hours, fifty-five, and I received $21. I said no, I’d rather work and earn a fair cheque each week. I wanted to work and make it, but this was not enough. A friend of Luigi, my cousin, was a brick-layer and he knew the owner or someone there at the wood shop on Roselawn Avenue in Toronto and through him I got that job. But I did not stay because they paid cheap wages. Those were the going wages for any ordinary worker at that time because many other San Giorgesi, they were working even for CP or CNR and they were making forty-five or fifty-five cents per hour. I could not stay because I had a responsibility. I did not need to look only after myself; I had a family to look after. From then on I always had good jobs, well paid, with good money. I had a clipping from the Toronto Daily Star, so I went for a job search on a Saturday in Scarborough. I found a job in the construction industry where they built that drive-in show on Kennedy Road just north of Eglinton Avenue. I was not able to speak English, but with my hands I understood the foreman to say come back Monday. I returned Monday very early when it was still dark, in April, a very cold morning and I got the job there. It was in the early spring of 1952, cold, and I was working ten to twelve hours a day. With the dark we started and with the dark we finished. One day I was so tired, I could hardly walk. My cousin Luigi Rao asked me what was the matter and said he had a solution. He took me to a good restaurant and ordered me the biggest steak I’d seen in my life. After that I felt fine.

There was no union. I was making a dollar per hour. We
worked Sunday and Saturday, seven days a week, and the rate of pay was equal on the weekends to that of the regular week: no time-and-a-half, no union, no law. The more hours we worked, the more money we made. I was able to support my family that way. I worked hard there, making a dollar per hour. That was doing very well whereas in the West End I wasn’t even making forty cents. I used to live down at College Street and Clinton Street. To go to Scarborough every morning took me two hours since I had to wait for the streetcar and a couple of buses. In the end, if I worked twelve hours, I was away from home for sixteen hours. The young people of today have no idea how rough it was for a new Canadian or for their fathers, uncles or grandfathers. They have no idea whatsoever because for this young generation, everything is a piece of gold. I was proud when I returned home. My cousin Luigi would be smiling and ask me how many hours I worked that day. I used to say ten to twelve. He said, “Well, at least you came here to work.”

By the way, that construction company, I was the last man that they took. When the work was completed, everybody was laid off. They had a big job in the U.S. and they asked me if I wanted to go and I said no thanks, I was searching for a job in Toronto and I wanted to remain here. I said to myself: why should I go to the U.S.? My cousin is here. It is enough that I left Italy to come here. Why leave to go somewhere else?

When I finished from construction, I searched for inside work because the winter was tough. I had difficulty because I spoke no English. In 1953, I went to work for John T. Hepburn Company, at 914 Dupont Street and Ossington Avenue. It was a tough job. Now it is a storage shed. We used to smelt there, making shells for cannon used for the Korean War. The metal was going like water into the forms. It was hot, especially in the summertime. Many days we stopped at noon in June, July and August because we were not able to do smelting that day. The boss was a little bit hesitant to say he would give me that job, but I kept insisting. Finally, he said, “Okay, I will put you there for
four hours. If you make it, fine. If you don’t, you return to where you are.” I agreed. I took this job and after a short period of time the boss says, “You’ve got it.” In other words, I had the willingness and the ability to do it. I was sure of myself. I never said this was impossible. If the other person was doing this work, why can’t I do it? I can do equal or better. There, I used to work on piecework. Let’s say I worked eight hours and three or four hours of bonus. In the evenings I was exhausted, but that was fine because I was happy with the money I was making there. There, I was working even forty-five or more hours per week. It added up, with fifty-five or sixty-five hours of pay because of the bonus.

I started my union activity in 1953 in the foundry as a moulder. I never forgot that union—Moulders Union Local No. 28. Each time the union negotiated a new contract, the participation at the meeting was next to nothing. I thought if the union is representing us, why are we not going to express our ideas and have input in decisions. The first evening that I went to the meeting they asked me to interpret for the others. It was a real pleasure to do that. I did that every two months when the meetings were called. The union people consulted with me. I was not the shop steward or anything, just interested. I used to go to the meeting and I used to pull some of the workers to the meeting also. I told them that if we participate, the union will help us. If we do not participate, the union cannot do very much for us. For example, the union knew of me. I was laid off from this job eventually. The union called me and asked if I was unemployed. It was in 1958. They wanted me to try to find a job at an address they gave me. The address was on Junction Road and the name of the company was American Standard. I went that day. The personnel manager asked when I would like to start. I said, “I can start today at noon, the 22nd of July 1958,” which I did.

When I finished at the foundry, before I went to American Standard, my first problem when searching for a job was that I was not able to express myself. The early remarks that people
made to me were really an education for me, “If we have to hire you, you should speak better English.” I said to myself I had nobody here, I only had my cousin Luigi. The only way to help myself is to go to night school. The next thing I did, I went to those courses at night and I picked up English with my beautiful accent of which I am very proud. As a result, I had no problem to work for American Standard. I had no problem to get a job since I was willing to work.

I went to elementary school to the fifth grade in Italy, which is equivalent to the eighth grade here. I went to night school when I worked for American Standard from midnight to 8 a.m. I had a part time job in the day. In the evening I went to school at Bloor Collegiate from 7:00 to 9:30 p.m. Then I had an hour break and I was ready to leave at 11:30 to start the graveyard shift. I served my apprenticeship well. The life for me was very rough and touch-and-go, but always I smiled. If I had to go back, I would do it again—perhaps a little bit wiser, but not any different. A lot of people, they have money because they have a free ride from relatives. But thanks to God, I sweated for everything I have. I have no debts.

The work at American Standard was kind of complicated because they had some lines going west and some east. I noticed a person, Bruno Sibbio was his name, who was transferring the bathtubs from one line to the other line. The lines were speeding and that fellow had no time to blow his nose. Jim Ray, the supervisor, had to decide where to place me. I thought I could do that job with Bruno Sibbio. Always, I was upgrading myself. I was super. That job was performed always by two employees, so one fellow could give a break to the other. The work was not possible for continuous hours because you would go like crazy. You had to go east and west, south and north. I was doing the work and they asked me to work on Saturday and I never refused.

One day, I ended up with another fellow from a different department older than I was. I was in prime health at that time,
less than thirty years of age. This fellow from the other department, he was old and not able. He just looked. I never dared to give him the hoist to do the transfer of tubs because he would have been lost. One day the foreman came and asked how the work was going. I said, “Fine” and he said, “Let me know if this fellow is pulling his load, otherwise I will fire him.” I said, “Get lost.” This weaker fellow had been working in this company before I was born. How could they fire him? You know, the foreman was full of shit. A lot of people, they get drunk on the compliments of the foreman, but I always had the sense to put the words on the scale. To see those words fit the situation. I told the foreman right there to get lost. I said that this individual is doing his best and he had been working here forever. I was not mad that the fellow was unable to do the work or to help me. I did the work for him and he was looking for me. From time to time I put some material on the floor for him to move around and that was the work that we did, but the heavy transfer was done by me.

I never believed in money. A lot of people today, they are starving for money. Even if they are rich, they want to be richer. In the early 1960s, I went out with a Jewish friend who was selling life insurance. Anytime he took me with him, he made a sale. Never failed. His manager called me one day because I was talking more than the salesman with the people. He said, “What do you do for a living?” I told him I was working at American Standard. He asked, “How much money do you make per year?” With some overtime I was making roughly $3000 per year. It was big money at that time. He told me I could start with his company tomorrow morning and make $12,000 per year. I said, “No, thank you. Perhaps other people will see this opportunity and they will jump at it. I say no.” He asked me why. I told him that money is not everything. He asked me if I knew the difference between three and twelve? I told him, “Sure, I know the difference.” He replied, “Tell me.” I think he thought I was stupid in calculation. “It is nine thousand.” Again he asked me why I
wouldn’t take the job. He almost fell from the chair. He told me I could do it. I said, “I know I can do it, but I don’t believe in it.” He asked if he could call me in a week. I said, “Sure, but you are wasting your time.” He called me for six months but I did not change my mind. The manager asked why I turned his offer down and I replied I liked what I was doing.
There was a problem of discrimination at first from the traditional Canadian unions, but, let’s say, the problem was created by ourselves. Let’s say I was called by other workers, Canadian and even immigrant, “DP” or “Wop” or whatever, but it never bothered me. I always had a thick skin. I used to tell them, “It’s a free country—you can say what you like. I came here to make my life better and really you too are here to make your life better.” I never really gave any importance to those racial or discriminatory remarks. They never bothered and still don’t bother me.

In the evening in ’52, ’53, ’54, I was always doing something for the community. I was involved organising people in the union. First, I was working with the Moulders’ Union and I was active with them, but then I was working with the Steelworkers. I was active in the community and organising for other unions: the International Ladies Garment Workers Union, the International Fur Workers’ Union.

In 1958–60, I started to be very active in the union at American Standard. We had an election and I ran. I was elected a shop steward, a safetyman. I was elected an executive committee man, and later, Vice President of the Steelworkers Local 6299. When elected, I read the collective agreement and I called the foreman to comply with some articles. He said, “Look, we have had a collective agreement here for years and nobody complained before you came into the picture, so why are you complaining?” I said, “Well, me is me and somebody else was somebody else. I believe that the company expects the workers to live by the collective agreement and we expect the company to comply with the collective agreement.” I made them comply. A lot of people took the title so they could say, well you know, I am shop steward! But I took the job of shop steward to defend the workers. I had many arguments with my boss each and every day of the week to make sure that the collective agreement was
not violated. I wanted to make double sure that the company and the foremen would abide by the agreement they signed with the union. One day the foreman, Mr. Alf Carter, said, “If you do not like to work here, why don’t you go elsewhere?” I said I couldn’t hear him, so could he repeat what he said. And he repeated what he said. I said, “Look, I am not chicken to go elsewhere. My job is to do the work according to the collective agreement for the best interest of the union and the workers. I am here to make this place better, even for yourself.” From then on we did our best.

Some of the workers said that it was not the right place for me to work, and that I should work elsewhere helping to organise the union. Right after working hours, I was helping unions to recruit workers to be in the union. I had no difficulty signing people up to be part of this or that union or the Steelworkers. I had an offer to work full-time for the International Ladies Garment Workers Union (ILGWU) as an organiser. When the Steelworkers learned about it, they asked me if I was willing to work for them. I agreed and went full-time on staff in the 1960s. With the Steelworkers, when you call on people and you don’t get them to sign for whatever reason, you mark down the results on a card. It could be they were not home or wanted more time to think about it. You also write down your name, the person who called the potential union member. If a different organiser calls on this person, already he or she has the information of how many times this person was called upon. The Steelworkers are really pro.

I was working for the United Steelworkers of America at the American Standard shop and organising in the evening for this other local. People say, well, the union is not doing anything. And I say, well, the union is doing whatever the members want. The union is not made by God. The union is made by people. And if the people are good, the union is good. If the people are lousy, the union is lousy. When I approach these people who declined to sign when approached by an earlier person, I smile and I explain if they sign, they help themselves. If they do not wish to
sign, they will help the employer to get richer and, of course, the
pie will stay on the table of the employer.

I had people whom we could not sign. Many people tried,
with a lot of experience with trade unions in Italy and Canada,
but the union did not have the right approach. They marked on
those returned cards: “This person will not sign even if God asks
him to sign.” I took those cards and went there [to the union lo-
cal]. They gave me brand new cards on which I could not see
how many times somebody else had tried. I explained. I smiled.
I never pushed them to sign. “If you wish to sign, this is an op-
portunity to be part of the union. You will be stronger. Your fam-
ily will be better off because if you have a car and house, you
will have insurance [i.e., security]. If you are working without a
union, you are at the mercy of the boss. For any stupid thing you
can be out the door. But if you have the union and you complain,
the union will find out why you’ve been put out the door, dis-
criminated, discharged or suspended. Signing with the union is
a protection for your family. It is up to you—if you wish to sign, if
you wish to think about it. If you do not want to sign, that is fine.”
I had no difficulty signing up people. In short, they signed. When
I took these cards back to the union office, to the other orga-
nizer, an Italian also, he was surprised. I said, “What, you did
not expect them to sign? You sent me there to sign them up.” He
said, “I have been there so many times!” And he started swear-
ing about them. I said, “Just one minute. They are smart people.
They are not idiots. They understand what we are saying. I told
them if they wish to sign, fine. If they do not want to sign, they do
not have to.” The problem was that he was pressuring them. I did
not pressure them.

I had no problem organising. I was organising both women
and men, Italians and non-Italians. I recall for one card I made
eleven calls. This lady would not sign because she was afraid
that she would lose her job. In January I went one evening with
twelve inches of snow on the ground. I had problems opening
the door to get out of the car. The daughter answered the door
and said that her mother just went out. I said, “She went by the roof with the helicopter, eh? Look at these footprints. There are no other and those are mine.” The mother felt I was pushing her to sign. I said I was not pushing anyone. I had been here eleven times. I had the date and the time. I said, “Each time you said you wanted to wait to see how it goes. Well, we applied at the Labour Relations Board. The union will be in, so if you sign you will help your family, but if you don’t you will help the company.” She asked when the union applied. I said we had enough cards to apply, but the more we have, the better we will be. Finally she signed. If in the previous visits I had been blunt this lady, I could not have returned other times. I always left the door open.

I tried to sign up this young fellow who was not home in the morning, evening or anytime. One time I asked his family when he went to work in the morning. He left the house at 5:30 a.m. I told them I would drop in at 4:00 a.m. the next morning. The next day at 4:00 a.m. the lights were still off. At 5:30 a.m. sharp he came out the door and I asked him if he would mind if I ask him a question. I introduced myself and told him I had left information a number of times about the union. He said he had gotten it. Now I told him it was up to him. We had a majority signed up. If he wished to sign, fine, if he didn’t, fine. He signed up. When I went to the office I told my supervisor, Don Montgomery, that I signed this guy at 5:30 a.m. and he asked if I was thrown off the veranda. But people didn’t because I was always polite.

One Easter Sunday I went early to church. After Mass around nine in the morning, I said to my wife that I had to see two people for the union. I would be back fast. It would be very simple. I went to see them and signed them up on Easter Sunday. Those two asked if so and so had signed up. I said that I was not supposed to tell who had already signed, but if they told me where these other people lived I would pay them a visit. I went to this couple and signed them up. They gave me another address of another two couples. That day I signed up sixty-
four people! When I returned by 4:00 p.m., my wife said, “Don’t tell me today you have been working for the blessed union.” I said, “Look, I signed up all these people. Tomorrow I will apply for certification at the Ontario Labour Relations Board.” The people I met that day were all at home, pissed off with the company, Acme Spring, which made metal springs for furniture and beds. I did not spend any time explaining. For those who were not in, their family asked me to leave the card for them to sign. But I preferred to return later. It was a pleasure for me. These were people who were exploited and, believe me, the collective agreement made a difference. Many never had a dental plan. As soon as they had the collective agreement they had benefits, life insurance, the weekly indemnity drug plan if they were sick. At least the wealth was shared. Before the union, whatever the boss made, it was possible for him to go south for the winter, to have a plane, a sports car and an expense card. The workers used to have only a bloody bone. But with the unions they have been lifted out of their exploitation.

As Steelworker organisers, we organised thousands of workers: Italian and non-Italian, Canadians, South Americans and international groups. There was a time we used to receive one certification from the Ontario Labour Relations Board per week. Organising is long, hard work. Many times we finished at midnight. I signed people up for a union drive at 5:00 a.m. before they left to go to work or at 2:00 a.m. after shift work. Many people never forgot what I did for them. Even after thirty-five years, anytime I am in shopping plazas, at weddings or funerals, they say, “You don’t remember me, but I remember you because you signed me up.” I think the faces are familiar but names are more difficult.

In the late fifties and early sixties, unions boomed, especially construction unions under Bruno Zanini and John Stefanini. My union job let me deal with the social pensions in the community, Italian and non-Italian. If they had a problem with any type of program—Workers’ Compensation Board, UIC,
Canada Pension—I would step in. I had about twenty-four locals to serve. I negotiated collective agreements, to take care of any grievances and arbitration. The Steelworkers, I think, have one of the best organisations of all unions in North America. There is a membership meeting each month by the constitution. It is not a union that collects union dues and then forgets about the worker.

The amount of hours I put in is pretty hard to describe. My wife had two kids. They grew up. They got married. I didn't even see them. Today I am sorry. I should have spent more time with them. I had the union in my blood. I didn't even take my vacation. The devotion to the union and the community involved me. I was one of a kind. The union representatives today are smarter, but they do not get involved in the community.

It doesn’t matter if the leader of the union is Italian, Portuguese, Greek or South American. If the person wants to be active in the union, then there is room. The union likes to embrace all these people. Today it is much better than ever because we have more people in the union—not only Italians, but also Portuguese, other nationalities, and blacks are making inroads. If the CAW or the Steelworkers or the United Food Commercial Workers Union, or let's say the construction unions, Locals 183 and 506, if they find someone at the local level and he is doing a good job, that person will be promoted through the ranks of the union. I think this is a good step forward because the membership will have their representation according to their needs. In the 1950s the doors were closed for an immigrant to be in a leadership position. I think the immigration from the fifties to the seventies was important. Canada was booming, with plenty of jobs at that time. Many people who were active like myself in the community found a position in the union. All the unions, I will say, are the same. When they see a member at the local level and he or she is good, they will keep an eye on him or her. When an opening is there, they will offer a job.

The Steelworkers in the late 1970s used to be 1.4 million strong. Today they have about 600,000 members. The Steel-
workers Union is one that is trying to organize the non-unionized workers. The bad part is that you organize ten and you lose twenty. With the recession in the early 1990s, I guess whoever is dominating this world, they are turning the clock back. I know people who used to have a union job with benefits and now work for half without benefits. I think that the government should cut income taxes for working people and have corporations pay their share. The government has to have a good look in the mirror. Sure there is eighty per cent working, but don’t forget about the other twenty per cent of the population out of work. The statistics will show less, and they will show what they want to see. All those people who do not collect UI or are looking for jobs are not counted any more in the statistics. I will say, the number of people out of work in the nineties is greater than in the 1930s.

With the Steelworkers I had more strikes than any union rep. During one period around 1977, I had five—four were at Alcan factories with one each in Aurora and Scarborough, two in Toronto and the other in Richmond Hill at Reynolds Extrusion. You might say that meant I could not negotiate a collective agreement so we had to strike. But that is not true. I was not a person to say, well, I will do half of the job and get an increase and ask the workers to vote on it. If I believed that we should get more money, I asked the workers to reject the deal to get what is just. Having a strike is a big headache, but I was never scared to have one headache or two headaches or five headaches.

I pushed for good language. I was lucky to be dealing with so many lawyers from Canada, from the USA and elsewhere, who represented international companies. I stood firm on the language. We had a master collective agreement with the articles that I thought were necessary. I took from it. We dealt with standard-of-living issues: medical benefits, life insurance and leave of absence. Those lawyers tried to rewrite the articles. I read it and I said, “No, we are not there.” Some workers thought the money was more important but really the language is more important. If you don’t have good language in a collective agree-
ment, the management can make life miserable for the workers. The brown noses, they are protected. The hard workers, they are always screwed.

As an illustration, I had a collective agreement in which the employer did away with seniority. I said “This is a farce.” Many workers, good people, had been laid off. People who started yesterday, because they were good friends of Mr. Brown, the foreman, they stayed there and the good people who built the company, they’d been laid off—for three days, five days, for two weeks—and that hurt. I told the company that this language must go. When we presented different language, some in the company said I would get this different language over their dead body. We had a strike in order to change the language and I had the workers in one solid fist because communication was the name of the game. Once you explain to the workers they have been screwed and why we are trying to change the situation, they understand. If there is any lay-off, it will be “The last one in is the first one out.” Unless a qualification does otherwise, you cannot ask a guy who has been with a company for twenty-five years and a guy who started last week to be treated the same. I said, “Provided that the qualification, the abilities are there, the seniority must govern,” and the workers they understood. We had a strike. I said, if you change one comma in the seniority clause it will be a problem. If you try to change one period, there will be a problem. Seniority has to be the way it is presented, we will not take anything less than that. The following morning they gave us our seniority at American Standard.

We had one or two walkouts during the collective agreement. You cannot leave your job, but the people decided to walk out because they did not like the way a fellow worker, by the name of Harry, was treated. Harry was a sweeper. He had been working all of his life for American Standard and then he had an injury caused by a motor-vehicle accident. He was off work for awhile. When he was ready to return to work, now over sixty years of age, the company refused to re-hire him.
The workers they were pissed off. They thought, well, today it is Harry—tomorrow it could be Joe or Lucky or Frank. I told the workers we had a collective agreement and we could not stop working. We signed the collective agreement and I said we had to honour that, but I said we should file a grievance procedure. Let the company contradict the collective agreement, not the union. The union filed a grievance arguing for his reinstatement. The company refused. It said it was dangerous to have him at work. He could get hurt, they argued, and they would be stuck with the compensation. The workers went out, and the manager called me and said, “What is this bullshit. People are out on the street?” I told him they want Harry back and the guys said, “Fuck the grievance procedure! We’re gonna take the law into our own hands.” The company sent a telegram to each and every one of them to return to work, otherwise they would be dismissed. Some guys got drunk in the parking lot when they read the telegram. The guys stayed out two days and a half. The company caved in and let Harry return to work. We sent a message to the company that he had to be in the shop when the workers returned. The company agreed to the contract language.

The question of the leave of absence was also an issue. The company may grant a leave of absence to the employees. I said that is funny like a three-dollar bill. If a person asks for a leave of absence, he should get it. And we put in the contract that if the employee requests a leave of absence, then the employer shall grant it. Then the company asked what if fifteen employees want to go at the same time? So we put in some safeguards. We did not want to screw production or the company. I asked them how many they could afford. Three at a time. I said that if the people are turned down because you have nobody to replace them, they will understand it. And also that if they request a leave of absence in advance by six months, that should have preference over short-notice absence requests. We have a two-way street of understanding. We had a lot of people who also made the mistake of buying a ticket overseas before they checked with
work. I said to the workers on the TV, on radio and personally, first get the leave of absence, and then you go buy the tickets. I received a lot of compliments from the employer because this was a problem.

An article in the collective agreement stated that the employer [American Standard] would supply to the union a bulletin board on which we can put any notice of union meetings, business and other things. I asked the foreman, where was the union board? He pointed to the employer's bulletin board. I said, “That bulletin board is the employer’s. I don’t see why we should be on the same board. If the employer puts something, fine, but the collective agreement calls for the union to have its own for its own notices and messages.” He called the carpenter to make one. George Greenwood was the maintenance person and I never forgot what he said, “Lucky, you want the bulletin board?” I looked him in the eye and I said, “It is not Lucky. It is the union and the collective agreement that calls for the board.”

I have been injured at American Standard—the first time on the eleventh of September 1959, which still today I’m paying the price for it. That was because of the heavy lifting on the bathtub line I told you about. I returned, with a brace on, for line duty. The foreman asked me to perform some lifting and I said I would not do it. I told him that I had requested not to pile the bathtubs the way they did because they put one flat on the floor, then five more piled on top. To reach the last one you have to stand on your toes and with fingernails lift the top one off. It was dangerous. He gave me some help, but I still refused because it was too dangerous for me and for others. He said I should go home. I said, “Fine, I would rather go home than the hospital.” I said to him that I refused to do the lifting because it was dangerous for my life and for others. I went home and I told him I would file a grievance. He and the manager denied the grievance. I took it to the next step. We dealt with the director of American Standard. We argued that the day of pay that I lost should be paid. They complied with the grievance and the company paid
for the day in question. The most important result, however, was that the company agreed that they would not pile the bathtubs five high anymore for the safety of the workers.51

Today, big companies are fine but with small companies, there’s plenty of hanky-panky. And I don’t blame the employer. I blame the workers because they have no guts to speak up. I know some of the companies in which the noise is out of this world from the machinery. When the inspectors go there, they turn those machines off and there is no noise. Some other places, where they work with materials, stink and there’s dust and whatnot, they have chemicals. The workers should know what they are dealing with and that the employer, by law, should know. Now it’s much better than before the [safety] law. But still the workers are not doing their share. If the workers don’t take a stand to speak out, they are going to pay the price. They are not educated and they pay the price. Even in some small union shops, where the union is weak or the union is not working, this is happening. But it’s the responsibility of the union representative to make the workers understand what is right and wrong.

There is an old story back home in Italy. One day one fellow was mad with another and this angry fellow said, “I’m going to kill that son of a bitch.” He passed by the church and he saw the caretaker who rings the church bell and asked, “Will you ring the bell for that bastard, I am going to kill him.” The caretaker of the church replied, “Look, it’s premature to ring the bell before you do the job on him. By ringing the bell now, it could be you who dies and not him. How sure are you that he won’t kill you first?” The angry guy thinks about it and says, “Well, if this is the case, forget about it—don’t ring any bell.”

Well, over forty years ago, I suggested that we have a labour/management meeting to resolve any issues at American Standard without going through the grievance procedure. They agreed it was a good idea and we started to meet once a month. I took many complaints from the shop floor. We had other shop stewards from other departments who were sleeping. They
were not doing their jobs. I always had a little notebook in my pocket—every day of the week—with a pencil. If someone came with a complaint, I marked it down. When we had these labour/management meetings the president of the company came to the meetings. One day I said I had twenty-six different complaints. Management started to laugh. I called each one out and when I finished their faces looked as if they had been hit with a pie. They did appreciate what I said. I said, “These complaints deal with safety, some are more important than others, but I received them from co-workers.” For example, at the shipping docks where the trucks pick up materials from the plant, truck drivers, especially during the summer period with the sun shining, found it difficult to drive into their spot because it was dark. I suggested they put two lights at the end of the dock below and above the floor where the trucks back up. With those lights, the driver knows exactly where he should go. He will not hit the other trucks beside him or go into the wall. That was one of the twenty-six complaints. The company would respond each month to these. I was one of the Italians with the Steelworkers’ as a staff representative and I am proud that each recommendation I put to the union, they listened to me.

We had the twentieth anniversary banquet of the Labour Show and I invited Italians and Canadians in other unions, who had been on the show many times. Do you know that they had no power to say to their unions we should go there or we should buy a table or a few tickets? Some of them were turned down. The Steelworkers were much more open to Italians. We had a flood in Italy many years ago and the Steelworkers donated money themselves. They set up an office, telephone and secretary, which opened the fundraising in the community: volunteers, letters out, money in. We were able to use the Steelworkers Hall [Larry Sefton Building] on 25 Cecil Street like our home. We had an earthquake several times and they sent money. Not from their pockets, don’t get me wrong, from the union treasury, thousands of dollars. We also sent an appeal to all the local unions
about donations for these disasters and they responded—five hundred or one thousand dollars—each and every one. Also I approached the CLC and the OFL and they responded. The Labour Council did not respond. The president is a good friend of mine, but I asked one labour fellow, “What’s is wrong with her?” He said, “Give her a women’s issue and she will go with it, but anything else and she is blind.” This is bad. The Labour Council, which represents the City of Toronto and the surrounding area, should have helped these people. When Sergio Tagliavini, the publisher of Lo Specchio, unveiled the monument to the fallen Italian workers in Woodbridge, I invited the Labour Council to the fundraiser and they declined to take a table or one ticket. They did not respond for the monument and they did not respond for the Labour Show and other unions also. CUPE or OPSEU are zeros. The civil service is zero. They are not in the community. The union that is not visible in the community cannot be accepted by the community because one hand washes the other. This is bad, very bad. Italians had a hard time getting into these unions in a way. If they are there, but have no voice, I feel sorry about that. Portuguese have some power but it will take some time yet in order to have more good people involved in a leadership position. Some unions are run like an empire.

Many years ago a worker was killed in a local that I organised for the Steelworkers. I did the contract for them. I suggested to the executive that they should take a day off and go to the funeral. The worker was killed by a coffee wagon in the parking lot. These coffee wagon drivers, they drive like crazy. The workers worked for some brakeshoe company. They told the company that tomorrow they were going to the funeral. The company said bullshit. The workers said bullshit back. The owners asked, “What about the production?” They said, “Fuck the production, it is one of our workers who died.” I organised the event with the executive, and we asked the worker’s wife if she minded that we wished to carry the casket. She said to do it. I sent pictures with the history of how it happened—a young fellow with a young
wife and two small children—to the newspaper of the union. And I also sent an article to the Corriere Canadese. They published it with a photo of the casket and all the Steelworkers around it.

At one point, friends of mine who were organising met a fellow who did not know whether to join the Steelworkers or not. He said that the only union he would join without hesitation is the union that does the funeral for the members. “I saw Fortunato Rao with the union fellows and this casket.” This fellow, he knew something about this funeral. My union friends told him that we didn’t pay for the funeral, but that it was a member of the union who died and the union people who attended the service were pallbearers for the casket. The worker said, “You mean that union in the funeral and this union [the Steelworkers] are the same! Give me the card and I will sign it.” What I mean is that if labour is not in the community, do not expect anything back from the community. But if labour does something in the community, it will be paid back. The people are not stupid. They have good knowledge and they remember.

Many years ago, in the seventies, a company called Ontario Store Fixtures which made hotel and restaurant equipment went bankrupt. Eventually this company merged with ANCO Metal, that also had gone bankrupt and came out operating under a different name. Somehow we [the Steelworkers] were on the ballot, too, because of the jurisdiction, to see if the workers wanted to come with us or the Carpenters’ union. The woodshop workers had been part of the Carpenters’ and the metal workshop workers the Steelworkers. We did some campaigning to win the vote and the Carpenters’ union did the same. But the bad news was that there had been eighty workers originally with the Carpenters’ union in the one company and our company had about sixty people. At the time of the vote, we [the Steelworkers] had about 20 people back to work. So the chance for the Steelworkers to win the vote was very minimal. But, anyway, I went there one, two, three mornings early at 6:00 a.m. before they went to work at 6:30 a.m. or 7:00 a.m. It was cold. I saw the door
workers went in. I said, "Why should I stay outside?" So I went in. I went into the shop and I was giving out the leaflet. A well-dressed guy came in and asked, "What are you doing here?" I told him I was giving out the leaflet and you can have one. He said he didn't need one because he was the foreman. I offered him one anyway. It was free of charge and I smiled. He looked at the leaflet and said, "Oh, you are from the Steelworkers? Do you remember Joe so-and-so?" I said the name was familiar but really couldn’t remember. He said it was his father and that I took him to the Board [Workers' Compensation Board] with his appeal for the pension, which was successful and increased [his pension]. Anytime I wanted to bring any leaflets, I didn’t have to stay outside but could distribute them in the warmth. I said I wanted to do the campaign according to the rules. When we counted the vote, I had some doubt that we would win the vote. Jesus Christ, we had close to ninety per cent of the vote. One fellow, he spread the word and said, "This union is a really good union. Not only is it a union for the members, but it is for people who don’t have a union." To be in the community, in my opinion, will pay off, and these leaders of the union, which are not in the community, I call them blind. They do not see with their eyes, but from the point of view of their mouth.

For me, a person who is part of the union has to do the best for the workers that he or she represents, no question about it. That person is also abreast of the workers' needs. They should be of the community, in the community and assist the community. He or she should have some vision for provincial issues, national issues and also international ones. There are a lot of people in the world that need our help. If someone looks always with tunnel vision then he or she doesn’t understand the union movement.

Democracy is where the workers go to a meeting and they elect the bargaining committee that represents them. Democracy is the workers telling the bargaining committee the changes they need in the collective agreement, the improvements, the
language or whatever—if there are medical or welfare programs that should be implemented, rate of pay and what not. When the negotiation committee reaches an agreement, either with the management or the corporation or government or whoever is the employer, the really democratic way is to draft the highlights of the changes. I used to print the language so that they can see exactly what kind of language we are talking about. The same with benefits, whatever the case may be—it must be in black and white in the hands of the workers. To say verbally that we have a good package or a certain change in language or money, I don’t buy that, that the workers should vote for something in the bag that they do not see. Let workers see the changes and go through all the changes, open the floor for discussion and call for a vote. That is democracy in action.

The Steelworkers’ Union is one of the best labour organisations. When we have a nomination, from the top to the ordinary Joe, it will be done on the floor at the local level or the national and international. When the time comes, names appear on the ballot. If you have to send a delegate to a conference, do it through an election. These delegates are obliged to bring a report back on the conference. I saw a lot of people who have gone to conferences with expenses paid and they don’t even show up to tell the membership what transpired. That is dishonest.

In Italy we have powerful unions because there are just three. Here, God knows how many unions there are—maybe close to one hundred. Each one of them, they want their own empire, their own salary. To be in the trade union for any leader should be a passion for the community—to speak up for social issues, not only for the collective agreement. This philosophy is not in the heads of many of them. They see only what concerns them. The leadership from the Steelworkers, the Canadian Auto Workers, UFCWU and Locals 183 and 506 of LIUNA55 are good. But others, my God, they are detached from the real people. If all the unions had banded together, we could have had our own
government a few years ago. But unions divide their support. Let me to tell you, in the U.S. elections for Clinton, Dukakis, Mondale and Carter, the Steelworkers worked hard and it paid off. Many union leaders are jealous of each other, the former head of the CLC. They are jealous because he is in the spotlight, he's in the media and aggressive, and the other leaders don’t like it.

I am not any longer a member of a local and I no longer pay union dues. I am a member of the retiree club of the Steelworkers. I do not attend the club meetings right now because I am always busy with the community. But once I slow down with community business, I will try to attend some meetings and to have some input again.
Politics, Canadian Citizenship and Labour Activism

I HAVE SPENT OVER THIRTY years working with the labour movement and the NDP. I have been involved with the labour movement since 1953 and the CCF and NDP since 1956. Since I started working with the union I have had the privilege to help in many ridings during elections or by-elections. I am going back to the 1950s—’57, ’58, ’59. I was working over in the east end, in the Greenwood riding. The Steelworkers were part of the NDP. I was told there was a by-election in Greenwood and asked if I cared to go with any friends. I said sure. I can bring a carload of them, no problem. From then on, I have been assisting in each election whether federal, provincial or municipal. I always support the NDP candidate because they stand for labour.

Many years ago, around 1970, the City of Toronto and the Labour Council had a dispute because the police force and fire department needed new uniforms. The City of Toronto wanted to give that contract to a firm that was not unionised. Don Montgomery, who was the president of the Labour Council, made a very strong argument to give the contract to organised workers in the ILGWU. A lot of people said bullshit, but Don Montgomery said that if this employer gets his work from the City of Toronto, he will give better vacation pay to the worker, will pay some benefits, and will offer better wages to the workers. In the end, this wealth will be distributed into the pocket of the workers. I was listening and I said, goddamn it, this guy makes sense. The other way around, if you give it to the manufacturer where there’s no union, they will keep the working conditions poor. I know. I witnessed where the tailors, they were going blind because they did not have even enough light to do the work. The working conditions there, a basement sweatshop, were miserable. They had to use one washroom for both sexes and people were forced to work all kinds of hours or no hours. The mayor and others said
Don Montgomery was right and they gave the contract to the unionised company. If they worked over nine hours per day, they got time-and-a-half, whereas the other people worked twelve hours straight time. The wealth, then, was divided between workers and the employer within the unionised shop from there on. I knew the union is for the workers. These union people at City Hall were fighting like dogs for the workers. The other people from the Liberal ranks and the Conservative ranks were laughing. They argued whoever does the work cheaper should get it. Don Montgomery said, “I will grant you that it will be cheaper, but take into consideration where the money will go. It will go into the pocket of the owner and the workers will pay the price.”

In 1961 the CCF was finished and the NDP took over and I was at the first rally. It was at Maple Leaf Gardens. I believe Tommy Douglas was there and he delivered a super speech about the need for compassion. I'll never forget it. There were not many new Canadians or immigrants with the NDP because the Liberals, they have always been able to say that the NDP were communists and the conservatives said the same. Those two parties scared the shit out of many immigrants, especially the ones from Poland, Ukraine or the Balkans. With the Italian people, they have been able to brainwash many of them, but I and many others have said this is the party of the working people. There were not many Italians in the NDP in 1961. I was there because of the trade union.

In 1969 I was asked to run as a candidate for alderman in Toronto's Ward 3 and I accepted. I was convinced that I would win. The people knocking on doors there—south of Rogers Road, north of Bloor Street and from Ossington Avenue to Lansdowne Avenue—thought I would win. I had a good program. I was even endorsed by The Toronto Telegram, The Toronto Star and the Labour Council. That year, the future mayor, Art Eggleton, ran in Ward 4. He won, I lost. Johnny Lombardi ran in Ward 4 with his radio station and his money and lost. I came second. I was fighting against Joe Piccininni who had spent nine
years in City Hall at that time. Anyway, I lost. To be honest, I was disappointed. They asked me several times to run for municipal election, provincial election and federal election. But once was enough. I did not run again. The people, they love to elect people who are less than honest, this is my view. They are not interested in electing honest people. In the end, I said fine. From then on, I tried to assist all those people who would vote for me, but could not because they were not Canadian citizens.

I was involved in Canadian citizenship for twenty years. Starting from 1970 with the Steelworkers, I helped many thousands of workers to become citizens—Italian and non-Italian, from many groups. We had good results with Canadian citizenship. It was a program that never existed before anywhere. I said during the election that if I win the election or lose, I would help these people become citizens. And that was the first outreach program that I did with the Steelworkers. I had a lot of support from the Steelworkers, the leaders, local presidents, shop stewards, a professor—Ottorio Bressan—and plant chairmen. This program was not only for the Steelworkers, it was for their families, neighbours, and friends. It was open to each and every one. I had people from other unions that did not have programs like this outreach of ours. We were the pioneers. There is still a need for this. Now you have more people who are educated, who are coming here with money. More or less, they know the score. But the problem was that many of these new immigrant workers who came in the early fifties and sixties, they were working hard, all kinds of hours. They had responsibility. They had a family, a father, and a grandmother to care for. They also had to take care of the house that they bought. Their aim was work and pay the bills and be fine. They did not bother to take time off to go for Canadian citizenship because they would lose, more or less, three days of pay plus whatever the fees were for the application. For this reason, they were not willing to say, “I will be a Canadian citizen tomorrow or next year” because their aim was to work. Others had some fear. They said, “Who is giving
us the certificate, a judge? Well, I never saw a judge in my life. Where are we going to get it, at the courts? Oh, my God, I never stepped inside a court. Neither I, my father nor my grandfather. Our tradition is to stay away from the courts.” There was fear.

When I organised the first group, I explained to them: “We will go to 55 St. Clair Avenue East, Toronto.” They were worried about what was there. I told them it was a citizenship court. They did not feel comfortable with the word “court.” They acted like babies when we went there. They did not want to see the bench. They were more or less afraid. When I said that it was peanuts, easy, to become a citizen, they thought you must be a Philadelphia lawyer to become a citizen. I said this is bullshit. They are going to ask you simple questions. If you cannot answer, that means you never watched the news or read the newspaper. You don't know who is the Mayor of Toronto? I said that is bad. How would you feel if a Canadian person went to Italy and stayed five years in Rome and then he decided to become an Italian citizen and they asked him who is the prime minister, president, or mayor of Rome and he couldn't answer? They said, he must be an idiot. And I said, “Well, there we are. It is nothing hard.” We made a brochure in Italian and English to help them.

Right after that experience, I recall, Michael Starr was one of the judges of the Canadian Citizenship Court. He used to be Minister of Labour in the era of Diefenbaker. I said to him, “Judge Starr, believe me, these people have some kind of fear to come to the Court. Is there any possibility that you could come down to the union office? We have a beautiful hall there and we can accommodate the Court there and the ceremony.” He said, “Lucky, if you have a good facility, we can do everything there. We can take the application, we can give them the test and, right after, we can give them the certificate down there.” He sent someone to see the facility and they were impressed. We then started to take applications at the Union Hall. I used to get the application and we helped the people fill them out. The Citizenship people used to send their staff in the afternoon on Satur-
days. For the test, the judge came to do the interview, to see how much English and knowledge of Canadian history, the provinces, the political system and whatnot, they had. It was fine. The presentation of the certificates was at the Union Hall for many years. Many judges came there, but the judge who broke the ice was Michael Starr. I never forgot him. He understood me when I told him the people have a fear of coming to the Court.

At this time, the Catholic Church woke up and the Italian community woke up. Also, the Portuguese community woke up. There were so many outreach programs in the late seventies. I left the Steelworkers on May 1st 1987. And then I did a couple of citizenship programs at Columbus Centre in '88, '89, '90 and that was it. Now the Court is saying to all the outreach groups that if the people want to become citizens, send them over and we will take care of them here. They don't have the staff to go out of the way like before, because of cutbacks. These cutbacks were created when Prime Minister Trudeau was still in. Prime Minister Mulroney took over and there were more cutbacks. The outreach program ended. At the Steelworkers at the present time, there is nobody who has stepped into my shoes because they believe it is not important. I will say that the program was extremely important. It was a super connection between the union and the community. We had people there from twenty countries at one point, to pick up their Canadian citizenship certificate. After the ceremony, we organised refreshments with music and food, pizza. We invited all the family to come to each celebration. We invited some politicians to participate at the Canadian citizenship functions.

There are not a lot of Italian Canadians who support the NDP. It is not a question that everybody is in love with the Liberals, but right now they are pissed off with everybody including them. Many times I would love to know less about politics. I would suffer less. I did my utmost for the NDP government in Ontario. For example, the labour law introduced by Minister of Labour Bob MacKenzie and the NDP, Bill 40, was a law for
everyone. The Liberals and the Conservatives opposed him [MacKenzie] when Premier Bob Rae appointed him the Minister of Labour because, they said, he is for the worker. I said, “God-damn it—it is about time that we have a Minister of Labour who is working for the workers!” Here there is this mentality that the workers have been dominating the world. Some think the workers have been dominating this country and province. We have never had a socialist government. Bob MacKenzie pulled through this great labour reform. The Liberals and the Conservatives voted against it. At election time, those two parties bullshit the voters that they represent their interests. This labour reform was long overdue. It was needed. Many employers will take the best of the workers. At the negotiating table, many of them were the masters and we were the servants. With this labour reform, there was no bullshit—we were gonna be equal. When we negotiate a collective agreement, we are there for a settlement. Either you make it or you break it.

I met two politicians from the Progressive Conservative [PC] Party for an interview at Channel 47 in 1993. I had an argument that put them in the corner. Those two politicians were mouthing against this labour reform and I said, “You don’t know what you are talking about. Where did you come from? You don’t know about this labour reform. Did you negotiate any collective agreements? Have you been with the workers? Have you seen how much the workers have suffered?” Really, they were off balance. I told them I have dealt with many employers. I will take my hat off to many. They are gentlemen, but many of them, they are less than gentlemen.

I wrote an article on labour reform. The priest at my church and some of the people said we did not know where the Liberals really stood. Now you know. We have been telling you all the time that there is no difference between Liberals and Conservatives. They are two of a kind for the capitalist system. They have never been for the workers. Bill 40, introduced by the NDP government around 1993 in Ontario, was the best labour law in
North America. It was excellent for the worker and companies. Then the Progressive Conservative government was elected in Ontario on the 8th of June 1995 and they repealed Bill 40. The union was set back seventy years.

Have you seen workers against workers in labour disputes? Have you seen brothers against brothers—one in management and one belonging to the bargaining unit? I called it awful. I saw blood brothers against blood brothers, people who were hurt. My son was involved for a little bit. He was working in some of the shops when he was a student. But he doesn’t have a thick skin the way I do, and he heard some of the workers speaking against the union, and in some cases some of the workers said disparaging remarks about his father. And I smile because a lot of people, they don’t know any better. He resented that and said, “Why should I work with people who do not appreciate what they have?” The people who do not appreciate were a small percentage. Jesus was an excellent person and, in the end, what did they do to him but put him on the cross? You have to forgive those clowns since they do not know any better. These people who are speaking are not attending the meetings. They are not up-to-date on information. To kill eight hours of work in the shop, they have to shoot some shit. They open their mouths but don’t know what they are talking about. My son says it bothers him because he knows how much I love the workers and how hard I work for them. I still smile. It doesn’t bother me because I am clear with my conscience and I always do my utmost best. Today I am out of the union for fourteen years and people, when they meet me everywhere—in the plaza, on the street, at weddings, or funerals and travelling—they still miss me in the shop. They say the representation today is different. I said, “Don’t give me this bullshit. The representation today is more sophisticated, more educated, more up-to-date. They do better work than I did.” They said, “We wish that was the case.” I say, “It is the case. You are in good hands now.” A lot of things have changed and the change is everywhere—in offices, shops,
mines and on construction sites. Now the employers are looking to have more production with less manpower and, in many cases, that is happening. You can say people are working harder, but that is not necessarily true with all the new machinery, technology and what not. A lot of people produce more with less effort.

Doctors have a union, movie stars belong to their own union, and employers have their own union, which is the Canadian Manufacturers Association. They put a lot of pressure on the government to get what they need or want. Why shouldn’t everyone have the chance to belong to a union? I had the pleasure to speak with Sophia Loren and I said, “Tell me a little bit about the union.” I asked her if she was happy with her union. She said, “The union did plenty for us, including me.” I said, “What do you think about these people that have no union in Canada?” She replied, “If they have a union, they have a lot to gain and nothing to lose.”

I was invited in 1968 to an open microphone show on Johnny Lombardi’s CHIN Radio. The host of the program was Mr. Umberto Crocione. Mr. Crocione said to me, “Jesus Christ, you have the union in your blood.” I just smiled. People phoned in and I answered questions but some of the big shots, they were not happy. One heavyweight person from the Italian community said to Johnny Lombardi, “Kick Rao out, he’s gonna wake up the worker.” I was kicked out and this was in the late sixties. The host was a good person and said he would invite me back when it calmed down and if I kept my nose clean. But I am a son-of-a-bitch. I am not able to lie to the people. They called and they had a big problem with the Workers’ Compensation Board. I said, “You will suffer with it because no one can change the compensation unless you change the government.” It will take some time. Rome was not built in a day.

In order to have press coverage, you have to be a player with the press. From the Italian community I have gotten what I have wanted. I respect them. I do good things for them and when
I go to them, they say okay, fine. Radio, television and newspapers are there. It will pay off to have a good relationship with the media. I never forgot a collective agreement that I signed with Indalex Aluminum in the early seventies which was good for the workers. They were happy. I wrote an article for the Corriere Canadese about it and for the in-house Steel Labour. One day I was stopped on St. Clair Avenue by Nicolo Fortunato. He was an alderman in York. He had read the article and he wanted to interview me for his community television program. It was a good opportunity to let the general public know about what the union was doing. I went and it was no problem. I was re-invited on the show. I then made a deal with Nicolo Fortunato. I asked him for five minutes to report what was going on in the labour movement and he agreed. That lasted a few months before I approached the management of the TV station at York, later Keeble, Cable to see if I could have a half-hour program. They told me to write a letter about the show and they would consider it. After a trial, it was well received. That started in early 1974. For twenty-two years I did a television program, the Labour News, later called the Labour Show. I had guests from every direction: the trade union, politicians, the church, federal and provincial governments and experts on topics like pensions.

I did the Labour Show on Rogers Cable for 14 years, sponsored by the Steelworkers for eight of those. I did it free of charge. Rogers did not charge us for the use of their studio; it was volunteer work. I thought that doing the program would be a plus for the working people. The working people have never had a program. I did it in Italian and English. Trade unions do many things that are good and beautiful within the community, but never communicate them to the people at large. That is one of the big problems for unions in this country. People don’t know about unions. It is not easy to accept the unions. The big problem for unions is communication with the broader community. In Italy or Germany, the union is more accepted by the people because there is more communication. In North America, they
Politics...

are isolated. There are too many unions. Believe me, that is a problem because each president of the union wants to hold their own power. The union should be a social movement. We do not need one hundred, fifty or twenty-five unions. If we have two or three, that is far too many.\textsuperscript{68}

It is not that the unions do not communicate. Each has a paper that costs them a bundle of money. With all this money they should cut out with the bullshit and get one national paper for all the Canadian people. By doing that, they could elect a workers’ government in order to have a government that works for the employee.

From time to time, I had people on cable involved with the old age pension and the Canada pensions. I was asked if I would sit as chairman of the Canada Pension Review Committee, which I did many times. This was a panel of three citizens, which had to decide whether or not to allow a claim. Many times they asked me to sit as the representative of the Health Ministry. I said fine. Other times I have been asked to sit as the representative of the workers. I had no difficulty wearing different hats because my heart was in the right place. We have to do our utmost to ensure that the people coming before the review committee will receive justice. I had the file two or three weeks prior to the date. Always, I had been through the file to see what kind of case it was. In some cases, those workers had no leg to stand on. You can ask, in what way do I mean this: medical evidence. They had been turned down in Ottawa since the medical evidence was not there, or he or she was not disabled enough to qualify for the disability benefit. I was able to somehow inform them at the opening of the hearing that the medical evidence was not there and they would lose if they went ahead with the case. Another appeal would take between two to four years to reach the final step at the Pension Appeal Board of the Canada Pension Plan. A panel of three retired Federal Court judges hears the last appeal. There you either make or break it. I said that the medical evidence is not there. If you can get
more medical evidence in support of your claim, you can ask for an adjournment. Under that condition, you would be surprised how many people would ask for an adjournment in order to get the medical evidence and would return in six months or a year. When they had it, we ruled either in favour or against the claim, but most of the time it was in the worker's favour if they had the medical evidence. Also, the date is extremely important because many doctors say he or she cannot work. If the doctor's report is not correct the first time, it is very hard to get it corrected two years later. Many don't spell out the diagnosis of the sickness or accident. Many are too busy and don't want to explain the illness or about an accident, dates of a CAT scan and x-rays. To spell it out is very important. If the doctor does not answer the proper questions or elaborate enough, it hurts the case. My advice to a person when they are turned down for medical reasons is usually that they revisit a doctor to get the necessary report. In the Italian community, we had plenty of problems, also in the Greek, Portuguese and other communities. Newcomers did not know the procedures and they lost out because there is a limit in the system. A worker needs to have five years of contribution in the last ten. Thank God, in 1993 they changed the legislation. If you file the application late or if you do not have five in ten and there is an explanation why you are filing late, Ottawa will take that into consideration. But recently the government has severely tightened up eligibility.

It was difficult for an immigrant to understand the system. Here the Corriere Canadese has been a very big boost for the Italian community. I wrote a large number of articles. The rules have been publicised. Believe me, there were interested people because when I spoke to them, some had the article I wrote in their wallet or purse. Also CHIN radio has been good. They give us space and we publicise Canada Pension rights and entitlements for the workers. But still there are lots of people who don't read the newspaper, many who do not even listen to the radio or watch the proper channel on TV. On the Labour Show
we assisted them with the appeal procedures, filing the application, and so on. The magazine Steel Labour had an article a few years ago and it went from coast-to-coast. People in Nova Scotia called me. I find a lot of people who applied in the past too late and were turned down, and many who did not know of the pension program. The government is not putting out the information. Lately, the great majority of appeals have been denied. The name of the game is to save money for the federal Liberal government—cut the deficit on the shoulders of the workers. We had conferences—on Canada Pension Plan Disability Benefit and Old Age Security, pensions and Italian pensions—at Local 183, at Columbus Centre, at Earls Court school at St. Clair Avenue and Dufferin Street, and one in Mississauga. Over the years, we have had many conferences. People came by the hundreds. At home I receive telephone calls almost every day of the week. I am giving advice over the phone. My wife says to me “You are retired; why do you bother?” My reply was and is, they need help. Someone must help them. For me, it’s a real pleasure to help others.

With the Italian pension system a person can go to whichever patronato he or she wishes. Normally, they will go to the nearest one they have. Mostly it is INAS which handles the cases, but they are overloaded so they channel some of the work to the other patronati to spread the work around. But at the present time, the work is more divided. Some of the patronati are through the church, some through the trade unions, some through different organisations. Let us say that INAS farms out work, for example to CISL, the socialist one, or ACLI, the Catholic one. They receive their staff from the Italian government. The taxpayers of Italy, they sustain the people in Toronto and everywhere in the world.

Until a few years ago—I think they made the change in January 1992 or 1993—the pension in Italy used to be based on one [i.e., each] year of work or one [each] year of service in the Italian army and you would be entitled to an Italian pen-
Let’s say the pension was 10,000 lire per month. You would also receive a supplement. It doesn’t matter if you were living in South America, Australia, Germany or wherever, they would give a maximum 490,000 lire of supplement so that person might end up with a half million lire every month in pension for life. So the amount with one year of service was about ten dollars and the Italian government would put four hundred and ninety dollars in supplement per month, wherever the person lived around the globe. Then they changed the law in Italy. They said no more supplement. The people who would receive the supplement would only be the poorest. The end result is, if a person now has one year of work in Italy, one year of contribution, he will receive twelve or fourteen dollars a month. The supplement is cut off if he receives the Canada Pension, early retirement or disability benefits. If the person has no other income and is not working, that person will receive the supplement from Human Resources Development Canada. But it has been chopped off, and very few will receive the supplement.

A person can apply at fifty or fifty-five years of age. The patronati here will get the information: in which province you worked, in what country, and they will search in Italy to find the contribution. Once they find the contribution in Italy, they will tell you when you can apply, at fifty-five, sixty or sixty-five. The patronati will file an application, but in order to receive a pension from Italy, it could take years. It could be one year if you are lucky, or two, because of the bureaucracy, or even up to ten years. My advice to anybody who had a contribution in Italy and is fifty or over is to start to work on their application now. The first application is for the search for the contribution, and the second is for the pension itself. It will also take some time because Ottawa has to send confirmation to Italy to say, yes, this individual has been here in Canada and worked so many years. It is necessary to have confirmation that the person has been working outside the country [Italy].

After they changed the law, people were no longer entitled
to both an Italian and Canadian pension. The people who were getting the supplement prior to the new law keep it to the age of sixty-five. At the age of sixty-five, the supplement will then be cut off. There is an accord between Canada and Italy that stipulates that when a person reaches the age of sixty-five, she will receive the old age pension regardless of whether she was working in Canada or not but it will be based on years of residence in Canada. Therefore the Italian supplement will be cut off. The pension will continue only according to the years of service. A lot of Italian people in Canada are pissed off, but there is not much we can do and we have to realise that Italy is also into the red. It used to be generous before it was cut. I would say about sixty-eight to seventy thousand people in all of Canada are on some kind of Italian pension. It is close to two hundred million dollars that comes here to Canada. The best part is that the provincial and federal government get the taxes that people are paying on these pensions. They pay a tax in Italy; they pay a tax here. In other words, those pensions are getting double-taxed. France also has an accord here, where French people do not pay tax on pensions. The Italian people were discontented. We wrote to Mulroney and the Minister of Revenue. They did not reply, as if they did not receive the letter. In other words those pensions are getting double-taxed.

I was unlucky because nobody took my pension contribution to the proper place even though I was working for the government of Italy, il forestale, the Department of Forestry. They did not report it. We were working in the mountains to make roads, plant trees in the south of Italy, in Calabria in ’48–51. Many people who worked with me didn’t get any contributions made for them. But Italy after the war it was complete chaos, a disaster.
If there is anything wrong with the newspaper or the radio, I speak to them. I am not one to say “Come vuole Dio [as God wills it].” If I have a disagreement, I will give it to them. One-day I went to the Corriere Canadese with seven pictures and an article about our social club. I gave it to them and they closed their eyes. I told them they were lucky that I fed them so much information. They argued that many times, for the other clubs, the paper only uses one picture. I said, “Look, the other clubs, they are sleeping. They don’t send you a picture. If you send a photographer, you will get a picture. If you do not send a photographer, you won’t get a picture. With our social club, we always have our own photographer and plenty of pictures.”

When I do an article, that article will go at least to four papers in the Italian community: Corriere Canadese, Lo Specchio, La Gazzetta, and Vita Italiana. La Gazzetta is here in Toronto. They have difficulty with money. They have a number of people who advertise, but they haven’t paid them because business is bad. They make some sacrifice to publish it. It has been published by Italo Luci for more than thirty years. It is for free, paid for by the advertisements in the St. Clair Avenue, Eglinton Avenue, Dufferin Street area. I always get a couple of hundred copies and send them to southern Ontario, Italy, South America and Australia and they really appreciate it. One friend went to Italy on Palm Sunday in 1984 and I sent about fifteen different copies for the mayor of San Giorgio Morgeto, la provincia Reggio Calabria, and they put all the publications into the library.

I gave some articles to the Forze Nuove run by Elio Costa, Odoardo di Santo and others. There had also been another socialist paper before it, which lasted a year or so, called Il Sole that Odoardo di Santo and Gino Fantauzzi created. The problem is getting the Italian community to subscribe to a newspaper is impossible. This you can compare to the reluctance of
Italian Canadians to buy a newspaper. If it is for free they will glance at it, they will read it. But if they have to pay so much per, say, every six months, hah! you won’t find a market for that. We do not have a large number of readers and this is bad.73

I will say, the newspaper will help the individual, the family and the kids. I have always been a subscriber of Corriere Canadese and Il Giornale di Toronto until it closed. When my kids were in elementary school and high school, I asked them to read one article a day. I know that it was a big pill to swallow, so I told them they had a choice: big article, medium article or small article. After they read it, they had to read it aloud to me. I also sent them to Italian language school in the summer. Today both of them speak Italian. In the summer time, I did not leave them on the street to only play with others, I said, “You will go to the Italian language school.”74 They asked why. I told them they would find out later. Either you go, or my boots will go where the sun does not shine. So they went to the school. Even my nephew was going but he pulled out. His father said, “If this is what you want, fine.” But he, Gino Fazari, was complaining not so long ago to his mother. He said, “How come Connie and Nunzio,” referring to his cousins, “speak Italian and I don’t.” His mother answered, “It is because their father pushed them and forced them to go to the Italian school when they were young.” “But how about me?” said Gino. “Yeah, you were too, but after a few weeks, for one reason or another, you pulled out and your father didn’t say too much.” My nephew can speak the dialect of Calabria and now he is sorry he never went to class for Italian. To give you an illustration, just with my son, he is dealing with a lot of people, Italian and non-Italian. Italians ask him how long he has been in this country. They do not believe that he was born here because his Italian is so good. Some ask him which region he was from and he insists that he was born here. My daughter is working at the airport and many times she was able to help Italians find their way because she speaks the language and could explain procedures or directions to relatives. It was a
big boost for these people.

I was involved in the early 1960s in the Italian community with Comunità San Giorgesi, the feast of San Giorgio Martire and San Giacomo Apostolo. We had those celebrations the last Sunday of July—that was the feast of St. James, the 25th. The statues came from Ortisei, in the province of Bolzano, Italy. We used to have people from the U.S. and Ontario at Marylake, north of King City, Ontario. Almost 15,500 people would come. The place was packed. It was organized by me and the executive of the feast-day society, the Comunità San Giorgesi. Some Italian families from Woodstock, Kitchener, Welland, Thorold, Guelph, Hamilton, Toronto, Oshawa, Ottawa, and even Albany, New York would come for those feasts. The part I enjoyed the most was seeing the old people. They shook hands after so many years apart. Many of their kids got married with kids of friends. I arranged that feast for nine years as president of that organisation. Now it is in the hands of others.

The idea behind the Circolo Morgezio club has been, for twenty-six years or so, since 1974, to bring together the people from my hometown. I have been the president for all this time. We used to have two dinner dances per year but, today, just one a year. We also promote citizenship. Before Jesus was born, we had a long history in San Giorgio Morgeto. [According to legend] a king lived there by the name of Morgezio. He had two sons, one named Italia and the other Calabria. Pope Eusebio was born there and was Pope over 1600 hundred years ago. We used “Morgezio” for the club and not “Morgeto” because Morgezio was the original name. Edward Lear described the city of San Giorgio. Who can say why? We don’t have two hundred thousand, but only a few thousand people. During his visit, he observed, the earthquake destroyed everything nearby. But San Giorgio Morgeto is on the mountain. It is built on the rock. The earthquake did not bother San Giorgio Morgeto. Old houses were cracked, but never knocked down. Everything around the town is flat territory filled with olive trees, and then the sea. On
special nights when the fishermen are out, it is beautiful with lights on the boats. It looks right out at the Mediterranean. It is something, really. The location is really fantastic.

I went back many times, not only to my birthplace, but all over Italy and Europe, also South America, the United States and California. But you cannot find a place better than Toronto. I have roots here. This is an old house. When people see this house, it is a story. It’s a floor and a half, with a peaked roof. I recall people passing by. When they see me in front cutting the grass, they say, “Do you live here?” They were expecting me to live in Woodbridge or a big shot house like at Avenue Road or off Spadina Road. But this is a modest house for a worker. I spent a lot of money to fix it the way I wanted it, but I left the model that I found many years ago. My kids grew up here. I have a big backyard that those houses that they build today don’t have. Many people, they go to their cottage during the summer. I laugh because this backyard here, I wouldn’t exchange with anything. We have grapes. We have our own fruit. I used to make wine from our own grapes. Now I give the grapes away every year. I don’t make any more wine.

With our social club [Circolo Morgezio], we have been assisting members and non-members with the problems they face with many government agencies. The best part of this social club is that it assists people who are less fortunate than us. We give a donation at each event that we have. Always, whatever we make at each dinner, we donate to the needy people. I don’t think you will find other clubs doing this. We had people from Italy who come for surgery here and, always, we’ve contributed to help them, or for earthquakes in Italy, or elsewhere. For Villa Colombo, we have always donated to it. And the Caritas project for helping against drug addiction, Sick Children's Hospital, The Kidney Foundation, The Heart and Stroke Foundation. We help to fund the Good Friday Cristo Morto procession on College Street in Little Italy. The funds raised by the social club go for various projects. We send money all over the world for earth-
quakes or disasters: Africa, Asia, India, Mexico, Somalia, Russia, Florida for Hurricane Andrew, the ice storm in Quebec [see Appendix C].

One organization that also helps is the Steelworkers, through the Humanity Fund. It gives money to the Food Bank, and to needy people in the Third World to irrigate land, make the drinking water safe, build schools and buy and send medicine. The Humanity Fund is something that is fantastic. The CAW and others now have these funds. The money comes from union members, a few companies and our social club. We have a number of meetings a year and on the agenda is a part for donations. If there is a crisis, I sometimes phone people and say, “You heard what happened in India? We are going to send a donation.”

They did the monument here at St. Clair Avenue and Lansdowne Avenue in memory of the Italian immigrant and they approached us. We donated five hundred dollars. I think it is always money well spent. When we have a dinner and dance I report to the group at large and they are proud of what we are doing. We have a lucky draw. We pay for two tickets to Florida and we have those two tickets plus a radio or something else, and at the end I send a letter thanking the contributors for support and listing them. We remind members over the years what we give it to.

My members asked me to have a headquarters, a recreation spot for the young people. These people have the money for it, they'll give you the place and you have to make double-sure that you'll run it. I spend so much time, but I am not prepared to open a social club and collect the smoke of others and spend each night there. I want to be free on evenings to go for a nice walk. I told them I would assist them. I could get the license, but somebody else should be in charge. This place, my home, is the address when we have the meetings. We have people from Woodbridge, Scarborough, Mississauga; they come here for the meetings. My wife gets used to having that crowd here as the
meeting place. But the executive is getting older. People from the five continents of the world come to every dance. It is not just for ourselves. When we reach the ticket limit for our dinner dances we say, sorry, we cannot take any more. It is open to each and every one. Today we still get a full house. We don’t cut corners when we do something. The evening will be rich in food, the best. Because of fundraising, the food won’t be less—there will be plenty of food there. We negotiate with the catering person in order to serve us right. We went to two or three places but mostly we went to the Mona Lisa and the food there was fantastic. For nineteen years we went to the Mona Lisa at Caledonia Road and Lawrence Avenue before it stopped operating in 1994. I guess we did one or two outside that, and we returned fast. I love it and the people, they love it also and are still talking about it. To organise anything you have to be born with the skill. It is not something you can pick up in school. For organising—I am not bragging—it is my bag. I love it. I spend so many hours on details. For an event, I spend one day writing to people and the following day [the day after the event] I deliver pictures to four different newspapers.

A number of the Italian social clubs will stay, but a good number will close. We are a member of the Calabro-Canadian Confederation [CCC]. We just joined in 1993 to see the federation grow and expand. We joined because I can see a future there. There are about two hundred thousand Calabresi in Toronto. We are the largest community of Italians. If we’re going to get our act together the ground is there to build a complex, perhaps for seniors, for the community. But we are divided. I tried to solve the problem, but we have people who are not mature yet. For this reason, I said I will let them grow up a little bit and maybe they will see things differently. If there will be something good for the community, I am prepared to work for it. Some other people have a different view altogether. We have to step back and ask this group of Calabresi, “And what are you going to do?” Every group has its own problem. There is a problem,
but I hope that some day it will be resolved. Once it is resolved, the community from Calabria will benefit. We have a consultore from Calabria,\textsuperscript{85} Benito Bellantone. He is a very fine person and because he is too good, a lot of people will say he is no good. But in my book, I have the highest respect for him. He knows what he is doing. He has come to some of our events. He is the consultore and I give him my vote. He represents us very well; there is no doubt. But some other people say, “Why him? I myself should represent the Calabresi.” I disagree. He also used to be the president of the CCC. There was some controversy, but he is doing a good job. His business is located at Jane Street and Sheppard Avenue, on the left side going north—Beltour Travel. Ben organises tours so that, when I am going to San Giorgio Morgeto I will see my relatives and friends in one or two days and then I will leave. So any time I go to Italy, I never stay in one spot. I spend one day here, a half-day there, etc. I make everybody happy. Some other people, they have no other friends and they are stuck in one spot for the duration.

Casa Calabria came along when the NDP and Premier Bob Rae were in government from September 1990 to the 8th of June 1995. Let’s say in 1991 and 1992, they came up with Jobs Ontario and they put a lot of work into the Province, trying to help many groups. A number of Italian groups applied for grants from the government. We wanted to build apartments for seniors that would be low cost and there were a good number of people looking for grants. Tony Silipo was Minister for Community and Social Services in 1992–1993 and these people knocked on Tony’s door to urge him to push the Cabinet to promote this idea of funding a centre for people living in Toronto from the region of Calabria.\textsuperscript{86} I know Bellantone was one, the National Congress of Italian Canadians had an application in, and another group of Calabresi from the town of Montalto Uffugo, led by Emilio Bisceglia, also had an application in.\textsuperscript{87} Tony told them it would be impossible for each of them to receive a grant. Tony called a meeting of people from Catanzaro, Cosenza and Reggio and
told them that if all of them were willing to work together and file an application for all Calabresi in Toronto, he would have a better chance of succeeding in the Cabinet. Two or three groups decided to withdraw their application. Montalto Uffugo did not, and they received a grant.

A joint committee under Gregory Grande as president filed an application for all the Calabresi and received 1.5 million dollars for a trade centre and community complex. We were promised it. We were also promised about ten million dollars for eighty units of low cost rental housing. We were going to build this complex. We had a good constitution, a committee to search for lands, and a fundraising committee. We were thinking about different locations for the community center. We had some in Toronto, North York, Vaughan. The name of the game would be to have it where people could reach it by subway or bus. We did not pin down the location; we had a beautiful location at Jane Street and Trethewey Drive. The Sorbara Group had a location at Keele Street and Finch Avenue, but it was not that big. The neighbourhood residents did not want us and the parking was a problem.

At one point we had “well-educated” people who behaved badly just to disturb the meetings. They were unhappy with the minutes. Once they missed a meeting; the following meeting they interfered. They were not builders. They were dividers. Some people are mature at twelve years and some at seventy years. These people had been in school, they had more education than I was lucky enough to receive. They have no idea how to behave when there is a meeting, how to obey the agenda. I have been working with thousands of workers with some education or none, but still, Jesus Christ, we could run the agenda. It was always followed. We used to have a meeting with five hundred people in one or one-and-a-half hours and we covered a lot of ground. Here, with twenty people, we started at 7:00 and finished at 1:00 in the morning with no conclusion. That will tell you that we were not mature. It was ridiculous.
One evening, I almost exploded. It was as if I dealt with people who had never been in school. [I thought] Don’t you people look in the mirror in the morning? Fine people, but at those meetings, they were nothing else but shit disturbers. Tony Silipo invited all of us. People who came that evening were from the previous meeting, maybe a few more. There was some bad blood prior to this meeting and this bad blood will never disappear. They were a combination of business people, labour, community groups. We would have offered not just a community centre, but a place to help people access social services. But the Calabrese people lost everything when Harris came in. At one point, two of the people jumped out and applied to do their own project. But it did not work. The people involved stepped out of the committee. Others followed them. Some of them resigned because they felt the same or just had had enough.

The reporters from Corriere Canadese questioned us, “Did you call them Judases?” Because of the old saying about Judas, and Jesus saying, forgive them, they do not know what they are doing. That was the part with Judas playing with God—I started many times to read the Bible but I never finished. Basically it was bullshit what the people are saying. We said they acted worse than Judas, the way he treated Jesus. Instead of building, we had to work on repairing what they did. They went to the Sun, the Corriere Canadese and the CBC. From the spark of that remark, which was in the newspaper, these two gentlemen charged us: Channel 47, Corriere Canadese, Benito Bellantone, Dan Iannuzzi, Rino Iannone, Tony Rizzo and Fortunato Rao. We had to hire a lawyer. They charged us with slander because we called them Judases. Let me say it was wrong on our part. We went a good number of times to the lawyer. I was willing to resolve this matter so we didn’t need to go to court. I said to the committee that we could pay the expenses they had up to now, and this would be over. We made an offer of $1500 with an offer of some sort of apology. These gentlemen refused the offer. Then we had to make our defense to our lawyer—the
statement of fact. We spent so much time. I said we agreed that we should go ahead to fight these gentlemen. The lawyer took it on. Once they received the statement of fact, they stopped right there—at two years.91 The only thing I can say is that to be on this committee I had to spend $2000 of my money from my own pocket! We had money which we collected, but I said, “Don’t touch that money.” In a way, we should have used it. We had no insurance. We were not covered. Each and every one, we paid from our own pocket. What did we do wrong? We defended our own Calabrese community from those two gentlemen who jumped ship to destroy it.

At the end of this, the Montalto Uffugo group had their money and were working really hard to conclude their project and we were, too. We invited all the presidents of clubs and associations from the Calabrese groups, but they did not respond. The end result was that the turnout was very poor. The Calabresi, we are the best in the world when we have to help others. We have a big heart. But the Calabresi in Toronto, when they had to do something for themselves, there was so much jealousy, division and mistrust. Many people were waiting for this project to collapse. We missed the train. We had almost $12 million promised from the province. We only had to raise $750,000, which was part of the deal to qualify for the government grant. Premier Bob Rae’s time expired and after the general election on June 8th, 1995 the Tories killed our project. We had the paperwork ready and we had chosen a place, but since we had no hole in the ground dug, that was enough for Mike Harris to cancel the job. The Montalto Uffugo people lost everything when Harris came in. The group of Abruzzesi had their work underway and they woke up were ready to apply for the grants much sooner than the Calabresi. Harris tried to bullshit them, but they told him they did enough work already; what was required to get the deal done. I congratulate them because Italians have benefited.92

We had about twenty-six or twenty-seven thousand dollars in the bank. From time to time, I am talking to people on the
committee and someone suggests that we give it to a charitable organization. I said this money should be kept. If, someday, something good will come about for the Calabrese group, then it will be there. The Treasury will be there until it is needed for our people. The only thing that was given back was one thousand dollars from a club, and our club, the Circolo Morgezio received the two thousand dollars it donated. We were the only two clubs to have donated any money. All these clubs and associations were like pieces of ice. And these are good people, because I saw them working for other projects in the Italian community and they give their hearts, time, everything. Now we had a chance to do something for our people, and why did they act like pieces of ice? We rented a big hall for fundraising in which we could put one thousand people. We ended up with around two hundred and fifty or three hundred people. We had an artist from Calabria come, Francesco Arrante, and we rented the Cardinal Carter Theatre at Sheppard Avenue and Yonge Street for the performance of “La Zia Teresa.” We could fit seven hundred and fifty people there. We printed the tickets. We advertised on radio, television and Dan Iannuzzi helped us through the Corriere Canadese. I sold over one hundred and fifty tickets, but not many others were sold. We did not even have three hundred people for this show. It was a disgrace and a disaster. If these people were bad, I would say screw you, but they have a big heart for others and a small one for themselves. I will sum up in a few words: We have to grow up first. I won’t see this done in this generation for the Calabrese people. It does not matter which province they are from. The location where you were born does not matter at all. We have people who have all the money in the world, smart people. They have the idea that when God calls, they will take all this money with them under their right or left arm. They are not willing to do anything good for the community.  

We started to talk about Villa Colombo in the late sixties, when it was only a dream. In the early 1970s we tried to talk more about an old age home and the end result was that I was
on CHIN radio fundraising with others. The people who knew me chipped in ten, twenty, fifty dollars at a time. Everybody chipped in and that was nice, but still there was no Villa Colombo. We were trying to raise more money. One evening at The Inn on The Park, Jerry Lewis was there and each one of us made a pledge of so much for the Villa. The project was well received in the Italian community. We explained it would be a home for seniors and finally, in '76, it was opened and it was some big splash. The people that are at the Villa, all of them, they benefit from the atmosphere. I was one of the lucky ones who, I will say, was involved from day one with Villa Colombo, and also with the Steelworkers. They were good because I had been requesting money from the local unions. They donated to the Villa, both where we had Italian workers and even where there were no Italian workers. I asked for a donation and they said, if you think this donation will go in the right place, then go ahead, you can have it. We had movie stars for the telethon who came from Italy—Rosanno Brazzi and Sophia Loren—and I was pleased to be there to present those cheques on behalf of the Steelworkers’ members to the Villa.

There was some conflict between the workers and the wealthier Italians over Villa Colombo. Some people call the big donors bastards. I said, look, you have to respect those people because they have a good idea. I fight with some of them, even with leaders. Some people have tunnel vision. They don’t see tomorrow. They don’t see the future. This is where I said thanks to God that I don’t have that problem. If I have to do work for them [wealthy Italian-Canadians], if they respect me, then I work with them. You talk with Anthony Fusco, Consiglio DiNino and Paolo Ariemma. They know me very well. I had a dispute with the Villa Board when they let go thirty-four people in 1984. But it is water under the bridge. It turned out okay. Yet some people say, he is not an NDP and why should I work with him? This is wrong. If it is for the benefit of the community, I don’t care if it is the devil.
I was in one committee at Villa Colombo, doing something nice for the community. I was asked if I wished to be part of that admissions committee. I said yes. Many years ago, when the people they saw me there, they were suspicious of me. Last year I learned why from a good friend of mine who said, “When we heard that you were coming to this admission’s committee, we were afraid. We thought that you would turn everything upside down. We considered you like a really left-wing bastard and many of us asked what you were doing in our committee, and you turned out to be one of the best.” What a compliment! I said, “Why did you have this negative view about me? And she said, “Because you were part of the Steelworkers, the union, all your life. You fought many employers very hard in favour of the workers. But we discovered that you are a gentleman.” This is the problem that the union is facing. It is a plus to be part of the community. Still, today many union representatives are isolated. They do not get involved with the community.

I was part of the admissions committee and a lot of people from Toronto or outside Toronto, when they applied for their parents to be residents at the Villa Colombo, they were really in love with the place. No other old age home in the world can match Villa Colombo’s design. Recently, I was in Niagara Falls and there are still some people who have the idea that the Villa was built for the rich. There were a lot of people in a [seniors’] house in Niagara Falls and someone said, “Well, our father is eighty and before he was mentioning to go up to Villa Colombo. But it’s a question of money to be a resident there.” I said, “Will you repeat what you said? What do you mean, a question of money?” “Well, the [old age security] cheque plus more money.” I said, “Look, I can tell you that nobody was turned down because of money because it is not the case, and I know the question of the Villa inside out because I am part of it. I will tell you, if your father wishes to live at Villa and you kids are happy to have your father there, it will be fine because it has a wonderful atmosphere. The question of money, forget about it. If your
father has the amount of money to be full-paid, then fine. If your father doesn’t have the money to be full-paid, for that he is not rejected because the provincial government will put up the rest of the money for any senior who is there. The money is not of concern for the Villa. The Villa is there to serve each and everyone who applies; of course, based on their need.” So they were relieved when I gave them this information. God knows how many people in Toronto and elsewhere I gave this information to. They have some clue, but, generally speaking, they don’t have a clear picture of what the Villa is all about. I am there every week and I am really happy to see the happy faces. And, also, I had the experience to see people who were residents at other old-age homes and for one reason or another they heard about the Villa and applied. Eventually, they were admitted and two weeks after, you did not recognise these people any more. When they came they were depressed, but after two weeks they were alive. Don’t forget that a lot of seniors don’t speak English and if they are in an environment where the Italian language is not there, these people are isolated. They cannot exchange any conversation with anybody. If the food is not to their liking, they can suffer the consequences. You can’t say they are starving—nobody is starving—but it is not easy to have a dish that is not what you really want. At the Villa they have the Italian atmosphere, Italian food. If they are in good health they can have a glass of wine at noon and in the evening. The Church and Father Luigi Malorzo arrange trips that make the difference for those seniors. Many of them say, “I am really sorry I did not come sooner.”

Villa Colombo, I guess the provincial government will screw it up because they will have central applications and then they will tell my father or your father or somebody else’s father, you go to this old-age home. It is being changed and it is not just one party changing it. It has been in the cards many years. Each government tried to fix the system for old-age homes. I think it will be changing. But I hope they will have enough sense to see that if there is a Portuguese old-age home, a Greek old-age
home, an Italian old-age home, and if the person's preference is for the Villa, then they can go there. We are many of us here. I hope the situation will improve. The question that I have some doubt about is if the young people will take part. But there are a few of them that will take part. Those few will work hard to make it happen.

We do have an Italian community—it is too bad that we only have it all together when something happens. The community was all together years ago for the anti-Mafia rally on St. Clair Avenue. The Italian community is here and if somebody is in trouble, it always responds very well. When something happens in Italy, the Italian community comes together for an earthquake or disaster or whatever. The Italian community, I would say, is very strong: there is no question about it. It is brought together when there is an appeal for something that has merit. Father Carparelli and his Caritas project against drug abuse; we admire him. When he announced through the radio that he needed money, believe me the Italian community, pensioners, people that don't work, they squeezed together ten dollars, twenty dollars, and chipped in. I think it is much better to have ten or twenty dollars from these people and a large donation from the business community. So the Italian community built Villa Colombo and it also built Columbus Centre. The Italian community is all together if Johnny Lombardi says let's have a picnic on the Toronto Island. The Italian community, I would say, is very strong, there is no question about it.

Young people of today—I will say the way it is, but maybe I am wrong—the young people have a gold dish on the table. They don't give a shit about the recent recession because there is a Mommy and Daddy taking care of them. What do they care, if they have a nice car with their mother paying gasoline and the insurance for them? A big majority of the young population doesn't care whatsoever, because they are not facing any problem. They are without responsibility. I can be wrong, but I will express myself the way I see it. I am not bundling each and ev-
ery kid all together. But a good majority, they are spoiled. I don’t blame them. I blame the father and mother who spoiled them. To kids, I’d offer them the fullest in education; but, besides that, I wouldn’t give them a penny. They have to sweat and work to make their way. When the father buys a $30,000 car, the kids don’t give a shit as long as the car has enough gas in the tank to make the motor run. When it is empty they think their parents will give them enough to get another full tank. If they buy the car for themselves, they will understand responsibility. The worst part of this is that as soon as the kids get their driver’s license, they leave school. They do not study hard enough. They switch from a good road to a bad one.\textsuperscript{101}
Fortunato Rao: Résumé

Services to people have been my life’s work. My work with the government, the volunteer sector, the media, education, business and the labour movement all contribute to my understanding of Canadian society.

Government

Throughout my career I have worked with government at every level and encouraged people I worked with to respect the political process and to get involved in it. As an example I was a candidate for alderman in the City of Toronto in 1969. My citizenship programs put new voters in touch with political choices. As a union representative I contacted government almost daily. At the worker’s compensation board I represented thousands of employees (and still handle claims for people who use the services of social, community and other voluntary organizations).

I learned the functions and operations of administrative tribunals in dealing with the Ontario Labour Relations Board. Here management and labour are required to respect each other and to work for consensus. Government’s role is to set rules. The labour union is a fascinating place to learn about the impact of values, the economy and government on the individual employee and the employer.

At the Unemployment Insurance Commission I dealt with appeals at the board of referees and the umpire.

I have also represented workers at the Tax Court of Canada, the court of appeal board of the Canada Pension Plan, the Workers’ Compensation Board and the Workers’ Compensation Appeal Tribunal. In 1988 I was appointed to the Workers’ Compensation Appeal Tribunal as a part-time adjudicator.

My involvement in workers’ compensation is a special area of satisfaction for me. As a young construction worker with a young family I was injured in a workplace accident. A painful back injury resulted, and I never forgot the feelings of the injured
workers. They wonder what kind of future they face. While I was recovering from my injury I hoped I would one day have the chance to help other injured workers because I understood in my pain what they felt.

In my union work I was responsible for building political education programs in workplaces. These political education committees informed workers about political issues and were designed to increase participation in the political system by encouraging them to vote, to work for candidates and to become better informed about local, provincial and federal issues.

Politicians from every party (and independents) have appeared with me for dialogues on current issues on my Rogers Cable television program. My efforts in the opening of Villa Colombo, INAS and Columbus Centre put me in touch with various departments in government, as I helped these organisations secure funding for social programs and services to the elderly and disabled.

**Volunteer work**

Thousands of new Canadians have been introduced to citizenship in their new homeland through courses I coordinated in Toronto. These briefings on Canadian law, culture and government enabled thousands of immigrants to become more fluent in their new surroundings. From the time the courses opened in 1970 their reputation has expanded so much that courses have waiting lists.

My role was to inspire new immigrants to take the step to citizenship. I helped them accept the responsibilities of citizenship and appreciate the importance of Canada's institutions. A successful citizenship program required me to work with employers, unions and the secretary of state's office. Wide coverage in the news media proved the importance of the citizenship course and extended its popularity.

Community involvement has been central to my life. In my view, participation in the culture and day-to-day life of the com-
munity is absolutely necessary for progress as a society. For immigrants, the neighbourhood is the entrance to Canadian life. From 1963 to 1973 I was president of Comunità Sangiorgese. This group linked new Canadians in the Italian community with their relatives and roots. In 1962 we imported statues built in Italy. These six-foot statues of St. George and St. James inspired pride in the community. They were symbols of our gratitude to Canada and our ties to our old country.

Comunità Sangiorgese also organized the annual feast at Marylake, north of King City, a religious event that attracted some 15,500 people in the 1960s.

In 1974 I helped found the Circolo Morgezio Social Club. At the time few organizations existed to promote multiculturalism. From its beginning as a social group, Circolo Morgezio soon expanded to fill other duties and provide additional services, including financial assistance and counselling. From the beginning to the present I have been privileged to be elected president of the club.

But Circolo Morgezio is more than its social and local activities. It is also a window on the world for our membership. The club has raised money for victims of the Barrie, Ontario, tornado and the Armenian earthquake. It makes financial contributions to Toronto food banks. Club members make an annual donation to the international development projects of the Steelworkers’ Humanity Fund.

Villa Colombo is another volunteer phase of my life, one that I have special attention affection for. In the 1960s Italian-Canadians in Toronto realized they lacked a home for retired members of the community whose families could not care for them. Villa Colombo became a reality in 1975. My connections with the community and the labour movement were considered important by the pioneers of Villa Colombo. Donations were required, and I helped this critical part of Villa Colombo’s history. Now I am on the admissions committee.

Alongside Villa Colombo stands another important part of
the Italian-Canadian community, a part in which I played a role: Columbus Centre. This provides social programs. For younger people, Columbus Centre is near the heart of their experience as children of the new Canadians who flocked to Toronto from Italy in the 1950s and 1960s. I was honoured in 1984 with a medal for volunteer services from the premier of Ontario. The same year the mayor of Toronto recognized my work in the volunteer sector with a Civic Award of Merit.

Today (and since 1985) I am proud to be part of the selection committee for this same Civic Award of Merit, representing the City’s important labour movement.

My experience in Metro Toronto brought my name to the attention of ethnocultural communities elsewhere in Canada. As a result I was named to the board of INAS-Canada, St. Charles Church (where I have been a member since 1957) and other community groups. I continue to contribute my time assisting with workers’ compensation, unemployment insurance and the Canada Pension Plan. Since 1989 I have been chairman of the INAS advisory council.

In 1988 I was named a member of the Canadian Chronic Pain Association, which was founded by a doctor to assist injured workers who have no union or other representation. In 1990 I was elected to the board of directors.

The Media

Years ago I realized that the demand for services improved the quality of life in our community. Sometimes people lacked services to help them. Often services were available, but people did not know how to find them. I consider the news an important part of every organization’s mission. For that reason I asked the Rogers Cable organization for time to televise a program aimed at average people, to tell their stories and reflect their needs. The people at Rogers asked me to line up guests for the program and to host the show on the air.

In 1975 this show went on the air. It is the longest-running
program devoted to working people’s issues in the country. The program is shown across southern Ontario on cable. Via cassettes it is distributed far beyond the Rogers territory. The program has dealt with various topics ranging from unemployment insurance to union activity, from workplace safety to government, citizenship and human rights. Politicians of all parties and from all levels of government have been guests.

**Education**

I consider myself first an educator, in a broad sense. My life is about learning. My work is about teaching. My citizenship schools educate new Canadians about the role of government in their life and about their obligations as voters and taxpayers. My community efforts educate people to acquire a sense of community and responsibility toward one another: toward youth at Columbus Centre, toward the elderly at Villa Colombo, and toward their fellow workers in the labour movement.

For the United Steelworkers of America I have served as a teacher in schools for hundreds of members who wanted to learn about the contents of their union agreements and about their union’s history and goals. As a union organizer, dating from my earliest work experience when I arrived in Canada in 1952, I have helped people learn to protect themselves and acquire more self-reliance.

I have been an instructor in citizenship courses in the Steelworkers’ Union and at Columbus Centre. These classes prepare immigrants to accept the responsibilities of Canadian citizenship. I designed a course for new citizens that has been copied by other instructors and praised by Citizenship Court judges.

**Business and Labour**

For more than two decades I worked as a union representative. This was a job that took me to various parts of Canada and to other countries. It was for me the greatest opportunity a person could have to serve and learn. (I took special early retire-
ment from the Steelworkers in a plan to reduce staff and cope with the cost pressures of a decline in membership caused by plant closings and layoffs.)

Workers depend on their union. Through the 1960s and 1970s legislation developed requiring employers to operate safer workplaces and to insist that unions respect the diversity of their memberships. Leading a bargaining committee is more than cheerleading. One must account for workers' goals with a sense of the employer's ability to pay.

As staff representative you balance the interests of older and younger workers. You accommodate the requirements of workers with higher skills and those who wish to be trained for new work. Bargaining goals are evaluated with research. Success for a union negotiator is agreement, not dispute. I had one of the best records on our union staff for solving problems.

Throughout my union career I dealt with small business people and representatives of worldwide corporations. I feel they regarded me as honest and fair. Conciliation officers who work for the labour ministry have complimented me. Supervisors in the union added new responsibilities to my job throughout my life as a staff representative.

One of the bargaining achievements that I am proud of is the provision in many Steelworkers' agreements for time off with pay—for up to three days—to complete the citizenship process. As a staff representative I led the first bargaining sessions that produced this provision. Another achievement was attaining cost-of-living protection in the aluminium industry, a breakthrough for the times (this was in the 1970s).

I also realized that the labour movement itself needed to adapt to the changing work force. On my recommendation union agreements in the Toronto area were translated into Italian and Portuguese. The union's constitution also was translated.

But as a union official I realized that I was part of a larger community of workers' organizations. From 1967 to 1987 I was a delegate to the Labour Council of Metropolitan Toronto and

The social services committee expanded my knowledge of social policy, welfare issues and community needs such as child care, services for single parents, for the disabled, for people who are struggling to overcome illiteracy. The international affairs committee put me in touch with citizens who are working for housing, education, jobs and justice in South Africa, South America and other corners of the globe.

My union experience also increased my understanding of the financial sector. From 1970 through 1980 I served on the loan approvals committee of the Steelworkers’ Credit Union in Toronto.

Politics is an important part of the community. Since I became a Canadian I have been a supporter and member of the New Democratic Party. In 1989 I was elected president of the Italian Advisory Committee of the Ontario NDP. The committee’s efforts to recruit candidates and election volunteers and to publicize the NDP’s policies were a big part of the NDP’s success in the Italian community in the 1990 provincial election.

There is not a skill I have that was not used in my union life… my fluency in English and Italian… my communications experience with TV and other media… my government contacts and my volunteer contributions to immigrant organizations and to community development.

One of my satisfactions is looking at the seven scrapbooks of newspaper coverage I have received. These are articles in which I was the spokesman for my union, for my community and neighbourhood. Even since I have taken early retirement from the Steelworkers, I am still contacted regularly by reporters from TV, radio and the newspapers for information on employment law, union activity and employee interests.

My philosophy is to do useful work. Happiness follows from contributing to society. It is a faith that my wife and I hand along to our children. I looked backward when I thought of these
milestones and activities from my life in Canada. But I realize I mostly look not behind, but to the future.

– 1990
Circolo Mogezio Social Club
(San Giorgio Morgeto – Reggio Calabria Italy)

A Brief History of Our Unforgettable Town: San Giorgio Morgeto
San Giorgio Morgeto is situated in the Province of Reggio Calabria and is 512 m above sea level; the citizens are known as ‘Sangiorgesi’ and number 6000.
Agricultural Centre of the “Piedemontane” mountains. The town is located on a mountain whereby one can see “Torrente of Messina” as well as the Aspromonte mountains.

Historical Background
At one time Baron Caracciolo di Gerace occupied the town after which Baron Coreale (1458–1501) took it over. It was then ruled by De Cadorna and Milano in the years (1502–1568) and then again by the Milano Dynasty years (1568–1806), after he took his revenge on the De Cadrona. The Milano acquired the title of “Marchese.”
In 1783 San Giorgio was devastated by an Earthquake. To the old name of San Giorgio was added the word Morgeto, in 1864, derived from the old Morgezio that, according to a tradition, arose at the time.

Artistic Sites
Although the town still conserves the medieval structures, the only existing remnant of that era is the ancient castle, partially in ruins. The church of St. Domenic, founded in 1393, was completely restored in the 18th and 19th centuries.
Within St. Domenic’s is the statue of Saint Giacomo made of wood from the 1700s. There are also precious religious and sacred ornaments to be found in the church.
Economy

Located within San Giorgio are two small factories that produce wooden crates: one factory that produces liquors and perfume; one that produces soft drinks; one that produces hair-dressing and cosmetic products; and two oil bearing factories. Agriculture produce is made up of primarily olives, beans, and fruit. Much of this produce is also exported overseas.

Other Tidbits

Feast of the Patron Saints (San Giorgio & San Giacomo) is held on the last Sunday in July. The annual exhibition is held on the first Sunday in July. There is also a high school and a railway station in the town.

Sincerely yours,
The Executive Committee:
Fortunato Rao, Cesare Giovanazzo, Silvio Tedesco, Mario Carere, Arcangelo Rao, and Giacomo Fazari

November 1991
60 Glen Long Avenue, Toronto, Ontario, Canada M6B 2M2
Donations by the Circolo Morgezio

<table>
<thead>
<tr>
<th>Organization</th>
<th>Date</th>
<th>Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>Villa Colombo</td>
<td>May 15, 1980</td>
<td>$100</td>
</tr>
<tr>
<td>Earthquake relief—southern Italy</td>
<td>November 17, 1980</td>
<td>$250</td>
</tr>
<tr>
<td>El Salvador humanitarian aid</td>
<td>May 22, 1984</td>
<td>$100</td>
</tr>
<tr>
<td>Ethiopia Fund</td>
<td>May 22, 1984</td>
<td>$100</td>
</tr>
<tr>
<td>Barrie relief fund—United Steelworkers</td>
<td>July 17, 1985</td>
<td>$200</td>
</tr>
<tr>
<td>Earthquake relief—Mexico</td>
<td>October 30, 1985</td>
<td>$200</td>
</tr>
<tr>
<td>Chiesa Madre, San Giorgio Morgeto</td>
<td>November 25, 1985</td>
<td>$200</td>
</tr>
<tr>
<td>Columbia Disaster Fund</td>
<td>November 28, 1985</td>
<td>$200</td>
</tr>
<tr>
<td>Villa Colombo</td>
<td>October 13, 1986</td>
<td>$200</td>
</tr>
<tr>
<td>Earthquake relief—Greece</td>
<td>October 13, 1986</td>
<td>$200</td>
</tr>
<tr>
<td>Earthquake relief—El Salvador</td>
<td>October 13, 1986</td>
<td>$200</td>
</tr>
<tr>
<td>Steelworkers’ Humanity Fund</td>
<td>October 13, 1986</td>
<td>$200</td>
</tr>
<tr>
<td>Mississauga Italian Centre</td>
<td>December 5, 1987</td>
<td>$200</td>
</tr>
<tr>
<td>Villa Colombo</td>
<td>December 5, 1987</td>
<td>$200</td>
</tr>
<tr>
<td>Steelworkers’ Humanity Fund</td>
<td>December 20, 1987</td>
<td>$200</td>
</tr>
<tr>
<td>Hopeton Edward Trust Fund</td>
<td>March 23, 1988</td>
<td>$200</td>
</tr>
<tr>
<td>Villa Colombo</td>
<td>November 26, 1988</td>
<td>$200</td>
</tr>
<tr>
<td>Flood relief—Jamaica</td>
<td>November 26, 1988</td>
<td>$100</td>
</tr>
<tr>
<td>Earthquake relief—Armenia</td>
<td>December 12, 1988</td>
<td>$200</td>
</tr>
<tr>
<td>Steelworkers’ Humanity Fund</td>
<td>March 18, 1989</td>
<td>$200</td>
</tr>
<tr>
<td>ALATI Fund, Scholarship</td>
<td>April 5, 1989</td>
<td>$200</td>
</tr>
<tr>
<td>Villa Colombo</td>
<td>November 24, 1989</td>
<td>$200</td>
</tr>
<tr>
<td>Giustizia Fund for Toni Preti</td>
<td>November 24, 1989</td>
<td>$100</td>
</tr>
<tr>
<td>INAS—Canada</td>
<td>November 24, 1989</td>
<td>$100</td>
</tr>
<tr>
<td>Canadian Breast Cancer Foundation</td>
<td>October 22, 1989</td>
<td>$100</td>
</tr>
<tr>
<td>Steelworkers’ Humanity Fund</td>
<td>February 6, 1990</td>
<td>$200</td>
</tr>
<tr>
<td>Chiesa Madre, San Giorgio Morgeto</td>
<td>October 12, 1990</td>
<td>$200</td>
</tr>
<tr>
<td>(door restoration and painting)</td>
<td>December 12, 1990</td>
<td>$200</td>
</tr>
<tr>
<td>Caritas Project</td>
<td>December 12, 1990</td>
<td>$200</td>
</tr>
<tr>
<td>Villa Colombo</td>
<td>December 12, 1990</td>
<td>$200</td>
</tr>
<tr>
<td>Monument Allitaliano</td>
<td>March 21, 1991</td>
<td>$200</td>
</tr>
<tr>
<td>Organization</td>
<td>Date</td>
<td>Amount</td>
</tr>
<tr>
<td>--------------------------------------</td>
<td>-------------------</td>
<td>--------</td>
</tr>
<tr>
<td>Villa Colombo</td>
<td>March 25, 1991</td>
<td>$200</td>
</tr>
<tr>
<td>Steelworkers’ Humanity Fund</td>
<td>March 25, 1991</td>
<td>$200</td>
</tr>
<tr>
<td>Villa Colombo</td>
<td>November 29, 1991</td>
<td>$200</td>
</tr>
<tr>
<td>Caritas Project</td>
<td>November 29, 1991</td>
<td>$200</td>
</tr>
<tr>
<td>Hobar der Mino Hospital—El Salvador</td>
<td>November 29, 1991</td>
<td>$200</td>
</tr>
<tr>
<td>Variety Club</td>
<td>February 3, 1992</td>
<td>$100</td>
</tr>
<tr>
<td>Villa Colombo</td>
<td>February 28, 1992</td>
<td>$200</td>
</tr>
<tr>
<td>Steelworkers’ Humanity Fund</td>
<td>March 28, 1992</td>
<td>$200</td>
</tr>
<tr>
<td>Canadian Red Cross—Earthquake in Turkey</td>
<td>March 28, 1992</td>
<td>$100</td>
</tr>
<tr>
<td>Scholarship Fund</td>
<td>March 28, 1992</td>
<td>$100</td>
</tr>
<tr>
<td>Hospital for Sick Children</td>
<td>June 8, 1992</td>
<td>$100</td>
</tr>
<tr>
<td>Club Vallelonga Monserrito</td>
<td>July 13, 1992</td>
<td>$200</td>
</tr>
<tr>
<td>Memorial to Italian Workers Who Died on the Job</td>
<td>July 13, 1992</td>
<td>$750</td>
</tr>
<tr>
<td>Villa Colombo—Fr. Iannuzzi</td>
<td>September 23, 1992</td>
<td>$50</td>
</tr>
<tr>
<td>Hurricane Andrew Relief Fund—Florida</td>
<td>September 23, 1992</td>
<td>$100</td>
</tr>
<tr>
<td>Somalia Relief Fund</td>
<td>September 23, 1992</td>
<td>$100</td>
</tr>
<tr>
<td>Villa Colombo</td>
<td>November 28, 1992</td>
<td>$200</td>
</tr>
<tr>
<td>Caritas Project</td>
<td>November 28, 1992</td>
<td>$200</td>
</tr>
<tr>
<td>Villa Colombo</td>
<td>March 4, 1993</td>
<td>$200</td>
</tr>
<tr>
<td>Steelworkers’ Humanity Fund</td>
<td>April 17, 1993</td>
<td>$200</td>
</tr>
<tr>
<td>Hospital for Sick Children</td>
<td>May 19, 1993</td>
<td>$100</td>
</tr>
<tr>
<td>Memorial to Italian Workers Who Died on the Job</td>
<td>June 4, 1993</td>
<td>$360</td>
</tr>
<tr>
<td>Club Vallelonga Monserrito</td>
<td>July 22, 1993</td>
<td>$200</td>
</tr>
<tr>
<td>Villa Colombo</td>
<td>November 27, 1993</td>
<td>$200</td>
</tr>
<tr>
<td>Earthquake relief—India</td>
<td>November 27, 1993</td>
<td>$200</td>
</tr>
<tr>
<td>Caritas Project</td>
<td>November 27, 1993</td>
<td>$100</td>
</tr>
<tr>
<td>Federazione Anziane</td>
<td>November 27, 1993</td>
<td>$100</td>
</tr>
<tr>
<td>Villa Colombo</td>
<td>March 12, 1994</td>
<td>$200</td>
</tr>
<tr>
<td>Steelworkers’ Humanity Fund</td>
<td>March 12, 1994</td>
<td>$200</td>
</tr>
<tr>
<td>The Hospital for Sick Children</td>
<td>June 16, 1994</td>
<td>$100</td>
</tr>
<tr>
<td>Organization</td>
<td>Date</td>
<td>Amount</td>
</tr>
<tr>
<td>--------------------------------------</td>
<td>--------------------</td>
<td>--------</td>
</tr>
<tr>
<td>Casa Calabria</td>
<td>November 26, 1994</td>
<td>$2000</td>
</tr>
<tr>
<td>(returned to the social club because Casa Calabria not going ahead)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Villa Colombo</td>
<td>November 26, 1994</td>
<td>$200</td>
</tr>
<tr>
<td>Italian Telethon—Rome</td>
<td>December 21, 1994</td>
<td>$100</td>
</tr>
<tr>
<td>Caritas Project</td>
<td>June 3, 1995</td>
<td>$50</td>
</tr>
<tr>
<td>Canadian Red Cross—Earthquake in Japan</td>
<td>June 3, 1995</td>
<td>$50</td>
</tr>
<tr>
<td>Italian Canadian Benevolent Corpo- ration</td>
<td>June 3, 1995</td>
<td>$202</td>
</tr>
<tr>
<td>Hospital for Sick Children</td>
<td>June 3, 1995</td>
<td>$100</td>
</tr>
<tr>
<td>Canadian Breast Cancer Foundation</td>
<td>October 19, 1995</td>
<td>$100</td>
</tr>
<tr>
<td>Villa Colombo</td>
<td>November 25, 1995</td>
<td>$200</td>
</tr>
<tr>
<td>Caritas Project</td>
<td>February 11, 1996</td>
<td>$100</td>
</tr>
<tr>
<td>St. Francis Church</td>
<td>February 27, 1996</td>
<td>$100</td>
</tr>
<tr>
<td>Boston Marathon</td>
<td>April 19, 1996</td>
<td>$100</td>
</tr>
<tr>
<td>St. Bruno Club</td>
<td>June 3, 1996</td>
<td>$100</td>
</tr>
<tr>
<td>Hospital for Sick Children</td>
<td>June 3, 1996</td>
<td>$50</td>
</tr>
<tr>
<td>Canadian Breast Cancer Foundation</td>
<td>November 23, 1996</td>
<td>$100</td>
</tr>
<tr>
<td>Caritas Project</td>
<td>March 1, 1997</td>
<td>$100</td>
</tr>
<tr>
<td>St. Francis Church—Good Friday</td>
<td>March 19, 1997</td>
<td>$100</td>
</tr>
<tr>
<td>Monument to the Italian Worker</td>
<td>March 12, 1997</td>
<td>$100</td>
</tr>
<tr>
<td>Canadian Breast Cancer Foundation</td>
<td>October 7, 1997</td>
<td>$100</td>
</tr>
<tr>
<td>Canadian Red Cross—Earthquake relief, Italy</td>
<td>October 7, 1997</td>
<td>$100</td>
</tr>
<tr>
<td>Steelworkers’ Humanity Fund</td>
<td>November 22, 1997</td>
<td>$200</td>
</tr>
<tr>
<td>Villa Colombo</td>
<td>November 27, 1997</td>
<td>$200</td>
</tr>
<tr>
<td>Canadian Red Cross—Ice Storm relief for Ontario and Quebec</td>
<td>January 23, 1997</td>
<td>$100</td>
</tr>
<tr>
<td>St. Francis Church, Good Friday</td>
<td>March 15, 1998</td>
<td>$150</td>
</tr>
<tr>
<td>Caritas Project</td>
<td>March 15, 1998</td>
<td>$100</td>
</tr>
<tr>
<td>Canadian Heart &amp; Stroke Foundation</td>
<td>May 29, 1998</td>
<td>$100</td>
</tr>
<tr>
<td>Flood relief—Regione Campania</td>
<td>May 29, 1998</td>
<td>$100</td>
</tr>
<tr>
<td>Canadian Red Cross—China relief</td>
<td>August 18, 1998</td>
<td>$100</td>
</tr>
<tr>
<td>Organization</td>
<td>Date</td>
<td>Amount</td>
</tr>
<tr>
<td>---------------------------------------------</td>
<td>--------------------</td>
<td>---------</td>
</tr>
<tr>
<td>Canadian Red Cross—Honduran Hurricane relief</td>
<td>November 5, 1998</td>
<td>$100</td>
</tr>
<tr>
<td>Canadian Breast Cancer Foundation</td>
<td>November 5, 1998</td>
<td>$100</td>
</tr>
<tr>
<td>Steelworkers’ Humanity Fund</td>
<td>November 27, 1998</td>
<td>$200</td>
</tr>
<tr>
<td>Villa Colombo</td>
<td>November 27, 1998</td>
<td>$200</td>
</tr>
<tr>
<td>Canadian Red Cross—Earthquake relief, Colombia</td>
<td>January 27, 1999</td>
<td>$100</td>
</tr>
<tr>
<td>St. Francis Church, Good Friday</td>
<td>March 1, 1999</td>
<td>$400</td>
</tr>
<tr>
<td>St. Francis Church</td>
<td>March 15, 1999</td>
<td>$200</td>
</tr>
<tr>
<td>Caritas Project</td>
<td>April 19, 1999</td>
<td>$100</td>
</tr>
<tr>
<td>Canadian Red Cross—Albania</td>
<td>April 19, 1999</td>
<td>$100</td>
</tr>
<tr>
<td>Canadian Red Cross—Turkey, earthquake relief</td>
<td>August 25, 1999</td>
<td>$100</td>
</tr>
<tr>
<td>Canadian Red Cross—Taiwan, earthquake relief</td>
<td>October 15, 1999</td>
<td>$100</td>
</tr>
<tr>
<td>Villa Colombo</td>
<td>November 26, 1999</td>
<td>$200</td>
</tr>
<tr>
<td>Steelworkers’ Humanity Fund</td>
<td>December 8, 1999</td>
<td>$200</td>
</tr>
<tr>
<td>Canadian Red Cross—Venezuela relief fund</td>
<td>December 8, 1999</td>
<td>$100</td>
</tr>
<tr>
<td>Mrs. G. Mammoliti donation</td>
<td>February 27, 2000</td>
<td>$200</td>
</tr>
<tr>
<td>Canadian Red Cross—Mozambique, flood relief</td>
<td>March 14, 2000</td>
<td>$100</td>
</tr>
<tr>
<td>St. Francis Church, Good Friday</td>
<td>March 28, 2000</td>
<td>$400</td>
</tr>
<tr>
<td>Caritas Project</td>
<td>April 11, 2000</td>
<td>$100</td>
</tr>
<tr>
<td>Villa Colombo</td>
<td>November 25, 2000</td>
<td>$200</td>
</tr>
<tr>
<td>Steelworkers’ Humanity Fund</td>
<td>November 25, 2000</td>
<td>$200</td>
</tr>
<tr>
<td>Hospital for Sick Children</td>
<td>November 25, 2000</td>
<td>$100</td>
</tr>
<tr>
<td>Canadian Red Cross—El Salvador, earthquake relief</td>
<td>January 29, 2001</td>
<td>$100</td>
</tr>
<tr>
<td>Canadian Red Cross—India, earthquake relief</td>
<td>January 29, 2001</td>
<td>$100</td>
</tr>
<tr>
<td>Mrs. Raso</td>
<td>January 29, 2001</td>
<td>$200</td>
</tr>
<tr>
<td>St. Francis Church</td>
<td>March 12, 2001</td>
<td>$400</td>
</tr>
<tr>
<td>Hospital for Sick Children</td>
<td>March 12, 2001</td>
<td>$100</td>
</tr>
<tr>
<td>Caritas Project</td>
<td>April 23, 2001</td>
<td>$100</td>
</tr>
<tr>
<td>Organisation</td>
<td>Date</td>
<td>Amount</td>
</tr>
<tr>
<td>------------------------------------------------</td>
<td>------------------</td>
<td>--------</td>
</tr>
<tr>
<td>Canadian Red Cross—September 11th relief</td>
<td>September 22, 2001</td>
<td>$200</td>
</tr>
<tr>
<td>The Breast Cancer Society</td>
<td>November 1, 2001</td>
<td>$100</td>
</tr>
<tr>
<td>Villa Columbo Home for the Aged</td>
<td>November 1, 2001</td>
<td>$200</td>
</tr>
<tr>
<td>The Humanity Fund for Third World Countries</td>
<td>November 1, 2001</td>
<td>$200</td>
</tr>
<tr>
<td>Canadian Food Banks</td>
<td>November 1, 2001</td>
<td>$100</td>
</tr>
<tr>
<td>Donation to a person in need</td>
<td>November 1, 2001</td>
<td>$200</td>
</tr>
</tbody>
</table>
The Rao House, very ancient and noble; from Pisa, town of its origin, it moved to Southern Italy and settled mostly in Calabria and in Sicily, where it reached great honours and held many administrative and government offices.
Nicholas DeMaria Harney is the Cassamarca Foundation Lecturer in Italian Migration Studies in the Disciplines of Anthropology and History at the University of Western Australia. He was the Research Fellow with the Mariano A. Elia Chair between 1998 and 2000 and its Interim Director during the academic year of 2000–2001 at York University, Toronto, Canada. His publications include Eh, Paesan! Being Italian in Toronto (1999).

Franc Sturino is Associate Professor of History with the Atkinson School of Arts and Letters and former Director of the Mariano A. Elia Chair in Italian-Canadian Studies at York University, Toronto, Canada.
Endnotes

1 The Corriere Canadese is a daily Italian-language newspaper published in Toronto. Vita Italiana is published bi-weekly in Toronto. Rao frequently contributes articles and photographs regarding labour union issues or social club events to these newspapers.


3 Rao completed the fifth grade in Italy. He stressed that this was equivalent perhaps to the eighth grade in Canada. He also attended night school to learn English during his early years in Canada.

4 A useful analytic review of Italian immigrant autobiographies in Canada was offered by Gianfausto Rosoli, “From the Inside: Popular Autobiography by Italian Immigrants in Canada,” in George E. Pozzetta and Bruno Ramirez, eds., The Italian Diaspora: Migration Across the Globe (Toronto: MHSO, 1992), 175–92.

5 Nicholas Harney, “Italy is Enough: Ethnicity, Community and Ambiguity Among Italians in Toronto” (Ph.D diss., Department of Anthropology, University of Toronto, 1996). See also Chapter 7 of Nicholas Harney, Eh, Paesan! Being Italian in Toronto (Toronto: University of Toronto Press, 1998).


8 San Giorgio Morgeto is a fairly typical (South Italian) hill town located in Reggio Calabria, the southern-most province of the region. It is situated on the Tyrrhenian side of the Mediterranean Sea on the western side of the Apennine Mountains and just outside the fertile Gioia Tauro plain, one of four lowlands in Calabria. Before World War II San Giorgio Morgeto had a population of around 5000, a figure that had been reduced to less than 4500 by 1970, mainly due to emigration. Like many Italian towns, San Giorgio Morgeto has its own published local history. The one for San Giorgio Morgeto is an especially fine example since, unlike most others, its historical account extends into the contemporary period. See Raffaele Romano Giovinazzo, San Giorgio Morgeto: Dalle origini ai nostri giorni, vol. I (Polistena, Reggio Calabria: Varamo, 1997).

9 Edward Lear, the noted English humorist and illustrator, was just one of a long series of English-speaking travelers who, beginning in the sixteenth century, left memoirs of their encounter with South Italy. Edward Lear (1818–1888), Journals of a landscape painter in southern Calabria, [etc.] (London: R. Bentley, 1852).

   The encounter with Calabria was often ambivalent. While depicted as fascinating in culture and spectacular in natural beauty, it was also seen as a political and economic backwater stuck in medieval ways. The most famous of these “travel books” was written by Norman Douglas, the zoologist and humanist writer, who in 1915 published Old Calabria (Martin Secker: London), most recently published by Picador Travel Classics (London) in 1994.

10 Edward Lear’s journey through Calabria and Basilicata occurred in 1847. He described San Giorgesi in terms similar to those used by Rao in his account. Lear wrote (1852: 156),
“Among the numerous grand positions of towns in this varied land, San Giorgio may bear an eminent place…the costume of the women is here perhaps the best we have yet seen in Calabria, and the wearers certainly the handsomest.”

While traveling toward the Gioia Tauro plain, Lear had this to say of the catastrophic earthquake of 1783, which entered the folk memory of the Calabresi at least until the mid-twentieth century. “The mind instantly reverted to the fatal days of February, 1783, when one of the most terrible earthquakes on record utterly overwhelmed this beautiful tract of country, and when all this fair western coast of Calabria became one great sepulchre.”

11 Emigrants from Calabria formed distinctive migration chains connecting specific localities of origin to particular New World destinations, which operated through ties of kinship and paesanismo (allegiance to fellow villagers). In the early twentieth century one such migration chain connected San Giorgio Morgeto to Guelph in southwestern Ontario. Originally drawn there to work on the expansion of the Welland Canal, at the turn of the twentieth century, the first San Giorgese settled in Guelph as a grocer in 1903, soon sponsoring others to work in the town’s local industries. By the 1930s around two hundred paesani from San Giorgio lived in Guelph making it the most important group of Italian immigrants. See Franc Sturino, “From Calabria to Canada: The Story of Emigrating People,” in Gabe Scardellato and Manuela Scarci, eds., A Monument for Italian-Canadian Immigrants (Toronto: Department of Italian Studies, University of Toronto, 1999), 20–26. Also see Pat Bowley, “The Italian Community in St. Patrick’s Ward, Guelph Ontario, 1900–1939: Development of a ‘Chiaroscuro’” in Historic Guelph. The Royal City (Guelph, Ontario: Guelph Historical Society, 1994).

12 “Blessed” here is used in the euphemistic sense of “cursed,” not its more religious sense. Gypsies, along with Albanian and Greek-speaking people, formed distinctive minorities in Calabria. Many tales have been transmitted about gypsies that have as their moral to beware their supposed crafty, dishonest practices. Gypsies were important middlemen as horse and cattle traders at fairs, where, despite warnings to the contrary, they did thriving business with local peasants.

13 Here Rao is borrowing the name of Toronto’s main train station to refer to its counterpart in his hometown. Later he again uses “Union Station” to refer to its cognate in Naples. Such linguistic borrowing, of course, is a common feature of immigrant adaptation. See Marcel Danesi, “Canadian Italian: A Case in Point of How Language Adapts to Environment,” Polyphony 7 (Fall/Winter, 1985):111–114.


15 Benito Mussolini (1883–1945) was the fascist prime minister of Italy from 1922 to 1943 when his dictatorial government came to an end. Among several readable accounts of the fascist regime is John Whittam, Fascist Italy (Manchester: Manchester University Press, 1995). Also, for a sophisticated interpretation of fascism in Italy see R.J.B. Bosworth, The Italian Dictatorship. Problems and Perspectives in the Interpretations of Mussolini and Fascism (London: Arnold, 1998).

16 Surprisingly little has been written in English concerning the disruption on the home front caused by World War II and its effect on living conditions afterwards. While outright starvation did not occur, certainly malnourishment was common. There were shortages of fuel, clothing and shelter in many peripheral areas. Such conditions acted as a powerful

17 Il municipio (town hall) dealt with local civic affairs; the la questura and la prefettura were located in the provincial capital and represented the national government for judicial and police matters in the case of the former, and civil affairs in the case of the latter. For purposes of emigration, access to the first two offices were required, and sometimes also to the third (see Sturino, Forging the Chain, chapter 3).

18 On June 2, 1946 a national referendum was held to decide the fate of the Italian monarchy due to the role it had played in the rise of fascism. Italians voted 54.3% to 45.7% for a republican form of government and on April 18, 1948 the first postwar parliamentary elections were held.

19 Canada did not begin to allow Italians to migrate until after a formal peace treaty was signed and Italians were removed from the Canadian government’s Enemy Aliens list in 1947. Significant numbers did not arrive until after an office was opened in Rome in January 1948 to facilitate the emigration procedures. Franc Sturino. “Post-World War Two Canadian Immigration Policy towards Italians.” Polyphony 7 (Fall/Winter 1985): 67–72.

20 Emigration from San Giorgio was almost as likely to be overseas after World War II as to the north of Italy and Europe, and Canada was the most likely destination. This was in marked contrast to the towns of the nearby Gioia Tauro plain, which sent only a small minority overseas. Evidently, the patterns of overseas chain migration established at the turn of the twentieth century held fast for San Giorgio (and some other hill towns) whereas the plain tended to be drawn to the postwar opportunities north of the Alps. Giovinazzo, San Giorgio Morgeto, 189–190.

21 In the autumn of 1950 Canada entered into a bilateral agreement with Italy to foster large-scale immigration to Canada. This, along with a general opening up towards Europe, made it possible for virtually any able-bodied person or relative to be sponsored from Canada and so greatly facilitated Italian immigration. Whereas in 1949 the number of Italians entering Canada was 7,742, by the end of 1951 it had tripled to 24,351, a figure that roughly represented the annual Italian influx during the 1950s. Sturino, “Post-World War Two Canadian Immigration Policy,” 68–69.

22 A vivid description of the arrival and reception of postwar immigrants at Halifax is provided by Trudy Duivenvoorden Mitic and J.P. LeBlanc, Pier 21: The Gateway that changed Canada (Halifax: Lancelot Press, 1988).

23 By the 1920s, the College Street Little Italy in Toronto’s west end had replaced the earlier settlement downtown in St. John’s Ward as the largest Italian concentration in the city. College Street was heavily South Italian, especially Calabrese. In addition, a Sicilian pocket formed to the east of downtown and a Friulan concentration to the northwest.

The location mentioned by Rao is significant since the intersection of Clinton and College streets was the center of the Calabrese presence in Little Italy. In 1961 the College Street Little Italy, bounded by Bathurst Street in the east and Dovercourt Road in the west, contained approximately 16,500 Italians out of a total metropolitan population of almost 140,000. For an excellent account of early Italian settlement in Toronto, see John E. Zucchi, Italians in Toronto: Development of a National Identity, 1875–1935 (Montreal: McGill-


25 The Sorbara family is the best known and most influential of the San Giorgese families in Toronto. Its patriarch, Sam Sorbara rose from humble beginnings in the prewar era to build a business empire centred on real estate development. His son Gregory became a major player within the Ontario Liberal Party and in the mid-1980s was appointed as the province’s first Italian-origin cabinet minister. Another son and lawyer, Joseph, was appointed to the Board of Governors of York University after serving a stint on the Advisory Board of the Mariano A. Elia Chair in Italian Canadian Studies during the same decade. Interestingly, the Chair is named after another Calabro-Canadian developer (from Aprigliano, Cosenza province) who provided the original endowment for the academic programme.

26 A major recruiter of contract labour from Calabria after the war was the Welch Construction Company based in Winnipeg and Port Arthur (now Thunder Bay) in northern Ontario. Originally founded at the turn of the century by two brothers, Vincenzo and Giovanni Veltri, from Grimaldi in Cosenza province, the firm quickly became a key contractor constructing new lines for Canada’s major railroads. After World War II, it was chosen by the Canadian government to help recruit track workers in Italy under one-year contracts. In this task the Veltri turned to their fellow Calabresi as their prime source of ready labour. See John Potestio, ed., The Memoir of Giovanni Veltri, (Toronto: Multicultural History Society of Ontario, 1987).

27 Other major San Giorgio clans, as illustrated by the colony in Guelph were the Valeriote, Carere, and Sciarroni. Brian R. Bradshaw, Patterns of Residence, Occupation and Preferred Work-Places Among Italians in Guelph, Ontario 1920–1960 (M.A. dissertation, University of Guelph, 1980), 22–27.

28 According to Giovinazzo the major colonia of San Giorgese in Europe is in the small region of Valle d’Aosta in northwestern Italy, which the author likens in importance to their presence in Ontario. Giovinazzo, San Giorgio Morgeto, 190–91.

29 The Monarch Hotel prior to World War II was known as the Venezia Hotel. It housed Italian sojourners and single men as well as being the headquarters of one of Toronto’s most influential padroni, who acted as labour agent, banker and steamship agent for his co-nationals. Significantly, it was located in the middle of the Calabrese colony. See Sturino, Forging the Chain, chapter 7.

30 The family of Johnny Lombardi, who after 1960 was considered the unofficial “mayor” of Toronto’s Italians due to his public exposure through his Italian-language radio station, started its success in business with their grocery store (now defunct) located at College and Grace Streets.

31 The Calabresi strictly adhered to naming children after grandparents as a sign of familial respect and continuity. The custom of first naming patrilineally and then matrilineally no doubt reflects the patriarchal traditions of Calabrese society.

32 Glen Long Avenue is located at Dufferin Street and Lawrence Avenue, in what in 1959 was
known as the Borough of North York, a designation indicative of its rural character at the
time. Through the 1960s this area was transformed into an Italian-Canadian suburb as it
attracted upwardly mobile immigrants from the city.

33 This is reminiscent of the practices of Canadian immigration recruiters who would routinely
ask aspiring emigrants to show them their hands in order to choose only hard-working
labourers. As one of the most prolific government officials wrote to his superiors in 1951
about his recruits, “all men were genuine Italian farmers from the southern regions of Italy.
I made sure of their qualifications by checking background and calluses on their hands.”
Sturino, “Post-World War Two Canadian Immigration Policy.” 70.

This checking of hands obviously made an impression on people, for it is often mentioned
by Italians when relating their migration stories.

34 In contrast to high return rates in the early twentieth century, the proportion returning to Italy
from Canada in the post-World War Two decades was only 10%. Indeed this was the lowest
rate of repatriation in the world compared to 15% for Australia, 20% for the United States and
rates of between one-quarter and one-half for South America.

35 For an informative analysis of the working life of Italians in postwar Toronto, especially in
the construction industry and involvement in the labour movement, see Franca Iacovetta,
Such Hardworking People: Italian Immigrants in Postwar Toronto (Montreal: McGill-Queen’s
University Press, 1992), chapters 3, 4 and 7.

36 Of over 49,000 male construction workers in Metropolitan Toronto in 1961, almost one-third
were Italian, though Italians made up only about 10% of the total population. See Ibid, Table
12.

37 The Korean War lasted from 1950–53. Canada participated both by sending troops to join
the massive American build-up there and by earmarking $5 billion for rearmament over three
years. Robert Bothwell, Ian Drummond, John English, Canada since 1945: Power, Politics,

38 American Standard, the multinational manufacturer of bathroom fixtures and plumbing
supplies, was located in a heavily industrial zone on the western border of the St. Clair Little
Italy that emerged after the war. Located around St. Clair Avenue and Dufferin Street this
Little Italy had over-taken the College Street colony as the city’s major concentration of
Italians by 1960, in part because of its proximity to the Junction industries. Franc Sturino,
“Contours of Postwar Italian Immigration to Toronto,” Polyphony 6 (Spring/Summer, 1985):
127–130.

39 While Italian immigrants were often stigmatized as having low levels of formal education,
many insisted that their schooling, even in the “backward” South, was superior to the
Canadian system in providing basic literacy and numeracy, not to mention building good
character. Rao’s statement here echoes the common conviction that a few years of elementary
education in Italy was equivalent to several more years’ in Canada.

40 English classes for “New Canadians” were offered by the Toronto Board of Education, and,
increasingly after 1960, by Italian immigrant aid agencies.

41 In 1961, Italians had the highest proportion, almost 50%, of any ethnic group in the most
productive age cohort (between 15 and 44 years) tabulated by the Census of Canada. Warren
E. Kalbach and Wayne W. McVey, The Demographic Bases of Canadian Society (Toronto:

42 This figure of $3000 is almost exactly the average annual income earned by Italian
immigrants in Toronto in 1960–61. It is almost half the income earned by the British in Toronto, and less than half the amount earned by Toronto’s Jews. Anthony H. Richmond, Immigrants and Ethnic Groups in Metropolitan Toronto (Toronto: York University, 1967), 22.

43 “DP” stood for “displaced person” and was a term of derision used by Canadians for both postwar refugees, to which the term properly referred, and regular immigrants like Italians. “Wop” was used specifically to refer to Italian immigrants. It had been common in the United States since the early twentieth century. Though its origin is unknown, one interpretation is that it was an acronym for “without papers,” referring to illegal immigration.

44 The theme of discrimination against Italian immigrants in Toronto is dealt with by Iacovetta, who sees it as a continuation of a broader, deep-rooted nativism that had been part of North America since the nineteenth century. Iacovetta, Such Hardworking People, chapter 5.

45 In 1961, Italian women formed over 58% of the female labour force in Toronto’s clothing and textile industries; hence women were a natural constituency for unions attempting to organize the sector. Italian men, at 22% of the male labour force in this sector, were also important targets. Ibid, Tables 12 and 14.

46 Some historians have presented the two strikes that occurred in Toronto’s residential construction industry during the summers of 1960 and 1961 as a turning point for Italian workers, since several thousand had been newly unionized and recruited for the struggles. However, while the strikes may have radicalized the construction workers, as indicated by Rao’s near silence on these events, their effect on the immigrant worker in general was negligible. An autobiography that presents the strikes front and centre as part of the immigrant experience is provided by Frank Colantonio, an organizer for the Carpenters’ Union: From the Ground Up: An Italian Immigrant Story (Toronto: Between the Lines, 1997).

47 For a profile of these two Toronto union organizers, see Kenneth Bagnell, Canadese: A Portrait of the Italian Canadians (Toronto: Macmillan, 1989), chapters 7 and 8.

48 The Unemployment Insurance Commission (UIC) and Canada Pension were under federal jurisdiction; Workers’ Compensation under the provincial government.

49 Canadian Auto Workers.

50 The official unemployment rate in the mid-nineties was around 9%.

51 An interesting comparison with the grievances reported here is provided by first-hand accounts of workers at various jobs in Walter Johnson, ed., Working in Canada (Montreal: Black Rose, 1983 [revised edition]).

52 Reference is made here to the Canadian Labour Congress, the Ontario Federation of Labour and the Toronto District Labour Council.

53 These acronyms stand for the Canadian Union of Public Employees and the Ontario Provincial Services Employees Union.

54 Toronto’s leading Italian-language newspaper established in 1954 by Dan Iannuzzi, also of Calabrese origin.

55 United Food Commercial Workers Union and Universal Workers Union, Local 183 (formerly Labourer’s International Union of North America).

56 The New Democratic Party (NDP) was established in 1961 on the social democratic foundations laid by the Co-operative Commonwealth Federation (CCF) which had been born thirty years earlier. In 1961, the labour support, which had been one of the pillars of
the CCF (along with agrarian reformers and socialists), was formalized by an allegiance between the new party and the Canadian Labour Congress and its affiliated unions, such as the Steelworkers. For a history of social democracy in Ontario, see Gerald L. Caplan, The Dilemma of Canadian Socialism: The CCF in Ontario (Toronto: McClelland and Stewart, 1973).

57 For a description of working conditions and union organization in Toronto’s garment industry, see Iacovetta, Such Hardworking People, 95–101.

58 T.C. Douglas, as head of the Saskatchewan CCF, catapulted the party to victory in the provincial election of 1944, forming Canada’s first social democratic government. He was thus the natural candidate to be chosen the first leader of the NDP in 1961.

59 Ward Three was one of a number of heavily Italian ridings in the western part of Toronto.

60 While The Toronto Telegram later went out of business, it re-surfaced, with its workers’ support, as today’s Toronto Sun.

61 Joseph Piccininni was the earliest and longest-standing Italian Canadian to win elective office in municipal politics. He paved the way for many others.


63 Columbus Centre is Toronto’s Italian-Canadian socio-cultural and recreational centre. It was completed in 1980, five years after the Italian community’s first major project, Villa Colombo, that consisted of a senior citizens’ residence. Both of these are overseen by the non-profit community-based Villa Charities organization (formerly, the Italian Canadian Benevolent Corporation). Located just a block from Rao’s home, at Dufferin Street and Lawrence Avenue, the Columbus Centre complex—consisting also of an adjacent church, schools and housing—emerged in the 1980s as the heart of community activities for Toronto’s Italians. See Nicholas DeMaria Harney, Eh, Paesan! Being Italian in Toronto (Toronto: University of Toronto Press, 1998), chapter 4.

64 The participation of Italians in politics, including the NDP in Ontario, is discussed in Franc Sturino, “Italian Canadians in Post-World War II Canadian Politics.” Italian Canadiana. 12 (1996):129–141.

65 Bill 40 was legislation introduced and passed by the NDP in 1993 to adjust Ontario’s Labour Relations Act. A number of changes made it easier to organize, created mechanisms for arbitration and prohibited the use of replacement workers, or “scabs.” It was one of the first pieces of legislation repealed by the right-wing Progressive Conservative Party when it assumed power in June 1995.

66 Channel 47 is CFMT television. Toronto’s multilingual station, with extensive Italian programming, was started in 1978 by Dan Iannuzzi, publisher of the Corriere Canadese. He no longer owns it.

67 Sofia Loren first visited Villa Colombo in 1979 during a promotional trip for her book. She has since revisited the Villa Charities compound twice in 2001 but in a more unofficial way, to meet with Italian seniors and attend a private party.

68 Rao is referring to the fact that the union confederations in Italy bargain on a national, industry-wide basis rather than having local unions deal with individual companies, as is the case in North America. Further, the Italian confederations also have their own press and extensive social service agencies, making them a visible force within Italian society.
During the interview process Rao wanted to make sure we understood, and that the future readers of the text were aware of the eligibility requirements to qualify for the Canada Pension Plan Disability Benefits. Rao therefore listed key points that were required:

“You must be between the age of eighteen and sixty-five. You must have enough Canada Pension Plan contributions at the time you become disabled. You must be disabled according to the Canada Pension Plan definitions. You must have become disabled before or within six months after your Canadian Pension Plan Retirement Pension starts if you are between sixty and sixty-five years of age and you must apply in writing.

According to the Canada Pension Plan legislation, a disability must be a physical or mental impairment that is both severe and prolonged. “Severe” means that you are unable to regularly carry out any gainful employment. “Prolonged” means that the disability is likely to be of indefinite duration or is likely to result in death. The “severe” and “prolonged” criteria must be met simultaneously at the time of application.”

Istituto Nazionale di Assistenza Sociale.

The Confederazione Italiana dei Sindicati Liberi (CISL) was dominated for many years by the Christian Democrats. ACLI stands for Associazioni Cristiano Lavoratori Italiani and was associated with Catholic workers and Christian Democrats.

Forze Nuove was the Italian language organ for social democracy published in Toronto between 1972 and 1979. The editors mentioned by Rao went on to successful careers: Odoardo di Santo was elected to the provincial legislature for the NDP and later was appointed head of the Workers’ Compensation Board; Elio Costa became an Associate Professor of Italian at York University.

The point being made here can be debated. In the 1960s, circulation of the Italian-language press across Canada reached 120,000 and rapid expansion in the number of different publications occurred in the 1970s. The major metropolitan papers of Toronto, Montreal and Vancouver, all founded in the mid-1950s, have survived into the present. Currently, the Corriere Canadese charges $199 for a yearly subscription and $119 for six months.

Rao is referring to Italian language classes rather than a school as such.

The Comunità San Giorgio Morgeto was one of the first paese-based societies to be formed by the Calabresi; with a following of about five hundred members, it was the largest of such clubs. By the mid-1980s, two dozen paese or regional clubs had been formed by Toronto’s Calabresi. Franc Sturino, “From Calabria to Canada,” 23–24.

Marylake is located a short drive north of Toronto, on grounds held by an Augustinian monastery whose monks supervise the various saints’ day feasts held practically every weekend through the summer months. In the 1980s, the Archdiocese of Toronto was receiving sixty requests annually from paese and other clubs to mount feste in honour of their local patron saint. For an up-to-date account of hometown clubs and their religious feste, consult Harney, Eh, Paesan!, chapters 7 and 8.

According to the Greek classics, an ancient king named Italus gave his name to the southern extremity of the peninsula that came to be known as Italy. A son of Italus named Morgete was supposed to have founded the present town over 2000 years before Christ. The name Calabria extends back to Roman usage after the conquest of the southern extremity. Gertrude Slaughter, Calabria: The First Italy (Madison, Wisconsin: University of Wisconsin Press, 1939), 5–6; Giovinazzo, San Giorgio Morgeto, 25–28.

Eusebius was born at Cassano in northern Calabria and was Pope for only a few months in
309 when he died a martyr in Sicily. Giovinazzo, San Giorgio Morgeto, 38–49.

79 Villa Colombo is the home for the aged that is part of the Villa Charities complex in the northwest of the city that includes Columbus Centre. The Caritas drug rehabilitation project is a Catholic charity aimed at Italian Canadian youth under the leadership of Father Gianni Carparelli.

80 The monument to Italian immigrants consisted of a bronze statue depicting an immigrating family. It was unveiled in June 1998 outside the Joseph J. Piccinnini Community Centre in the St. Clair Little Italy. The monument was sponsored by the Italian-Canadian Immigrant Commemorative Association, which also collaborated with the Department of Italian Studies at the University of Toronto to produce a publication devoted to the various regional communities, A Monument for Italian-Canadian Immigrants, cited earlier.

81 One of Toronto’s many banquet halls used by Toronto’s Italian community for weddings, first communion parties, and special events. Increasingly the halls within the city have been displaced by newer, more spacious and elaborate facilities in the suburban fringe around Toronto.

82 The Calabresi are indeed the largest Italian regional community in Toronto, but their number is lower than the guess made here. In 1991 out of 387,400 single-origin Italians in metropolitan Toronto, approximately 70,000 were Calabrese.

83 On the rise of Italian regionalism in Toronto and the recent construction of regional community centres, see Harney, Eh, Paesan!, chapter 5.

84 In 1983, the establishment of the Calabro-Canadian Confederation brought some semblance of unity to the Calabresi of Toronto. This was shattered, however, with the rise of the rival Alleanza dei Calabro-Canadesi some years later. In 1991, the provincial rivalry that was partly behind the dissension, came to the fore with the establishment of two new federations representing the provinces of Cosenza and Catanzaro. Interestingly, the attempt at building bridges has come mainly from the smallest of the three provincial groups: that of Reggio Calabria, of which the San Giorgesi are a part.

85 In 1970, the Italian government began to devolve some limited power to the regions. This had been called for by the republican constitution but postponed because of cold war exigencies. Devolution laid the foundation for regions to become much more involved with their people overseas, both culturally and economically. One concrete step taken by some regions was to appoint a representative, or consultore, in major settlements, to link immigrants with their home regions. This development is explained in Harney, Eh, Paesan!, 83–87.

86 Tony Silipo emigrated from the province of Catanzaro, first to Australia and then Canada. He was one of five Italian-Canadian candidates elected to the provincial legislature with the New Democratic Party in the heavily Italian west end of Toronto in 1991. Premier Bob Rae’s riding, also located in the west end, had considerable Italian immigrant presence too. Benito Bellantone is originally from the province of Reggio Calabria.

87 Montalto Uffugo is in the province of Cosenza. Emilio Bisciglia, a young lawyer, became president of the Toronto district of the National Congress of Italian Canadians between 1994 and 1999. The National Congress of Italian Canadians was founded in 1974 to coordinate common interests and projects across Canada.

88 Gregory Grande was a president of the Toronto section of the National Congress of Italian Canadians in the 1980s. A Board of Education social worker by profession, Dr. Grande was active in numerous initiatives ranging from research to theatre in the local Italian community.
His brother, Tony Grande, was a member of the provincial legislature in the 1970s.

North York formed part of Metropolitan Toronto. Vaughan is a suburban city to the immediate northwest that contains the largely Italian-Canadian community of Woodbridge.

The Progressive Conservative Party (PC) under Mike Harris defeated the NDP in the 1995 provincial election. They were re-elected in June 1999 and are still in power.

Litigation between members of the various Calabrese factions is not uncommon and seems to be considered simply part of the “cost” of being involved in community affairs.

The successful Abruzzese effort at organizing the regional community and fundraising resulted in the construction of a senior citizens’ residence and the near completion of a community center (Casa Abruzzo) in the northwestern Downsview area of Toronto. It should be noted that the Abruzzese community group, known as the Casa Abruzzo Benevolent Corporation, organizing the fundraising for Casa Abruzzo has had some difficulty as well in raising enough money from the community to complete the kitchen for the centre’s banquet hall. Although this may seem minor on the surface, in fact, the banquet hall portion is needed to generate income for the non-profit Casa.

Endless debate has transpired in the Italian-Canadian community about the inability of the Calabresi to come together as a regional group for common ends as other regional groups (for example, the Friulani, Veneti, and Abruzzesi) have done. Their “failure” in this regard has been attributed to jealousies and clashes (such as Rao reveals here), to excessive paese- or provincial loyalty, and to an “arcaic” type of individualism, among other explanations. It may be, however, that the explanation is much more prosaic. With a 1991 population of 70,000, making the Calabrese the largest regional group in Toronto, it may be that it was simply too large and unwieldy to organize as effectively as others. The next largest regional group, the Abruzzese, numbered only 42,600 and the Friulani and Veneti about 27,000 each.

The date of this event was June 14, 1974.

The Villa Colombo Home for the Aged was completed near the end of 1975. In April 1976, Progressive Conservative Premier William Davis—representing the province, which had subsidized the project—presided at its official opening. Harney, Eh, Paesan!, 59.

The Villa Colombo (which cost about $4.5 million dollars) like other similar building projects was funded by a combination of community fundraising and public subsidies from government. The Italian-Canadian fundraisers found the telethon, which for the Villa was held on Mother’s Day, an effective means to solicit donations for various charitable causes. For a history of the Italian Canadian Benevolent Corporation (reorganized as the Villa Charities in 1995), the fundraising and decision-making body behind Villa Colombo and subsequent projects, see Virginia Williams Ariemma, The Story of Villa Charities, 1971–1996 (Toronto: Villa Charities, 1997).

Anthony Fusco, a successful businessman in transportation, was president of the Italian Canadian Benevolent Corporation from 1974 to 1980 and the driving force behind the construction of Villa Colombo and Columbus Centre. Consiglio DiNino, founder of the Cabot Trust Company, also closely involved with these ventures, was appointed to the Canadian Senate by Progressive Conservative Prime Minister Brian Mulroney in the early 1990s.

Father Malorzo was also on the Board of Directors of Villa Charities.

Substantial sums were collected for the victims of earthquakes, which devastated Friuli in 1976 and Campania and Basilicata in 1980.
100 It is interesting to compare Rao’s praise for the community and the successful pan-Italian building projects with his earlier criticism of the Calabrese regional group and its failure at realizing a centre. Certainly the former was much better organized and more effectively explained to Italian Canadians than the failed, hasty campaign of the regional group.  

101 According to the Canadian census, while in 1971 Italian-origin youth between the ages of 15 and 24 were considerably below the general Canadian proportion in school attendance (46% versus 51%), in 1981 the Italian-origin proportion had risen to 55% and surpassed the overall Canadian rate. Moreover, in 1986 a higher percentage of Italian Canadians had a university or college education than Canadians overall (11% and 27% of Italian-Canadians compared to 10% and 24% of Canadians, respectively).  

102 Rao’s focus on Villa Colombo Home for the Aged and his musings on youth in this last section perhaps reflect the phase in life he finds himself in—now retired, though still quite active. Both the plight of the aged and the apparent shortcomings of youth are natural concerns to dwell upon for an immigrant who has surmounted many harsh challenges.  

103 This autobiographical sketch was produced by Rao. He has used it to introduce himself to others interested in his work.
Selected Bibliography

Bagnell, Kenneth

Breton, Raymond, Wsevolod W. Isajiw, Warren E. Kalbach and Jeffrey Reitz

Colantonio, Frank
1997 From the Ground Up: An Italian Immigrant Story. Toronto: Between the Lines.

Harney, Nicholas DeMaria

Harney, Robert F.

Hawkins, Freda

Iacovetta, Franca

Jansen, Clifford
Magocsi, Paul Robert, ed.

Niccoli, Gabriele, ed.
2000 Ricordi: Racconti di vite olteoceano. Welland, ON: Soleil

Perin, Roberto and Franc Sturino

Potestio, John

Ramirez, Bruno and Pierre Anctil
1991 If One Were to Write a History: Selected Writings of Robert F. Harney. Toronto: MHSO

Sturino, Franc
1990 Forging the Chain: Italian Migration to North America, 1880–1930. Toronto: MHSO.

Zucchi, John E.
Photo Gallery

**Life in Italy**
The Rao family, A trip to Cittannova

**Emigrating to Canada and Early Years**
Group picture, Fortunato and his cousin, A Toronto Social Event - 1950

**Working Life**
Retirement festivities, Municipal Election 1969
Tenth anniversary of “Labour News”, The “Labour News” show

**Union Work**
Organizing a boycott, Picket line 1970, Steelworker’s Christmas Party, Labour Day Parade 2000, Italian Workers at Local 183 hall

**Politics, Canadian Citizenship and Labour Activism**
Fortunato at Queen’s Park, Striking Workers 1970’s, Bob Rae & Fortunato Rao, Ontario NDP’s Italian Advisory Committee, Bob Rae accepts membership cards

**Italian Community Involvement**
Executive Committee - 1964, Fortunato and Sophia Loren, Circolo Morgezio Social Club, Good Friday Procession, 25th Anniversary of Circolo Morgezio, Honouring Mrs. Rachela Fazari, Executive of Circolo Morgezio

**Family Life**
Fortunato's 70th Birthday party, Fortunato in his garden

This was a trip with the Reverend Cononco Congemi to Cittannova. Fortunato, first row, far left.
Emigrating to Canada

il Forestale, located third row centre (third person straight back from the man in front with the watch). Head Builder, Ferdinando Di Maria, first row, far right.

Fortunato with his cousin Luigi Rao and Luigi’s daughter Pasqualina. Toronto, March 1955.
Toronto social event in the 1950s. From left: Guido Mammoliti, Giovanni Varone, Fortunato Rao, Connie Rao, Michele Mammoliti.

Fortunato Rao during the Municipal Election, Toronto, 1969.

A “Labour News” show on Keeble and York Cable. The topic: the boycott of grapes and lettuce. From left: Nicolo Fortunato, Director of Studio; Fortunato Rao, host of program; Jessica Govea, representing the United Farm Workers of America.
Organizing the grape and lettuce boycott. Cesar Chavez, president of the United Farm Workers of America, with Fortunato Rao, staff representative of the United Steelworkers. London, Ontario, June 7, 1975.

Picket line for a strike at Indalex. Toronto, 1970s.
United Steelworkers’ annual Christmas party for workers’ children. Giuseppe Serpe as the Italian-speaking Santa Claus.

Italian immigrant workers, at the Local 183 Hall, questioning the Italian Advisory Committee of the Ontario NDP about their Italian pension rights and Workers’ Compensation benefits.
Fortunato Rao at Queen’s Park speaking to Premier William Davis about the plight of injured workers and changes at the Workers’ Compensation Board (WCB). To the left of Rao in photographer, seated, Odoardo DiSanto, later NDP member of the Ontario provincial legislature and head of the WCB. In back (with pen), Sergio Tagliavini, journalist and publisher. Toronto, 1974.

Listening to striking workers:. Donald McDonald, NDP Member of the Ontario Legislature, and Fortunato Rao, Staff Representative of the United Steelworkers of America. Toronto, 1970s.
Ontario NDP leader Bob Rae and Fortunato Rao with strikers from United Steelworkers Local 7291. Toronto, June 17, 1982.

Bob Rae, then leader of the provincial New Democratic Party, accepting two handfuls of party membership cards from Fortunato Rao at a Circolo Morgezio social club dinner/dance. Toronto, April 11, 1987.
Executive committee for the feast of San Giorgio the Martyr and San Giacomo the Apostle. From left: Fortunato Rao, Aurelio Giovinazzo, Pasquale Fazari, Michele Fazari, Domenico Sorbara, Pasquale Raso, Francesco Consiglio, Silvio Tedesco, Giorgio Marchesano, Matteo Rao Annunziato Rao, Salvatore Addario, Emilio Fazari, Marylake Monastery, King City, Ontario

Fortunato Rao and Sophia Loren at Villa Columbo, 1979

Good Friday Procession, Grace Street, Toronto, 1997.

Honouring Mrs. Rachela Fazari for her life experience. From left: Fortunato Rao; Giacomo, Rachela, Pasquale and Giuseppe (with glasses) Fazari. Toronto, n.d.
Newspaper Clippings

He worked a 50-hour week for $17
By Harry Boyle, Sunday Star, 18 December 1977, D4.

Immigrant union members keen on labor education
Steel Labour, September 1970, 7.

Compensation won for Bayani Sunga
Steel Labour, 12.

Protesta a St. Clair contro l’uva trattata chimicamente negli USA
Corriere Canadese, Marzo 1987, 6.

Your NDP Candidates in Ward 3: Fortunato (Lucky) Rao

Lavoratori: nuovi cittadini
La Voce, 12 Octobre 1974, 6.

Un assegno Steelworkers Union e’stato consegnato all’INAS di Toronto

Earthquake Relief Fund
The Steelworker, 1976, 3.
He worked 50-hour week for $17

When Fortunato (Lucky) Rao came to Canada 25 years ago he was, in his words, “blind and deaf with the English.” But he soon came to understand the meaning of exploitation.

He worked 50 hours a week for $17 in a factory in hard-wood doors. The job lasted two weeks.

“I was very angry,” Rao recalls. “I said, ‘In no way will I work for this kind of money.’ I had a mother, a brother and a sister I had to support in Italy.”

It was perhaps that spark of outrage that led lucky Rao into the trade union movement. Now he is one of the most successful union organizers in Canada for the United Steelworkers of America.

During those early years in Canada, Lucky (so called because his first name is Fortunato) Rao worked in construction like many other Italians who came to Metro. He was paid $1 an hour, no overtime, even on Saturdays and Sundays. There were no benefits.

“I did all the heavy and dirty work you could name, and I was proud to do my job,” he says. He had moved enough by 1962 to bring his family to Canada from their home in San Giorgio Mergo in Calabria.

Before he joined the Steelworkers staff in the early 1960s, Rao worked in a factory that made steel sinks. “I worked 40 hours a week in the factory, but I never took it for granted that my work ended with my shift.”

Steelworkers Fortunato Rao: “I couldn’t stand to see people exploited”

Worked nights

He worked nights as a part-time organizer, translator and Italian community worker. He organized a picnic for people from his home town in Italy, and it was a good job. I still feel that way with the bottom of my heart.”

“Since I couldn’t stand to see people exploited, to see them earning low money, no benefits, when they were doing a good job, I still feel that way with the bottom of my heart.”

The workers in one plant, he organized had no indoor toilet. “It wasn’t so bad in the summer, but in the winter they froze.”

He once persuaded a group of workers in a plant to join the union, not knowing that the union’s chief organizer had been trying for weeks to get the workers to sign the union cards.

“I perhaps had the right approach,” Rao says. “It’s my nature to smile. Even if I go to a funeral I smile all the time.”

He took the cards back to the union hall. “Those finks signed,” the chief organizer yelled.

In organizing, Rao says, you answer the workers’ questions “with no bull . . . to the best of your ability. You make no promises, except to tell them that they can’t do any worse together than alone.”

Strictly confidential

“You tell them the cards they sign are strictly confidential, that the boss won’t find out. And you must know something about the plant they work in, what their working conditions are, and what improvements they deserve.

“And even so,” Rao says, “I won’t sign even if God from heaven tells me to.”

The most difficult workers to organize, according to Rao, are those from southern Italy, Spain, the West Indies and Latin America. They have had little contact with the trade union movement. As a result, they have more fears about joining a union.

“Many employers tell their workers ‘that either you stick with us, stay clear of the union, or we’ll send you back home.’ . . . Only a few fight back.”

He recalls that when the owners of one plant found out that the union was trying to organize the 100 workers, they called meetings, separating the workers by nationality.

“One day it would be the Greeks, then the Portuguese, the Italians, the blacks on another day. They would tell them that if they joined the union they would be on strike, that the company would shut down,

that they would have to pay exorbitant dues.”

The plant was organized. “But I don’t want to tell you its name. We have good relations with the management now. Why pour gasoline on the fire?”

New problems in organizing come with what Lucky Rao describes as Third World people. “They come here from the poor countries and if they have to work 54 hours a day they will do it. They have no leaders.”

They made new Canadians into Canadian people. Since 1970, through the Steelworkers, Rao estimates that he has been responsible for 3,600 new Canadians becoming citizens.

He became involved after the 1960 municipal election when he was defeated in his bid for alderman in Ward 3 by Joe Piccinni.

“Everybody I talked to said I’m for you, Lucky,” and I believed them. The only thing wrong was the race of some of them could vote because new sheet for new Canadians to them with a test on Canada must pass before they can be citizens.

The new citizenship procedure involves three steps: The application hearing and court ceremony problem, Rao says, is that the average applicant $100 in missed work. Now he’s trying to organize the companies int
A group of recently immigrated workers from Italy learn the techniques of good stewardship from Steelworker Staffman, Fortunato Rao at a special school in Toronto. The course, an integral part of union activity in the area, is designed to acquaint immigrants with local union administration, collective agreements and the structure of the Canadian labor movement.

Immigrant union members keen on labor education

A large percentage of Steelworker members who participate in union-sponsored schools in the Toronto area are immigrant workers. Estimates run as high as 50 per cent in some cases.

Although many nationalities are represented, Italians make up the largest contingent. Fortunato Rao, a Steelworker staff representative estimates that since the Second World War, over 300,000 Italian immigrants have settled around Toronto. Many of them are Steelworker members working in the more than 160 plants in Metro Toronto where the union has contracts.

Over the course of a year, union-sponsored education programs attract hundreds of workers from the ethnic population. They participate in a variety of summer and winter seminars sponsored by the Steelworkers, the Ontario Federation of Labour and the Canadian Labour Congress.

Where there is a language barrier, the Ethnic Labour Committee, a group within the Toronto and District Labour Council, sets up special courses and provides instructors. Louis Lenkinski, Labour Council secretary, notes that this has only been necessary on two occasions in general weekend institutes. For the most part, immigrants are able to cope with the subject presented.

There are no restrictions on courses offered. Organizers report that immigrant workers have familiarized themselves with everything from local union administration and the grievance administration and the grievance procedure to economics and collective bargaining.

The courses give immigrants an opportunity to compare the Canadian labor movement with that of European countries. Fortunato Rao reports that this is a favorite topic with the immigrant union member.
Compensation won for Bayani Sunga

From left: Fortunato Rao, staff rep; Frank Plorio, vice pres. LU 7574; Mary Shane, staff organizer; Eugenio Conforti, pres. LU 7574; Bayani Sunga and Mrs. Sunga; Carmine Perri of the Local Union Safety Committee.

Mississauga, Ontario — Local 7574 member Bayani Sunga has won $3,090 in back claims from the Ontario Workmen’s Compensation Board in spite of the strong opposition of his employer, ITT Aimco.

Sunga injured his back last year while pushing a heavy box of brake shoes to his workplace. As a result of the injury he had to stop work and undergo surgery, but the company insisted that Sunga was not injured on the job. The WCB rejected his claim for compensation.

The Steelworkers appealed to the WCB on Sunga’s behalf and won him compensation after a full hearing.

Toronto area Staff Representative Fortunato Rao, confirmed that Sunga, a recent immigrant from the Philippines, will be authorized for a permanent pension from the WCB next month. “There’s no question about it,” said Rao, “he’s entitled to it and he will have it.”
Protesta a St. Clair contro l’uva trattata chimicamente negli USA

Alla manifestazione hanno aderito politici e sindacalisti italiani

Nostro servizio

TORONTO - Politici e sindacalisti, alcuni dei quali italo-canadesi, si sono uniti ai rappresentanti dei lavoratori, associati al sindacato della 'United Farm Workers of America', per protestare contro l’uso di prodotti chimici, come fertilizzanti, per la coltura delle vigne in California.

La protesta è avvenuta sabato scorso, nel centro della comunità italiana, nella zona compresa tra St. Clair ed Oakwood, in vicinanza di due supermercati, meta degli acquisti da parte di molti italiani di Toronto.

Un folto gruppo di dimostranti, inalberando cartelli e stendardi, ha cercato di invitare coloro che si recavano nei supermercati, a non comperare uva proveniente dalla California, perché trattata con prodotti chimici, in gran parte oleosi, che si crede possano generare il cancro. Alla dimostrazione si sono uniti il deputato federale del partito liberale On. Carletto Caccia, il deputato provinciale dell’NDP, Ross Mc Lellan, e Fortunato Rao dell’United Steel Workers Association.

Dopo una breve introduzione da parte di David Martinez, direttore dell’ufficio canadese per il boicottaggio dell’uva californiana, hanno parlato i tre rappresentanti politici e sindacali presenti, che hanno messo in risalto il pericolo che deriva dall’usare uva di provenienza californiana, sia per uso domestico, che per uso vinicolo. In particolare si è posto l’accento sul fatto che la Federal del sindacato degli Steelworkers, David Martinez direttore del gruppo di boicottaggio, ed il nostro inviato.

Drug Administration americana non fa praticamente controlli sui prodotti ortofrutticoli e che, mediamente, i prodotti chimici tossici vengono usati con percentuali fino a 50 volte superiori al massimo consentito dalle leggi canadesi.
YOUR NDP CANDIDATES IN WARD 3

Fortunato (Lucky) Rao

was born in Italy 38 years ago and came to Canada 20 years ago. He first worked as a construction worker and started his union activities at the Local Union level. In 1966 he was appointed as a staff organizer with the United Steelworkers of America. In 1968 he was appointed Staff Representative with the Steelworkers and became a member of the Ethnic Labour Committee. He is an officer in the Steelworkers’ Credit Union and is interested in the problems of integration of the immigrants. At present he is President of the San Giorgio Morgeto Community. Lucky is a family man. He and his wife Tina have two children. His hobby is to devote himself to the welfare and improvement of conditions of his fellow men.
Altri immigrati italiani sono divenuti cittadini canadesi, grazie all’opera instancabile del sindacalista Fortunato Rao. La sera del 2 Ottobre presso la sede della United Steelworkers of America, al numero 25 di Cecil Street, in Toronto un numeroso gruppo di lavoratori hanno giurato con la Bibbia fra le mani fedeltà alle leggi del Canada. Sempre suggestiva e commovente anche se semplice e severa la cerimonia che dona ai nostri immigrati una nuova patria anche ufficialmente attraverso i documenti personali.
Un assegno della Steelworkers Union e’ stato consegnato all’INAS di Toronto

Toronto- aprile 88: Quale responsabilita’ ha il Governo canadese verso gli anziani della nostra comunità italiana? Verso coloro che hanno dato grande contributo per il benessere di questo paese? Poca e niente. Nel corso degli ultimi 12 mesi ho constato di persona come vengono trattati gli anziani costretti a lunghe e interminabili file all’ingresso dell’INAS Istituto Nazionale di Assistenza sociale, sito al 1921 Eglinton Ave West in Toronto. Persone anziane, uomini, donne operai ed operaie sono costrette ad attendere sotto la pioggia, la neve e le intemperie del tempo, per accaparrarsi il numero ed essere quindi pronti a ricevere il loro fabbisogno. Non bisogna (continua a pagina 3)

Da sinistra: Fortunato Rao ex sindacalista della Steelworkers e socio dell’Esecutivo dell’INAS Canada, Ken Signoretti sindacalista e vice presidente dell’INAS, consegna l’assegno a nome della Steelworkers Union al signor Giuseppe Carraro, coordinatore Naz.INAS.
Earthquake relief fund

The United Steelworkers of America in Toronto have formed a committee to help the earthquake victims of northeastern Italy. An appeal was sent from coast to coast to 853 Steelworker Local Unions for donations.

On our weekly cable television program "Labour News" we have documented the story of the earthquake on May 6th, 1976, many times and shown how our brothers have lost their homes, jobs and in some cases friends and family.

In the photograph taken on Labour News program are the following people for right to left — Jake Isbister, recording secretary of Local 1005, Hamilton ($1000 donation); financial secretary Joe Esposito and president Guido Farace of Local 14831 ($500 donation and plant collection of $325.00); George Getzler, Personnel Manager of Royal Industries ($1000 donation) and Fortunato Rao, host of the program and chairman of the Earthquake Fund.

At the present time donations from local unions total $5,630.00. We are hoping that those who have not yet donated will do so following their next membership meeting. Any donation is better than none.

Please send donations to:
"United Steelworkers' Toronto Committee for Earthquake VICTIMS OF Northeastern Italy"
25 Cecil St.,
Toronto, Ontario. M5T 1N1
Using Help

Using online Help
The Adobe Acrobat Reader application includes complete documentation in an accessible PDF-based help system. The help system includes information on all the Acrobat Reader tools, commands, and features for both Windows and Mac OS systems. The accessible PDF format is designed to provide easy navigation online, as well as easy reading using third-party screen readers compatible with Windows. The file can also be printed out to provide a handy desktop reference.

To start online Help:
Do one of the following:
- Choose Help > Reader Help.
- Press F1.
Reader Help will open in a new document window with the bookmark pane open. If the bookmark pane is not open, choose Window > Bookmarks, or type F5. You can navigate the Help document using bookmarks, by using the Contents and Index navigation links, or by searching the document for the term you are looking for.

Using Bookmarks
The contents of Reader Help are shown as bookmarks in the Bookmark pane. To view subtopics, click the plus sign or arrow (Mac OS) next to a topic. The topic will be expanded to show the subtopics it contains.

Each bookmark is a hyperlink to the associated section of the Help document. To view the contents, click the bookmark. As you view the contents in the document pane, the bookmark associated with that content will be highlighted in the bookmark pane to help you easily identify where you are in the document.

You can turn highlighting on or off by selecting Highlight Current Bookmark in the Bookmark pane menu (Windows).

Using the navigation bar
A navigation bar is provided at both the top and bottom of each page of the Reader Help document. Click Using Help at any time to return to this guide to using help. Click Contents to view the table of Contents, or Index to see a complete index of Reader Help.

The navigation bar also provides the Next Page and the Previous Page navigation arrows before and after the page number to allow you to navigate through the pages one at a time. Clicking Back will take you to last page you viewed. You can also page through the document using the First Page, Previous Page, Next Page, and Last Page navigation arrows in the Reader toolbar.

To find a topic using Contents:
1. Click on Contents in the navigation bar at the top or bottom of any page.
2 Click on a topic in the list that appears on the Contents page to view the first page of that topic.

3 To see a list of the subtopics, click the plus sign next to the topic name in the bookmark pane.

**To find a topic using the index**

1 Click on Index in the navigation bar at the top or bottom of any page.

2 Click on the appropriate letter of the alphabet displayed at the top of the index page. You can also click a letter bookmark listed under Index in the bookmark pane.

3 When you have located the topic you want, click the page number to the right of the topic to display the associated subject matter.

4 To view multiple entries, click Back to return to the same place in the index.

**To find a topic using the find command:**

1 Choose Edit > Find.

2 Enter a word or a phrase in the text box, and click OK.

3 Reader will search the document, starting from the current page, and display the first occurrence of the word or phrase you are searching for.

4 To find the next occurrence, choose Edit > Find Again.

**Printing the Help file**

Although Reader Help has been optimized for on-screen viewing, you can print out file or portions of the file. To print, choose Print from the File menu, or click the printer icon in the Reader toolbar.

**Other help resources**

In addition to Reader Help, the Help menu provides you with other help resources, such as information about your version of Reader and information about plug-ins. See the Help menu for more information.
Contents

Using Help 1
Windows Shortcuts 36
Mac OS Shortcuts 41
Index 46
Legal Notices 50
About Adobe Acrobat Reader

Acrobat Reader allows anyone to view, navigate, and print documents in the Adobe Portable Document Format (PDF). You can also use Reader to fill out forms, play movies, and search PDF files.

Adobe Acrobat Reader can be downloaded free of charge from the Adobe Web site at http://www.adobe.com. On the Adobe Web site home page, you can click a country name in the Adobe Sites pop-up menu to choose a language for viewing the site. The exact information in the site may vary from one language version to another. Each copy you make and distribute must include all of the following:

- The Acrobat Reader installer, exactly as provided by Adobe
- The Acrobat Reader Electronic End User License Agreement
- Copyright and other proprietary notices included in Acrobat Reader
- The following attribution statement on any media and packaging that includes Reader:

  “Acrobat Reader Copyright © 1987-1999 Adobe Systems Incorporated. All rights reserved. Adobe, the Adobe logo, Acrobat, and the Acrobat logo are trademarks of Adobe Systems Incorporated.”

The Acrobat Reader Electronic End User License Agreement and proprietary notices are contained in the Reader or Reader installer program. You are expressly prohibited from modifying or creating your own installer for the Acrobat Reader software. Details on the terms of use for the Acrobat Reader products are found in the Acrobat Reader Electronic End User License Agreement presented during installation of each product.

A special “Includes Adobe Acrobat” logo is available from Adobe for use when distributing Acrobat Reader. See the Adobe Web site (www.adobe.com) for details.

Accessibility

Adobe Systems is committed to developing and providing the vision and motion challenged community with the tools and resources to make digital information more accessible.

Using accessibility features in Acrobat Reader 5.0

Accessibility features are only available if you downloaded the Adobe Acrobat Reader with Search and Accessibility option.

At present, accessibility features are more robust on the Windows platform. This chapter covers using the accessibility features of Acrobat Reader 5.0.

For a PDF file to be accessible, it must have been created with accessibility in mind. For example, the PDF file must have structure. Screen readers will have trouble presenting the document if the structure tree is incomplete.

Important: If you have a PDF file which cannot be read by assistive technologies, contact the author of the document, and request that it be made accessible using Adobe Acrobat 5.0.
Using a screen reader with Acrobat Reader 5.0
Mac OS does not offer a general accessibility interface for screen readers. Acrobat Reader 5.0 does not support screen readers on the Mac OS. On the Windows platform Adobe Acrobat Reader 5.0 supports the use of several screen reader applications. Please refer to your screen reader documentation for information on installation and use with Adobe Acrobat Reader 5.0. The screen reader will follow the logical structure of the document. You can control whether the content is delivered to the screen reader in single pages, or the entire document at once. For more information on accessibility preferences, see “Setting Accessibility preferences” on page 7.

Using Acrobat Reader 5.0 and Microsoft Internet Explorer (Windows only)
You can use the keyboard to control Adobe Acrobat Reader 5.0 within Microsoft Internet Explorer. If you open an Adobe PDF document from within Internet Explorer, the navigation and command keystrokes will function normally. The Tab key moves the focus from the browser to the Acrobat Reader document pane. Pressing Tab again will select the items in the document. Press Shift + Tab to move in reverse. To return the focus to the browser, press Ctrl + Tab. When in the browser, use the Internet Explorer keystrokes for navigation and selection.

Using keyboard shortcuts for menu commands and navigation
Navigation functions can be controlled through the keyboard as well as the mouse. You can change focus areas, and manipulate menus and dialog boxes. Focus areas are large sections of the interface that are treated as logical entities. Within these you may have more detailed navigation. Focus areas have an outline around them.

Some of the gestures used to navigate may differ from those used in other Windows applications. This is due to both the different types of elements that are available in Adobe Acrobat Reader, and also to ensure compatibility with earlier versions.

To toggle the focus area between the document and navigation panes:
Press F6 to toggle the focus between the document and navigation panes.

Menu bar keystrokes
Press Alt or F10 to access the Menu bar. Then use the arrow keys and Enter to select from the menus.

Document pane keystrokes
When the focus rests on the document pane, pressing the following keys will help you navigate and invoke commands:

**Tab**  Moves the cursor from one item to the next.

**Shift-Tab**  Returns to the previous selection.

**Spacebar**  Invokes an action. For example, if the focus is on a hyperlink, pressing the Spacebar will open that link.

**Shift + F10**  Opens a contextual menu related to the selected item.

**Application**  (Windows only) also opens the contextual menu.
Alt then Ctrl + Tab (Windows only) will access the toolbar.

**Toolbar keystrokes (Windows only)**

Press Alt then Ctrl + Tab to move to the toolbar. Within the toolbar the following keystrokes will cycle through the tools, commands, and menus:

- **Ctrl + Tab** Moves from one section of the toolbar to the next. For example, this will cycle from the File toolbar to the Navigation toolbar, then to the View History toolbar, and so on.
- **Tab** Moves from one toolbar item to the next. If the File toolbar is active, Tab will cycle through Open, Open Web Page, Save, Print, and E-mail.
- **Arrow keys** Once a toolbar item is selected, you can also press the arrow keys to move between items. The down arrow key will open hidden menu items.
- **Enter** Selects the tool or command.
- **Esc (Escape)** Exits the menu.

**Navigation pane keystrokes**

Press F6 to focus on the navigation pane. Within each of the tabbed palettes, lists of objects are organized into a tree structure. Adobe Acrobat Reader 5.0 follows the standard Windows keyboard behaviors for tree views. When the focus is on the navigation pane, the following keystrokes will help you move around:

- **Ctrl + Tab** Moves between the palette tabs. Cycles through the Bookmarks, Thumbnails, Comments, and Signature palettes.
- **Tab** Moves between items within the palette. Pressing Tab will move down the list of bookmarks, comments, and so on.
- **Shift + Tab** Moves back to the previous item in the palette.
- **Arrow keys** Move the selection forward and backward within the palette.
- **Enter** Opens the selected palette item.
- **Spacebar** Opens the selected item.

**Floating palette access (Windows only)**

Alt + F6 and Ctrl + F6 will move the focus to floating palettes. If you have detached palettes, or created custom palette groups you can move the focus to them. Within the palettes the Tab and arrow and Enter keys will let you select and invoke actions.

**Dialog box keystrokes**

When the focus is inside of a dialog box, use the Tab, arrow, and Enter keys to select and invoke actions. Dialog-specific controls are shown in the keystroke shortcut table. After tabbing through all the items in a dialog box, the focus wraps back to the default selection. Navigation will occur top down, left to right, first by group box location.

For a complete list of shortcuts, see “Windows Shortcuts” on page 36 and “Mac OS Shortcuts” on page 41.
Setting Accessibility preferences

The accessibility preferences are designed to aid vision and motion challenged users. You can set high contrast color schemes, custom text and background colors, and screen reader options. In general Adobe recommends that you use the system color schemes available through your operating system.

To set Accessibility preferences:

1. Choose Edit > Preferences > Accessibility.

2. In the Alternate Document Colors section, select from the Adjust Display of Colors options:
   - **When document doesn’t specify colors** is the default. Acrobat Reader will adjust colors to your custom scheme when the document does not specify any.
   - **Always, overriding document colors** will always change the colors of the document to your custom scheme.

3. Select from the Color Scheme options:
   - **Use colors specified in document** will display the document as presented by the author.
   - **Use custom color scheme** will present the document with your selections.
   - **Use Windows colors** will present the document using your system colors.

4. In the Custom Scheme section, specify a Custom Scheme (available only if Use custom scheme is selected):
   - Click the Text Color button to open the color swatch and choose a color.
   - Click the Page Background Color button to open the color swatch and choose a color.

Once you have created a custom color scheme, you can choose Custom Colors from the Color Scheme pop-up menu to use your scheme when displaying a document. Some on-screen items won’t be affected by a custom color scheme. For example, the color of lines and images won’t change.

5. Choose a Content Delivery option (Windows only):
   - Select Deliver data in pages when document exceeds and enter a value.

Acrobat Reader can deliver a PDF document one-page-at-a-time to a screen reader if it exceeds the number of pages you specify. If you check this option and set this number to 0, then Acrobat Reader will deliver every PDF document one-page-at-a-time.

Click OK.

Opening PDF documents

The creator of a PDF document can set the document to open in a variety of ways. For example, a document might open to a particular page number, at a particular magnification, or with the bookmarks or thumbnails visible.
If a document is set to open in Full Screen view, the toolbar, command bar, menu bar, and window controls are not visible. You can exit Full Screen view by pressing Escape, if your preferences are set this way, or by pressing Ctrl+L (Windows) or Command+L (Mac OS).

For more on this view, see “Reading documents in Full Screen view” on page 10.

**To open a PDF document:**

Do one of the following:

- Click the Open button , or choose File > Open. In the Open dialog box, select one or more filenames, and click Open. PDF documents usually have the extension .pdf.
- Choose the document’s filename from the File menu. The menu lists the four PDF documents you last opened.
- Double-click the file icon in your file system.

**Note:** On Mac OS, you may not be able to open a PDF document created in Windows by double-clicking the icon. If double-clicking the icon on Mac OS does not open the document, use the File > Open command in Acrobat Reader to open the document. After you've used the Open command once on the document, you’ll be able to open the document next time by double-clicking.

**Adjusting the view of PDF documents**

You can change the magnification level of a PDF document and set a page layout that determines whether you’ll see one page at a time or a continuous flow of pages.

**Magnifying and reducing the view**

The minimum and maximum zoom levels available depend on the current page size.

If you need to magnify a page to a size larger than the window, use the hand tool to move the page around so that you can view all the areas on it. Moving a PDF page with the hand tool is like moving a piece of paper on a desk with your hand.

**To increase magnification:**

Do one of the following:

- Select the zoom-in tool , and click the page.
- Select the zoom-in tool, and drag to draw a rectangle, called a marquee, around the area to magnify.
- Click the triangle next to the magnification value box in the viewing toolbar, and choose a magnification level.
- Click the Zoom In button in the viewing toolbar.

**To decrease magnification:**

Do one of the following:

- Select the zoom-out tool , and click the page.
- Select the zoom-out tool, and drag to draw a marquee the size you want the reduced page to be.
- Click the triangle next to the magnification value box in the viewing toolbar, and choose a magnification level.
• Click the Zoom Out button in the viewing toolbar.

**Note:** When the zoom-in tool is selected, you can press Ctrl (Windows) or Option (Mac OS) while clicking or dragging to zoom out instead of in. When the zoom-out tool is selected, press Ctrl or Option to zoom in.

**To change the magnification level using a thumbnail:**

1. Choose Window > Thumbnails to open the Thumbnails palette.
2. Position the pointer over the lower right corner of the red page-view box in the thumbnail until the pointer changes to the double arrow.
3. Drag the corner of the box to reduce or expand the view of the page.

**To resize a page to fit the window:**

Do one of the following:

• To resize the page to fit entirely in the window, click the Fit In Window button, or choose View > Fit in Window.
• To resize the page to fit the width of the window, click the Fit Width button, or choose View > Fit Width. Part of the page may be out of view.
• To resize the page so that its text and graphics fit the width of the window, choose View > Fit Visible. Part of the page may be out of view.

**To return a page to its actual size:**

Click the Actual Size button, or choose View > Actual Size. The actual size for a PDF page is typically 100%, but the document may have been set to another magnification level when it was created.

**Setting the page layout and orientation**

You can use three page layouts when viewing PDF documents:

• Single Page layout displays one page in the document pane at a time.
• Continuous layout arranges the pages in a continuous vertical column.
• Continuous - Facing layout arranges the pages side by side. This configuration accommodates a two-page spread display and multiple-page viewing in the window. If a document has more than two pages, the first page is displayed on the right to ensure proper display of two-page spreads.

In Single Page layout, the Edit > Select All command selects all text on the current page. In Continuous and Continuous - Facing layouts, it selects most of the text in the PDF document.

**To set page layout:**

Do one of the following:
• Click the Single Page button, the Continuous button, or the Continuous - Facing button in the status bar.
• Choose Single Page, Continuous, or Continuous - Facing from the View menu.

💡 To see two-page spreads most efficiently, use the Continuous - Facing page layout, and choose View > Fit Width.

**To rotate a page:**
Do one of the following:
• Click the Rotate View Clockwise button or the Rotate View Counter-Clockwise button in the status bar.
• Choose Rotate View Clockwise or Rotate View Counter-Clockwise from the View menu.
💡 You can change the orientation of a page in 90-degree increments with the rotation tools.

**Reading documents in Full Screen view**
In Full Screen view, PDF pages fill the entire screen; the menu bar, command bar, toolbar, status bar, and window controls are hidden. A document creator can set a PDF document to open in Full Screen view, or you can set the view for yourself. Full Screen view is often used for presentations, sometimes with automatic page advancement and transitions.

The pointer remains active in Full Screen view so that you can click links and open notes. You can use keyboard shortcuts for navigational and magnification commands, even though the menus and toolbar are not visible. You can also set preferences to define how Full Screen view appears on your system.

**To read a document in Full Screen view:**
Choose View > Full Screen. Press Return or the Down Arrow or Right Arrow key to page through the document. Press Shift-Return or the Up Arrow or Left Arrow key to page backward through the document.

**Note:** If you’re using Windows 98, Windows 2000, or Mac OS and have two monitors installed, the Full Screen view of a page appears on only one screen. To page through the document, click the screen displaying the page in Full Screen mode.

**To exit Full Screen view:**
Press Escape, if your Full Screen preferences are defined this way, or press Ctrl+L (Windows) or Command+L (Mac OS).

**To set preferences for Full Screen view:**
1 Choose Edit > Preferences > Full Screen.
2 Select the navigation options:
• Advance Every specifies whether to advance automatically from page to page every set number of seconds. You can page through a document using mouse or keyboard commands even if automatic paging is selected.
• Advance On Any Click lets you page through a PDF document by clicking the mouse. If this is not selected, you can page through a document by pressing Return, Shift-Return (to go backward), or the arrow keys.

• Loop After Last Page lets you page through a PDF document continuously, returning to the first page after the last. This option is typically used for setting up kiosk displays.

• Escape Key Exits lets you exit Full Screen view by pressing the Escape key. If this is not selected, you can exit by pressing Ctrl+L (Windows) or Command+L (Mac OS).

3 Choose the appearance options:
• Default Transition specifies the transition effect to display when you switch pages in Full Screen view.
• Mouse Cursor specifies whether to show or hide the cursor in Full Screen view.
• Background Color specifies the window's background color. If you choose Custom, the system color palette is displayed. See your computer's user guide for instructions on setting a custom color.
• Monitor (Mac OS) selects a monitor to use for Full Screen view when two monitors are installed. You can choose Main (for the monitor with the menu bar), Largest Intersection (for the monitor that displays the largest portion of the document), Deepest (for the monitor with the most colors), Widest (for the monitor with the greatest horizontal resolution), Tallest (for the monitor with the greatest vertical resolution), or Largest Area (for the monitor with the most pixels).

4 Click OK.

Navigating in PDF documents
You can navigate in PDF documents by paging through them or by using navigational structures. You can also retrace your steps through documents to return to where you started.

Paging through documents
Acrobat Reader provides buttons, keyboard shortcuts, and menu commands for paging through a PDF document.

Note: If you use the number keys on your keyboard’s number pad, make sure Num Lock is off.

To go to another page:
Do one of the following:
• To go to the next page, click the Next Page button ▶ in the navigation toolbar or status bar, press the Right Arrow key, press Ctrl (Windows) or Option (Mac OS) and the Down Arrow key, or choose Document > Next Page.
• To go to the previous page, click the Previous Page button ◀ in the navigation toolbar or status bar, press the Left Arrow key, press Ctrl (Windows) or Option (Mac OS) and the Up Arrow key, or choose Document > Previous Page.
• To move down one line, press the Down Arrow key.
• To move up one line, press the Up Arrow key.

_Note:_ The Down and Up Arrow keys move you one line at a time when you are not in Fit in Window view. In Fit in Window view, these keys move you one page at a time.

• To move down one screenful, press Page Down or Return.

• To move up one screenful, press Page Up or Shift+Return.

• To go to the first page, click the First Page button in the navigation toolbar or status bar, press the Home key, or choose Document > First Page.

• To go to the last page, click the Last Page button in the navigation toolbar or the status bar, press the End key, or choose Document > Last Page.

**To jump to a page by its number:**

Do one of the following:

• Drag the vertical scroll bar until the number of the page you want to jump to is displayed.

• Select the current page number in the status bar, type the page number to jump to, and press Return.

• Choose Document > Go To Page, type the page number, and click OK.

_Note:_ If the Use Logical Page Numbers option is selected in General preferences, and if your document’s page numbers are different from the page position in the PDF file, the page position appears in parentheses in the status bar. For example, if a first page is numbered “iii,” the numbering might appear as “iii(1 of 10).” You can double-click inside the parentheses, edit the page-position number, and press Return to go to that page.

**Browsing with navigational structures**

Acrobat Reader offers a wide range of navigational structures to help you move to specific places in PDF documents:

• Bookmarks provide a visual table of contents and usually represent the chapters, sections, and other organizational items in a document.

• Thumbnails provide miniature previews of document pages. You can use thumbnails to move pages, to change the display of pages, and to go to other pages. A page-view box in a thumbnail indicates the area of the page currently showing in the document pane.

• Links take you to specific locations another user (usually the document creator) has defined; these locations can be in the current document, in other electronic files, or in Web sites. A link usually points to a titled section or other organizational item.

• Articles are electronic threads that lead you through a document. An article typically begins on one page and continues on another, just as articles do in traditional newspapers and magazines. When you read an article, Acrobat Reader zooms in or out so the current part of the article fills the screen.

**To browse using a bookmark:**

1. Show the Bookmarks palette. You may need to choose Window > Show Bookmarks to open the palette or click the Bookmarks tab to bring the palette to the front of its group.
To jump to a topic using its bookmark, click the bookmark’s icon or text in the palette.

**Note:** Clicking a bookmark might perform an action, such as playing a movie, instead of taking you to another location. It depends on how the bookmark was defined.

The bookmark for the part of the document currently showing is boldfaced.

If the navigation pane disappears when you click a bookmark, the document creator has activated the Hide After Use command. To show the navigation pane again, click the Show/Hide Navigation Pane button on the command bar. Deselect Hide After Use in the navigation pane’s palette menu if you want the navigation pane to remain open after you click a bookmark.

Bookmarks can be subordinate to other bookmarks in their hierarchy; a higher level bookmark in this relationship is the parent, and a lower level bookmark is the child. You can collapse a parent bookmark in the palette to hide all its children. When a parent bookmark is collapsed, it has a plus sign (Windows) or a right-pointing triangle (Mac OS) next to it. If the bookmark you want to click is hidden in a collapsed parent, click the plus sign or triangle next to the parent to show it.

To select the bookmark for the part of the document showing in the document pane, choose Find Current Bookmark from the Bookmarks palette menu, or click the Find current bookmark button at the top of the Bookmarks palette. If the bookmark is hidden in a collapsed parent, the parent bookmark is opened so you can see the selected bookmark.

**To browse using a thumbnail:**

1. Show the Thumbnails palette. You may need to choose Window > Show Thumbnails to open the palette or click the Thumbnails tab to bring the palette to the front of its group.
2. Do one of the following:
   - To jump to another page, click the page’s thumbnail.
   - To display another part of the current page, position the pointer over the edge of the page-view box in the page’s thumbnail until the pointer changes to the hand tool (Windows) or a right-pointing triangle (Mac OS). Then drag the box to move the view area.

**To follow a link:**

1. Select the hand tool (Windows) or a selection tool.
2. Position the pointer over the linked area on the page until the pointer changes to the hand with a pointing finger (Windows). (The hand has a plus sign in it if the links point to the Web.) Then click the link.

**Note:** Clicking a link might perform an action, such as playing a movie, instead of taking you to another location, depending on how the link was defined.

**To read an article:**

1. Do one of the following:
   - Show the Articles palette. Then double-click the article’s icon in the palette to start reading at the beginning of the article.
   - Select the hand tool (Windows). Then click in the article to start reading it at that point, or press Ctrl (Windows) or Option (Mac OS) and click anywhere in the article to start reading at the beginning.
2 The pointer changes to the follow article pointer 🌋. Do one of the following to navigate through the article:

- To go to the next page in the article, press Return or click.
- To go to the previous page, press Shift-Return, or press Shift and click.
- To go to the beginning of the article, press Ctrl (Windows) or Option (Mac OS) and click.
- To exit the article before reaching the end, press Shift-Ctrl (Windows) or Shift-Option (Mac OS) and click.

3 When you reach the end of the article, the pointer changes to the end article pointer 🌋. Press Return or click to return to the view displayed before you started reading the article.

Retracing your viewing path

After you have paged through documents or used navigational structures to move through documents, you can retrace your path back to where you started. You can go 64 steps back in Acrobat Reader, or 32 steps back for documents in external browser windows.

To retrace your viewing path:

Do one or more of the following:

- To retrace your path within a PDF document, click the Go To Previous View button 🔄 in the navigation toolbar, or choose Document > Previous Page for each step back. Or click the Go To Next View button 🔄, or choose Document > Next Page for each step forward.
- To retrace your viewing path through other PDF documents, choose Document > Go To Previous Document for each step back or Document > Go To Next Document for each step forward. Or hold down Shift, and click the Go Back or Go Forward button. This command opens the other PDF documents if the documents are closed.

Viewing PDF documents on the Web

You can view PDF documents that are on the World Wide Web or an intranet using a Web browser. Every document on the Web is identified by a unique address called a Uniform Resource Locator (URL). When a PDF document is stored on the Web, you can click a URL link to it to open the document in your Web browser.

Reading PDF documents in a Web browser

PDF documents can display in Web browsers compatible with Netscape Navigator 4.0 (or later) or Internet Explorer 4.5 (or later). The necessary plug-ins are automatically installed when you install Acrobat Reader. For information on getting your browser ready, see “Installing the Web browser plug-in” on page 16.

When you view a PDF document in a Web browser, all of the Acrobat Reader tools are available in the browser.

Note: Many keyboard commands are mapped to the Web browser rather than to Acrobat, so some Acrobat keyboard shortcuts may not be available in the browser window.
Searching in a Web browser

Some Web search engines index PDF documents as well as HTML documents on Web servers. And some search engines support PDF search highlighting, although not all search engines that support PDF indexing support search highlighting.

If you visit a Web site that uses a search engine that indexes PDF documents, your search results list may include PDF documents. If the Web site uses a search engine that supports PDF search highlighting, and if you open one of the PDF documents in the search results list, the Highlight Next button and the Highlight Previous button activate on the Acrobat Reader command bar in your Web browser. The search term is also highlighted in the document.

To go to the next search hit, click the Highlight Next button. To go to the previous hit, click the Highlight Previous button. These two commands jump across PDF documents, but not across HTML documents.

Enabling Fast Web View

With Fast Web View, the Web server sends only the requested page of information to the user, not the entire PDF document. As a reader of the PDF document, you do not have to do anything to make this happen; it is communicated in the background between Acrobat Reader and the Web server. If you want the entire PDF document to continue downloading in the background while you view the first page of requested information, be sure Allow Background Downloading is selected in the Web Browser Options section of the preferences. For more information, see “Setting Acrobat Reader preferences” on page 17.

Setting up Acrobat Reader as a helper application

If your Web browser does not display PDF documents in the browser window, or if you prefer not to view PDF documents in the Web browser, you can set up Acrobat Reader as a helper application in your browser’s preferences. Then, when you view a PDF document on the Web, Acrobat Reader will start and display the document. When Acrobat Reader works as a helper application, you cannot use Fast Web Viewing, form submittal in a browser, or search highlighting on the Web. You can set an option preference so that all PDF documents on the Web open in a new Acrobat Reader window.

To set up your Web browser to recognize PDF files, you must define a MIME type and a file type. The file type should be pdf. The MIME type should be application/pdf. See your browser’s documentation for information on configuring it. This is especially important for using Netscape 6.0.

If you are using Netscape Navigator 4.0 or later, and you want to use Acrobat Reader as a helper application, rename the PDFViewer plug-in or delete it from the Netscape plug-in folder. The plug-in is named nppdf32.dll (Windows) or PDFViewer (Mac OS).

*Note: This is not necessary in Mac OS.*

**To use Acrobat Reader as a helper application in Windows:**

1. Choose Edit > Preferences, and select Options.
2. Deselect Display PDF in Browser, and click OK.
Installing the Web browser plug-in

Browsers compatible with Netscape Navigator need the nppdf32.dll file (Windows) or PDFViewer plug-in (Mac OS) to display PDF. When you install Acrobat Reader, this plug-in is automatically installed in the Netscape plug-in folder, if you have Navigator on your system. If you install Navigator after installing Acrobat Reader, or if you’re using another browser compatible with Navigator, you can install this plug-in yourself.

To install the Web browser plug-in:
1. Open the Browser folder (Windows) or the Web Browser Plug-in folder (Mac OS) in the Acrobat Reader folder.
2. Copy the nppdf32.dll file (Windows) or the PDFViewer plug-in (Mac OS) to your Web browser’s plug-ins folder.

Printing PDF documents

You can print the entire document, specify a range of pages, noncontiguous pages, or a particular page area to print before opening the dialog box.

To print a PDF document:
1. If you don’t need to print the entire document, do one of the following:
   • To select pages to print, click thumbnails in the Thumbnails palette. You can Ctrl-click (Windows) or Command-click (Mac OS) thumbnails to select non-contiguous pages, or Shift-click to select a contiguous range of pages. You can also select a contiguous page range in the Print dialog box.
   • To select an area on a page to print, select the graphic select tool and drag on the page to draw the area you want.
2. Choose File > Page Setup to set general printing options. The available options will vary with different printers and drivers. See your printer driver documentation for details.
3. Click the Print button, or choose File > Print. Specify the printer, page range, number of copies, and other options, and click OK. Most of the options are the same as they are for other applications, but note the following:
   • Selected Pages Or Selected Graphic (Windows) or Selected Thumbnails/Graphic (Mac OS) prints only the pages or page area you selected before opening the Print dialog box.
   • Page From/To prints a range of pages. In Windows, if the Use Logical Page Numbers option is selected in General preferences, you can enter page-position numbers in parentheses to print those pages. For example, if the first page of a document is numbered “iii”, you can enter (1) to print that page.
   • Comments prints Acrobat comment graphics on the pages.
   • Shrink oversized pages to paper size reduces the PDF file to fit the paper size specified in the printer properties.
   • Expand small pages to paper size enlarges the PDF file to fit the paper size specified in the printer properties.
   • Auto-rotate and center pages adjusts the PDF file’s orientation to match that specified in the printer properties.
• Print As Image (Windows) prints the pages as bitmap images. (In Mac OS, this is set in the Print Method pop-up menu.) You may want to print pages as images if normal printing does not produce the desired results.

• Print Method, in Windows, specifies which level of PostScript to generate for the pages. Choose the level of PostScript appropriate for your printer. In Mac OS, this specifies whether to print using PostScript (without selecting a level) or to print pages as bitmap images.

• Optimize for Speed downloads fonts to the printer as they are needed. With this option checked, the pages must be printed in the order in which Acrobat Reader emits them.

• Download Asian Fonts downloads Asian fonts to a PostScript printer. Select this option if you want to print a PDF document with Asian fonts but do not have the fonts installed on the printer and do not have the fonts embedded in the document. (Embedded fonts are downloaded whether or not this option is selected.) You can use this option with a PostScript Level 2 or higher printer, or a Level 1 printer that supports Type 0 font extensions.

• Save Printer Memory downloads all the fonts for a given page to the printer before the page is printed. When unchecked, print jobs may be smaller but require more printer memory.

**Note:** Some fonts cannot be downloaded to a printer, either because the font is a bitmap or because embedding of the font is restricted in that document. In these cases, a substitute font is used for printing, and the printed output may not match the screen display exactly.

If Download Asian Fonts is not selected, the PDF document prints correctly only if the referenced fonts are installed on the printer. If the fonts are not on the printer but the printer has similar fonts, the printer substitutes the similar fonts. If there are no suitable fonts on the printer, Courier is used for the text.

If you have a PostScript Level 1 printer that does not support Type 0 font extensions, or if Download Asian Fonts does not produce the results you want, print the PDF document as a bitmap image. Printing a document as an image may take longer than using a substituted printer font.

### Setting Acrobat Reader preferences

You can use preferences to define a default page layout, enable Web Buy, and customize Acrobat Reader in many other ways. General preferences settings are described here.

**Note:** These preferences control the Acrobat Reader application on your system; they are not associated with a particular document.

#### To set Acrobat Reader preferences:

Choose Edit > Preferences, or choose Preferences from the document pane menu. Select one of the features from the list at the left and select preference options for that feature.

- **Accessibility** Defines preferences for customizing color and page layout to make documents easier to read. For more information, see “Setting Accessibility preferences” on page 7.

- **Comments** Defines preferences for the appearance and functionality of document comments. For more information, see “Setting comment preferences” on page 28.
Display  Defines preferences for the appearance of pages within Acrobat Reader. Display
options are:
• Default Page Layout sets a page layout used for scrolling when you first open a
document. You can display pages one at a time as you scroll, continuously one above
the next, or continuously side by side.
• Page Units specifies a unit of measure for displaying page size in the status bar, and Info
palette.
• Application Language sets a language for the Acrobat Reader user interface. The pop-
up menu shows the languages you installed with Acrobat Reader. If you choose a
different language, the change takes effect the next time you start the application.
• Use Greek Text Below displays text below the designated point size as gray lines (or
greeked text) to speed display time.
• Display Page To Edge eliminates the thin white border that is displayed around the
edge of PDF pages created by some applications. If you do not select this option, pages
are printed with a white border, as defined by the printer driver.
• Display Transparency Grid displays a grid behind transparent objects.
• You can choose to smooth text, line art, and image. Smoothing smooths the edges of
text and monochrome images to minimize the contrast between the background and
the text or image. This sometimes improves the quality of the display on-screen,
especially with larger text sizes.
• Use CoolType lets you adjust the text display of Acrobat Reader to work optimally with
your monitor. When you have choose this option, you must also calibrate CoolType by
clicking Configure CoolType and choosing the text sample that looks the best.
• Default Zoom sets the magnification level for PDF documents when they are first
opened. This affects only documents that have Default set for their magnification level.
• Max “Fit Visible” sets the maximum magnification level for the Fit Visible view and for
viewing articles.

Forms  Defines preferences for the appearance and functionality of forms.

Full Screen  Defines preferences for the appearance and navigation of documents when
Acrobat Reader is in the full screen mode. For information on the specific options, see
“Reading documents in Full Screen view” on page 10.

Identity  Defines preferences for personal information which may be used for forms data.

Options  Defines preferences for opening Acrobat Reader, Web browsers, and other appli-
cation preferences. Preference options are:
• Display PDF in Browser displays any PDF files opened from the Web in your default
browser. If this option is not selected, the PDF files will open in a separate Acrobat
Reader window.
• Check Browser Settings checks your browser settings for compatibility with Acrobat
Reader each time Acrobat Reader is launched.
• Allow Fast Web view displays PDF files from the Web one page at a time. If this option is
not selected, the entire PDF will download before it is displayed.
• Allow Background Downloading allows a PDF document to continue downloading
from the Web, even after the first requested page displays on-screen in a Netscape
Navigator-compatible browser. If you do not select this option, only the requested page downloads to your computer, and other pages are downloaded as you request them.

- Display Splash Screen At Startup shows the splash screen each time Acrobat Reader is launched.
- Certified Plug-ins Only Certified Plug-ins allows you open encrypted files you have purchased, but prevents third-party plug-ins from loading at startup. This option may be required if you are using the Web Buy feature. If you change this option, click OK to exit and restart Acrobat Reader.
- Use Page Cache places the next page in a buffer even before you view the page in Acrobat Reader. This reduces the amount of time it takes to page through a document.
- Use Logical Page Numbers allows you to set page numbering in a PDF document using the Document > Number Pages command. You typically do this when you want PDF page numbering to match the numbering printed on the pages. A page's number, followed by the page position in parentheses, appears in the status bar and in the Go To Page, Delete Pages, and Print dialog boxes. For example, if the first page in a document is numbered “i”, it might appear as “i(1 of 10)”. If this option is not selected, Acrobat Reader ignores page numbering information in documents and numbers pages using Arabic numbers starting at 1.

**Note:** You will get unexpected results from the Go Back command in your Web browser if you do not select this option. For example, if you link to another document from a partially downloaded PDF document and then want to return to that document by using Go Back, you return to the first page of the PDF document, even if you were not on the first page. This option should alleviate most cases of unexpected Go Back behavior in your Web browser.

- Allow File Open Actions and Launching File Attachments warns you of security risks when you open a file in another application from a link in a PDF document and gives you a chance to cancel the operation. If this option is not selected, links to files in other applications are disabled.
- Open Cross-Document Links In Same Window opens linked PDF documents and views in one window to minimize the number of windows open in Acrobat Reader. If you do not select this option, a new window is opened for each new Go To View link. If a linked document is open when a Go To View link to it from another document is activated, the document remains open in a separate window.

**Note:** To override this setting, either selected or deselected, you can press Ctrl (Windows) or Option (Mac OS) when clicking a link.

- Reset All Warnings causes any warnings you have disabled to be redisplayed on startup.

**Update** Defines how often to check for updates to Acrobat Reader 5.0 and Acrobat Web Services, and allows you to check for updates instantly.

**Web Buy** Defines preferences for purchasing and viewing electronic books from the Web.
Getting information on PDF documents

When you view a PDF document, you can get information on the file, such as the title, the fonts used, and any security settings. Some of this information is set by the person who created the document, and some is generated by Acrobat. You can change any of the information that can be set by the document creator (unless the file has been saved with security settings that do not allow you to change the document). For more information on security settings, see “About Locked PDF files and license files” on page 31.

To get information on the current document:

Choose File > Document Properties > Summary, or select document summary from the document pane menu.

Basic information about the document is displayed. The title, subject, author, and keywords may have been set by the document creator.

**Note:** Acrobat Catalog and many Web search engines use the title to describe the document in their search results list. If a PDF file does not have a title, the filename appears in the results list instead. A file's title is not necessarily the same as its filename.

The binding option affects how the pages are arranged side by side when you view pages using the Continuous - Facing page layout. This is provided so that the arrangement of pages will match the reading direction (left to right or right to left) of text in the document. Right Edge binding is useful for viewing Arabic or Hebrew text or vertical Japanese text. You can change this setting.

Some information is generated by Acrobat and cannot be modified. This includes the application that created the original document, the Acrobat utility that produced the PDF file, the date and time the PDF file was created and last changed, whether the file was optimized for Fast Web Viewing, the file size, and the PDF version number. Acrobat generates this information from comments in the PostScript file.

Fonts lists the fonts and the font types used in the original document, and the fonts, font types, and encoding used in Acrobat Reader to display the original fonts. Only the fonts viewed in the document up to the current page are listed. To see a list of all fonts used in the entire document, click List All Fonts.

**Note:** You can look at this dialog box to see what fonts were used in the original document and whether the same fonts are used in Acrobat Reader. If substitute fonts are used and you aren’t satisfied with their appearance, you may want to install the original fonts on your system or ask the document creator to recreate the document with the original fonts embedded in it.

Finding words in PDF documents

You can use the Find command to find a complete word or part of a word in the current PDF document. Acrobat Reader looks for the word by reading every word on every page in the file, including text in form fields.
If a full-text index has been created for your PDF document, you can search the index for a word rather than using the Find command. A full-text index is an alphabetized list of all the words used in a document or, more typically, in a collection of documents. Searching with an index is much faster than using the Find command, because when Acrobat looks for a word in the index it goes right to the word in the list rather than reading through the documents.

**To find a word using the Find command:**

1. Click the Find button, or choose Edit > Find.
2. Enter the text to find in the text box.
3. Select search options if necessary:
   - Match Whole Word Only finds only occurrences of the complete word you enter in the text box. For example, if you search for the word *stick*, the words *tick* and *sticky* will not be highlighted.
   - Match Case finds only words that contain exactly the same capitalization you enter in the text box.
   - Find Backwards starts the search from the current page and goes backward through the document.
   - Ignore Asian Character Width finds only those Kana characters that exactly match the text you enter.
4. Click Find. Acrobat Reader finds the first occurrence of the word.

**To find the next occurrence of the word:**

Do one of the following:
- Choose Edit > Find Again.
- Reopen the Find dialog box, and click Find Again. (The word must already be in the Find text box.)

**Searching indexes**

Search features are only available if you downloaded the Adobe Acrobat Reader with Search and Accessibility option.

The Adobe Acrobat Search command allows you to perform full text searches of PDF documents and collections that have been indexed with the Acrobat Catalog feature. The Search command is more powerful and flexible than the Find command. It lets you search multiple documents, and define advanced query criteria. Search is faster than find because it reads the index rather than the entire document.

To search an index created using Adobe Acrobat Catalog, you first select the indexes to search, define a search query, and view the occurrences of the search term within the documents you selected to review. You can also select the documents to review from those returned by the search. A search query is an expression made up of text and other items to define the information you want to find.

Opening a PDF document associated with an index automatically makes the index searchable.
Selecting indexes
You can search any or all indexes displayed in the Index Selection dialog box. Dimmed indexes are not available for searching.

To add or remove indexes to search:
1. Choose Edit > Search > Select Indexes to list the currently available indexes and to add or delete indexes, and then do one of the following in the Index Selection dialog box:
   - To add an index to the available indexes list, click Add, navigate to the index, and double-click on the index file.
   - To remove an index, select the index name, click Remove, and then click OK.
   - To select or deselect an index, select the box for the index, and then click OK. Dimmed indexes are currently unavailable for searching.
   - To view information about an available index, highlight the index name, click Info, and then click OK. The information displayed includes the build date, creation date, number of documents in the index, location of the index, status, and information provided by the builder of the index.

Using the Search command
The Search command allows you to perform a search on indexed PDF documents. You can search for a simple word or phrase, or you can expand your search query by using wild-card characters and Boolean operators. You can use the search options to further refine your search. And if document and date information were provided for the documents you are searching, you can use that information to further narrow your search.

The text that you type in can be a single word, a number, a term, or a phrase. It can be a word, with or without wild-card characters (*, ?), or any combination of letters, numbers, and symbols. Because you can use Boolean operators in the text box, you must enclose any search term that includes and, or, or not in quotes. You can also use the operators =, ~, and != with text, but only to perform exact matches, contains, and does not contain searches, respectively. You can use comparison operators (<, <=, >, >=) with values of the same type.

To perform a full-text search:
1. Launch Acrobat Reader 5.0, and choose Edit > Search > Query.
2. Enter the text you want to search for in the Find Results Containing Text box. To clear the search dialog box and redefine the search, click Clear.
3. Selecting any combination of the search options:
   - Word Stemming. Word Stemming finds words that contain part of (a word stem) the specified search word. It applies to single words, not phrases; does not apply to words that contain wild-card characters (*, ?); finds words that end in ing, ed, s, ion, and so on, but not er; and cannot be used with the Match Case option. Word Stemming works only for indexes built with this option.
   - Sounds Like. Sounds Like finds different spellings for proper names. It applies to single words, not phrases; does not apply to words that contain wild-card characters; and cannot be used with the Match Case option. Sounds Like works only for indexes built with this option.
• Thesaurus. Thesaurus finds similar words that appear in the documents you are searching, not necessarily all the similar words you might find in a complete thesaurus. It applies to single words, not phrases; does not apply to words that contain wild-card characters; and cannot be used with the Match Case option.

• Match Case. Match Case limits the results of the search by finding only those documents that contain words with the same capitalization. It can be used with a Boolean expression and with terms that use wild-card characters. Characters matched by wild-card characters can be either uppercase or lowercase.

• Proximity. Proximity limits the results of simple AND searches to one pair of matches per document—the pair closest together. The two matches must be within three pages or fewer of each other. This option is useful for locating a document that concentrates on some topic of interest. Proximity affects relevancy ranking in searches. The closer the matches are within a document, the higher the ranking. Proximity does work with complex AND searches—such as, Hawaii AND (cruise OR fly).

If the search options are not displayed in the Acrobat Search dialog box, restore them by closing the Search dialog box, choosing Edit > Preferences > General > Search (Windows), or Edit > Preferences > Search (Mac OS) and selecting Word Options. Choose Edit > Search > Query to continue.

4 Select Search. The Search dialog box is hidden, and documents that match your search query are listed in the Search Results window in order of relevancy.

• The results are displayed in the Search Results window. Documents more likely to contain relevant information are listed first on the list. The relevancy ranking of each document is indicated by an icon. The degree of fill in the circle in the icon indicates the probability that the document contains the search information. A solid fill indicates a high probability that the document contains your search term; an empty circle indicates a low probability that the document contains your search term. When you open a document in the list, you view only pages containing matches. All the matches on a page are highlighted. When you use ordinary search text, the relevancy ranking indicates how frequently the search word appears in the document. This means both in absolute terms and relative to the number of other words in the document.

• When you use a Boolean OR operator between two words or phrases in a search, documents that contain both items have a higher relevancy ranking than documents that contain just one item.

• When you use the Proximity option, the closer the matches are within a document, the higher the relevancy ranking of the document.

5 View the document by doing one of the following:

• Select the document, and click the View button.

• Double-click the document.

6 Click the Next Highlight button or the Previous Highlight button to go to other matches in the document. You can also choose another document to view.
Advanced search techniques

You may need to perform searches using advanced criteria and special operators. If your search returns too many matches, none, or information you don’t need, you can change how Acrobat searches. This section covers refining, Word Assistant, options, and Boolean operators.

If you want to keep the search dialog box small, you can hide (or keep hidden) the options and type in their names in the Find Results Containing Text box. Along with the text box names, you need to use operators such as = (equals) and > (greater than). For the options, type in /st (stemming), /so (sounds like), /th (thesaurus), /ca (match case), or /pr (proximity).

Before you perform a search with one of these techniques, you can preview the type of results you’ll receive using the Word Assistant. For more information, see “Using Word Assistant” on page 24. Alternatively, you can redefine the query by typing new text in the Acrobat Search dialog box or by using other techniques to expand the search to include more documents or to limit the search to fewer documents. For more information, see “Limiting searches” on page 27.

Refining searches

If you want to narrow a search you can refine or confine your search to documents listed in a prior search. For example, you can first search for (and find) all documents by an author, and then define a search query for that subset of documents. The result would be a subset of documents that are authored by the specified author and that contain the search string.

To refine a search:

1. Choose Edit > Search > Results to display the Search Results window. Select and show the results of a previous search.
2. Choose Edit > Search > Query to open the Search dialog box. Edit or replace the query that produced the first list of documents.
3. If you used a simple text string for the search query, you might consider refining the search query by using the search options, by including document and date information in the search, or by using Word Assistant. For more information, see “Using Word Assistant” on page 24.
4. Press Ctrl (Windows) or Option (Mac OS). The button label changes from Search to Refine.
5. Click Refine. This produces a Search Results list of documents that are a subset of the previous list, and that match the new query.

Using Word Assistant

Word Assistant enables you to build a list of terms that will appear when you specify a search using the Sounds Like, Word Stemming, or Thesaurus options. The resulting list shows you if the option you are using is likely to return helpful results. If the list is too long or full of irrelevant words, you can quickly construct a list of words to find by copying words from the Word Assistant dialog box and pasting them into the search dialog box.

To use the Word Assistant with search options:

1. Choose Edit > Search > Word Assistant.
2 Click Indexes to check the available indexes or change the selection of indexes.
3 In the Index Selection dialog, select the indexes you want to use. Click OK.
4 Select a search option (Sounds Like, Word Stemming, or Thesaurus) from the Assist menu.
5 Enter the search word in the Word text box, and click Look Up.

To copy words from the Word Assistant dialog box:
1 Choose Edit > Search > Query to open the Search dialog box.
2 Choose Edit > Search > Word Assistant, and use the Word Assistant to generate a list of related words.
3 Double-click a word to search. The selected word appears in the Word text box.
4 Copy the results in the Word text box, and paste them into the Find text box of the Search dialog box.
5 Repeat steps 3 through 5 for each word you want to use; separate each pair of words in the Find text box with AND or OR.
6 Click Search.

Searching with Document Info and Date Info
If document and date information was provided for the documents you are searching, you can use this information in the Search dialog box to limit your search. For example, you can limit your search to documents authored by one person and created or modified within a given period or on a given date. You can view the document and date information (if any) provided by choosing File > Document Properties > General from within the PDF document. If these options are not displayed in the Acrobat Search dialog box, restore them by closing the Search dialog box, choosing Edit > Preferences > General > Search (Windows), or Edit > Preferences > Search (Mac OS) and selecting Document Information. Open the Query dialog box to continue.

To search using Document Info:
In the Search dialog box, enter your search query information in the appropriate title, subject, author, and keywords text boxes. You can use Boolean operators and wild-card characters in these text boxes, with the search text. All documents that contain the value are returned. If the With Document Info text boxes are not displayed in your Search dialog box, choose Edit > Preferences > General > Search (Windows), or Edit > Preferences > Search (Mac OS) and select Document Information. You may see additional custom text boxes in your display, depending on the information supplied for the PDF document.

To search using Date Info:
1 In the Search dialog box, do one of the following:
   • Enter a date (month, day, year), or use the Up and Down Arrow keys to select a value.
   • To limit a search to documents created or modified after a specific date, specify the after date, and leave the before date blank.
   • To limit a search to documents that were created or modified before a specific date, specify the before date, and leave the after date blank.
• To create a Boolean AND condition, enter the creation and modification dates in the Search dialog box. An AND condition returns only documents created or modified during the specified period.

Searching for phrases, stopwords, numbers, and separator characters
If the indexes do not specify stopwords, you can search for phrases in which they appear. If your search phrase includes the words and, or, or not used in their ordinary sense (not as a Boolean operator), put the phrase in quotes. The search phrase “once or twice” finds all occurrences of the phrase once or twice, not all occurrences of once and all occurrences of twice as it would without the quotes.

• If your search phrase includes punctuation (other than an apostrophe) or special characters (such as @ and *), they are ignored. For example, either of the terms son-in-law, son in law finds all occurrences of both son-in-law and son in law.

• If you are unsuccessful in searching for a phrase that includes a common word, it is probably because it is a specified stopword.

• If you are unsuccessful in searching for a term that includes numbers, it is probably because numbers have been excluded from the index. Adobe Acrobat Catalog defines a number to be a sequence of one or more digits (0 through 9), optionally preceded by a minus sign (-), optionally separated by one or more commas (,) or periods (.), and optionally containing a decimal point, which can be a period (.) or a comma (,).

• If you use a separator character in a search term, it is automatically discarded. Separator characters include all symbols, the space character, and punctuation characters except the apostrophe. When indexing a PDF document, Acrobat Catalog uses separator characters to recognize where one term ends and the next term begins.

• If alphanumeric terms are made up of numbers and separator characters, they can also be excluded.

Using Boolean operators
To avoid building inaccurate search queries, follow these guidelines:

• You can use operators in text and Document Info text boxes.

• You can use =, ≠, and != with text only to perform exact matches, contains, and does not contain searches, respectively.

• You can use comparison operators (<, <=, >, >=) with values of the same type.

• When NOT is used with either or both of the AND and OR operators, it is evaluated before either the AND or OR. For example, evolution AND NOT Darwin finds all documents that contain the word evolution but not the word Darwin.

• When you combine AND and OR in the same expression, AND is evaluated before OR. For example, Darwin OR origin AND species finds all documents that contain Darwin or that contain both origin and species.
• When you use parentheses, you change the default order of evaluation for Boolean operators. For example, \((\text{Darwin OR origin}) \text{ AND species}\) finds all documents that contain either \text{Darwin} and \text{species} or that contain \text{origin} and \text{species}. Parentheses can be nested.

• When you use a literal phrase that contains an operator name, a symbol for an operator name (such as & for AND), or parentheses, the phrase must be enclosed in quotation marks. For example: "cats and dogs" finds all documents that contain the phrase \text{cats and dogs}, not all documents that contain either the word \text{cats} or the word \text{dogs}. The phrase \text{cats & dogs} also needs quotes to be interpreted literally.

In addition to \text{and}, \text{or}, \text{not}, and parentheses, the symbols that require quotation marks are:

\& AND
\| and, OR

\! NOT

However, quoted search phrases that contain parentheses or vertical bars can produce unexpected results.

**Expanding searches**

If your search returns too few or no results, you may have to expand the search criteria. Use the Search dialog box, and follow these general guidelines:

• Use wild-card characters in the search text to increase the number of matches for the text.

• Use an asterisk (*) to match zero, one, or more characters; use a question mark (?) to match any one character.

• Use wild-card characters in a term that is part of a Boolean expression.

• Use wild-card characters to specify Document Info text box values. However, you cannot use wild-cards to represent separator characters such as the hyphen (-) and the slash (/).

• Use Boolean expressions in Document Info text box values.

• Use a Boolean OR operator between two words to return documents containing either word.

• Use the Sounds Like, Word Stemming, and Thesaurus options to increase the number of matches for the text.

• Use a comma (,) or vertical bar (|) to separate items in an OR search.

**Limiting searches**

• Use a Boolean NOT operator before a word or search term to exclude documents containing the word or search term.

• Use an exclamation point (!) as another way to specify a NOT search. However, be sure to place a space between the exclamation point and the search item.

• Use a Boolean AND operator between two words to return only documents containing both words.

• Use the Proximity option to limit AND searches. This specifies that words must be in close proximity to each other—within three pages or fewer.
• Use the Match Case option to match exact capitalization.

Reviewing comments
The comments feature of Adobe Acrobat 5.0 lets a user attach comments to an existing document. These comments can be in the form of notes, text, audio, stamps, files, graphic markups, and text markups. In Acrobat Reader 5.0, you can open comments and review their contents; you cannot edit the comments, nor can you launch file attachments or play sound comments. Notes do not print directly from the document that they annotate.

To review notes:
Do one of the following:
• To view a note, position the mouse over the note icon until the note description pops up.
• To open a note, double-click the note icon.
• To close a note, click the close box in the upper left corner of the note window.

Setting comment preferences
You can set the font style, color, and size for comments.

To set preferences for comments:
1 Choose Edit > Preferences > Comments.
2 Select a font style from the Font menu.
3 Enter a number for the Font Size or choose a size from the pop-up menu.
4 Click OK.

Playing movies and sound clips
Before you can play movies or sounds, your computer must have the appropriate hardware and software installed. See your system's documentation for more information. You must also have the necessary software installed on your system:
• Apple QuickTime 3.0 or later, or Microsoft Windows Media Player (Windows).
• Apple QuickTime 3.0 or later (Mac OS).

Note: QuickTime 4.0 or later is recommended. QuickTime 5.0 or later is required for working with MPEG files.

To play a movie or sound clip:
1 Select the hand tool $\text{Hand Tool}$.
2 Move the cursor over a movie or sound clip, the cursor changes to a filmstrip.
3 Click to begin playing the clip.
4 Click again to stop playing, or press Escape.
Viewing documents with digital signatures

Acrobat Reader 5.0 allows you to view and print PDF documents with digital signatures; it does not allow you to validate digital signatures or digitally sign PDF documents. A digital signature may appear in a document as text, a graphic, or a handwritten facsimile.

Filling out forms

You can fill out forms in Acrobat Reader and submit them across the Web if you are filling them out from inside a Web browser.

To fill out a form:

1 Select the hand tool  
2 Position the pointer inside a form field, and click. The I-beam pointer allows you to type text. The arrow pointer allows you to select a button, a check box, a radio button, or an item from a list.
3 After entering text or selecting an item, check box, or radio button, do one of the following:
   • Press Tab to accept the form field change and go to the next form field.
   • Press Shift+Tab to accept the form field change and go to the previous form field.
   • Press Enter (Windows) or Return (Mac OS) to accept the form field change and deselect the current form field.

In a multiline text form field, Enter or Return goes to the next line in the same form field. You can use Enter on the keypad to accept a change and deselect the current form field.
   • Press Escape to reject the form field change and deselect the current form field.

If you are in Full Screen mode, pressing Escape a second time causes you to exit Full Screen mode.

4 Once you have filled in the appropriate form fields, click the Submit Form button, if one exists. The button may be named differently. Clicking this button sends the form data to a database across the Web or over your company intranet. This button only works if you are viewing the PDF document from inside a Web browser, or you have Web Capture.

To clear a form in a browser window:

Do one of the following:
   • Select a Reset Form button, if one exists.
   • Exit Acrobat Reader without submitting the form, and start again.

Clicking the Reload button the Go Back button, or following a link in a Web browser window, does not clear a form.

Important: There is no undo for this action.
Copying and pasting text and graphics to another application

You can select text or a graphic in a PDF document, copy it to the Clipboard, and paste it into a document in another application such as a word processor. Once the selected text or graphic is on the Clipboard, you can switch to another application and paste it into another document.

Note: If a font copied from a PDF document is not available on the system displaying the copied text, the font cannot be preserved. A default font is substituted.

To select text and copy it to the clipboard:

1. Select the text select tool, and do one of the following:
   - To select a line of text, select the first letter of the sentence or phrase and drag to the last letter.
   - To select multiple columns of text (horizontally), hold down Ctrl (Windows) or Option (Mac OS) as you drag across the width of the document.
   - To select a column of text (vertically), hold down Ctrl+Alt (Windows) or Option+Command (Mac OS) as you drag the length of the document.
   - To select all the text on the page, choose Edit > Select All. In Single Page mode, all the text on the current page is selected. In Continuous or Continuous - Facing mode, most of the text in the document is selected. When you release the mouse button, the selected text is highlighted. To deselect the text and start over, click anywhere outside the selected text.

The Select All command will not select all the text in the document.

2. Choose Edit > Copy to copy the selected text to the Clipboard.

3. To view the text, choose Window > Show Clipboard.

In Windows 95, the Clipboard Viewer is not installed by default, and you cannot use the Show Clipboard command until it is installed. To install the Clipboard Viewer, choose Start > Settings > Control Panel > Add/Remove Programs, and then click the Windows Setup tab. Double-click Accessories, check Clipboard Viewer, and click OK.

To copy graphics to the Clipboard:

1. Select the graphics select tool. The cursor changes to the cross-hair icon.

2. Drag a rectangle around the graphic you want to copy. To deselect the graphic and start over, click anywhere outside the selected graphic.

3. Choose Edit > Copy to copy the graphic to the Clipboard.

4. To view the graphic, choose Window > Show Clipboard. The graphic is copied using the WMF (Windows), PICT (Mac OS), or XPIXMAP (UNIX) format. In UNIX, the graphic is pasted in the primary selection.
Using Web Buy

The Web Buy feature lets you buy and download eBooks, reference works, technical manuals, structured business documents, newspapers, and periodicals as PDF files that have been locked with the Adobe secure PDF technology to protect the copyrights of authors and publishers. Web Buy lets you unlock these files so that you can read and search them on your personal computer or reading device. A series of Web pages pops up in your browser to guide you through the process.

Setting your Web Buy preferences

Sellers of electronic documents may require that the use of an electronic document be tied to a particular computer or storage device. You can specify in the Web Buy preferences dialog box what storage device information you are willing to make available to sellers automatically when you purchase a secure PDF document over the Web. An advisory page will pop up in your Web browser if a seller seeks information other than that you have defined in your Web Buy preferences dialog box.

To set your Web Buy preferences:

1. Select Edit > Preferences > Web Buy.
2. Make sure Enable Web Buy is checked.
3. Specify what warnings you would like to receive before information is sent to an on-line seller.
4. Select your preference of storage device from the Other Identifier 1 drop-down menu. You may select an alternate storage device for Other Identifier 2. All devices that are visible to your computer are listed in the drop-down menus.

Note: If you lock a document to a portable device such as a Zip cartridge or Jaz drive, the document is portable. If you lock a document to your computer, the document can be read only on that machine.
5. Enter a path in the text box or click the Choose button to select a default folder in which to store your purchases.
6. Click OK.

About Locked PDF files and license files

When you attempt to download or open a PDF file that has been locked, Web Buy will look for a matching license file. The license file is created by the seller and specifies certain security and permission parameters. For example, a seller may restrict printing, copying, or extracting images from a copyrighted document. You can view the security settings for a PDF file by choosing Document Security from the document pane menu or clicking on the key icon in the status bar, and clicking the Display Settings button in the document security dialog box. These settings cannot be modified by the user.

If Web Buy is able to locate a valid license file, the locked PDF will be opened for viewing. If a matching license file is not located, a dialog box will be displayed to allow you to manually locate the license file on your computer, or go on-line to obtain a license file to unlock the document.
To find a license file:

1. Click Find License and locate the license file. The license file will have the same name as the associated PDF file followed by the extension .rmf.
2. Click OK. The PDF will be unlocked and opened.

To obtain a license on-line:

1. Click Go On-line. Your browser will open to the URL specified in the locked PDF file.
2. Follow the on-screen instructions to complete the transaction with the seller or source of the PDF file you want to unlock and download the proper license file.

Downloading the Web Buy plug-in

If you try to download a locked PDF file without having the Adobe Web Buy plug-in installed, you will be prompted to go to the Adobe Web site (www.adobe.com). In the error message dialog box, click the Adobe Online button and follow the instructions on the Web site. (Version 3.0 and earlier versions of Acrobat Reader do not support the Web Buy plug-in.)

Updating your Web Buy plug-in

If the PDF file you are trying to open was locked using a version of PDF Merchant more recent than the version of the Web Buy plug-in you have installed, you will be prompted to update your version of Web Buy. In this case, a dialog box will be displayed. Click Adobe Online to go to the Adobe Web site and download the latest version of Web Buy.

To find out which version of Web Buy is currently installed, you can go the About Box for Web Buy by choosing Help > About Adobe Acrobat Plug-ins. Select Web Buy from the list of currently installed plug-ins to view the version number and other information about Web Buy.

Using Acrobat Reader with UNIX

In general, Acrobat Reader functions on UNIX systems in the same way it does on other systems. However, there are a few areas where you will need to know specific UNIX commands for Reader. To display a list of all Acrobat Reader command-line options (UNIX), start the Acrobat Reader product with the -help option. For example:

acread -help

Setting a default view

In UNIX, the first time you open Acrobat Reader, a preferences file named .acrorc is created in your $HOME directory. If you have opened an earlier version of Acrobat Reader at any time prior to opening the 5.0 version, you should delete $HOME/.acrorc before starting Acrobat Reader 5.0. A new .acrorc file will be created with the recommended Acrobat Reader 5.0 settings when you start Acrobat Reader 5.0.

Note: Some Acrobat Reader features are not available when Acrobat Reader is installed on an Asian-language UNIX operating system. See the Reader ReadMe for details.
Customizing resources for your personal use
When Acrobat Reader starts, it searches for resources in the standard X Window System resource file (~/.Xdefaults). It uses all resources it finds to determine the proper setup. If it finds a resource more than once, it uses the last value found. By editing the resource file, you can customize Acrobat Reader. For your changes to take effect, you must restart your windowing system.

The following sections describe some general Acrobat Reader resources that you can change in the .Xdefaults file:

• “Plug-in location” on page 33.
• “Starting multiple Acrobat Reader viewers” on page 33.
• “Fonts for bookmarks” on page 34.

Plug-in location
When Acrobat Reader starts, it searches for plug-ins in the directory $ACRO_INSTALL_DIR/$ACRO_CONFIG/plug_ins. You can specify a new default directory by changing the systemPlugInPath label. The systemPlugInPath label specifies the location of the plug-ins used by all users of Acrobat Reader:

    systemPlugInPath /net/Acrobat/Sun_OS4/doc_dept/plug-ins

You can specify your own plug-ins when starting Reader. By default, Acrobat Reader searches for personal plug-ins in the $HOME/plug_ins directory. You can specify a new default directory for personal plug-ins by changing the *userPlugInPath label. For example:

    userPlugInPath $HOME/Acrobat/plug_ins

Starting multiple Acrobat Reader viewers
If you want to open a new Acrobat Reader program every time you open a PDF file, set the userFrontEndProgram resource to FALSE. By default, the userFrontEndProgram is set to TRUE, meaning that the Acrobat Reader program that is already opened is used to display the new PDF file.

Giving Acrobat Reader access to fonts
If a font is referenced in a PDF file, but not embedded, and Acrobat Reader finds that font on the system opening the file, Acrobat Reader will use the font on the system to display the text. You can give Acrobat Reader access to your installed Type 1 fonts by setting the PSRESOURCEPATH variable in the viewer launch script or in your user configuration file. Editing the launch script, usually done by a system administrator, gives all users who access that copy of the viewer access to the fonts. Editing your user configuration file gives you access to the fonts.

The PSRESOURCEPATH variable looks for UNIX PostScript Resource (.upr) files in the location at which you point it. The .upr files are created when Type1 fonts are installed. If you have installed Adobe Illustrator® or Adobe Photoshop®, the PSRESOURCEPATH is already set for the individual and Acrobat Reader will find it.

To give access to fonts systemwide:
1 Open Acrobat4/bin/acroread in a text editor.
2 Enter the following command:
PSRESOURCEPATH=<font_location>::

3 Restart Acrobat Reader.

To give an individual access to fonts:
1 Open your user configuration file in a text editor.
2 Set the PSRESOURCEPATH environment variable:
PSRESOURCEPATH=<font_location>::
3 Restart Acrobat Reader.

Fonts for bookmarks
If you want to change the default font size used for bookmarks, you can change the value of bookmarkFontSize. The font size is expressed in points. If you want to change the font family, you can change the value of bookmarkFontName. For example:

bookmarkFontSize 10
bookmarkFontName Courier

Setting preferences
In UNIX, you can define resources in the .Xdefaults file. You can also give Acrobat Reader access to more fonts systemwide or for individual users. See “Giving Acrobat Reader access to fonts” on page 33 for information.

To install the Web browser plug-in (UNIX):
Run <installdir>/Browsers/netscape.

Printing PDF documents from the command line (UNIX)
Besides printing directly from within Acrobat Reader by choosing File > Print, you can print PDF files from the command line. To print the file sample.pdf to the default printer, type the following:
cat sample.pdf | acroread -toPostScript | lp

Note: If a PDF file has been secured with an Open password or does not allow printing, you will not be able to print from the command line.

You can use options to control your print job from the command line. Options available to Acrobat Reader are the following.

To create a LanguageLevel 2 PostScript file:
-level2

To print a PDF file to a differently named PostScript file:
-pairs <pdf filename> <PostScript filename>
For example, to print sample.pdf to test.ps, you would use the following syntax:
acroread -toPostScript -pairs sample.pdf test.ps
Using reader with Asian fonts

In Acrobat Reader 5.0, you can view and print PDF documents that contain Japanese, Korean, Traditional Chinese, and Simplified Chinese text if you use the appropriate language kit at installation.

If you are working on an operating system that does not have support for Asian languages, in order to enable the viewing and printing of PDF files that contain Asian language text, you will need to separately download and install one or more of the Asian language font packs that are available on the Adobe Web site (www.adobe.com). Fonts are available for the Chinese Traditional, Chinese Simplified, Japanese, and Korean languages.

How to print this online guide

Because the pages of this online guide are optimized for online viewing, you may prefer to print them two to a page (two-up).

To print pages two up:

1. Choose File > Print Setup (Windows) or File > Page Setup (Mac OS).
2. Follow the instruction for your platform:
   • In Windows, click Options, select 2 up on the paper tab, click OK to return to the Print Setup dialog box, and click OK again to close it.
   • In Mac OS, choose 2 Up from the Layout menu and click OK.

*Note: If you can’t perform step 2 in Windows, you may not be using the Adobe PostScript printer driver.*

3. Choose File > Print.
4. Indicate the page range.
5. Click OK (Windows) or Print (Mac OS).
# Windows Shortcuts

## Selecting tools

<table>
<thead>
<tr>
<th>Tool</th>
<th>Keystroke</th>
</tr>
</thead>
<tbody>
<tr>
<td>Article</td>
<td>A</td>
</tr>
<tr>
<td>Crop</td>
<td>C</td>
</tr>
<tr>
<td>Form</td>
<td>F</td>
</tr>
<tr>
<td>Hand</td>
<td>H</td>
</tr>
<tr>
<td>Link</td>
<td>L</td>
</tr>
<tr>
<td>Movie</td>
<td>M</td>
</tr>
<tr>
<td>Pencil</td>
<td>N</td>
</tr>
<tr>
<td>TouchUp object</td>
<td>O</td>
</tr>
<tr>
<td>Notes</td>
<td>S</td>
</tr>
<tr>
<td>TouchUp text</td>
<td>T</td>
</tr>
<tr>
<td>Highlight text</td>
<td>U</td>
</tr>
<tr>
<td>Text select tool</td>
<td>V</td>
</tr>
<tr>
<td>Zoom in tool</td>
<td>Z</td>
</tr>
<tr>
<td>Zoom out tool</td>
<td>Shift + Z</td>
</tr>
<tr>
<td>Hidden Pencil tools: line, rectangle, ellipse</td>
<td>Shift + N</td>
</tr>
<tr>
<td>Hidden Notes tools: text comment, audio comment, stamp, file comment</td>
<td>Shift + S</td>
</tr>
<tr>
<td>Hidden Text Select tools: column select, graphics select, table select</td>
<td>Shift + V</td>
</tr>
<tr>
<td>Hidden Highlight tools: strikethrough, underline</td>
<td>Shift + U</td>
</tr>
<tr>
<td>Hidden TouchUp Text tools: touch up object</td>
<td>Shift + T</td>
</tr>
<tr>
<td>Graphics Select</td>
<td>G</td>
</tr>
</tbody>
</table>
## Navigation

<table>
<thead>
<tr>
<th>Result</th>
<th>Keystroke</th>
</tr>
</thead>
<tbody>
<tr>
<td>Previous screen</td>
<td>Page Up</td>
</tr>
<tr>
<td>Next screen</td>
<td>Page Down</td>
</tr>
<tr>
<td>Temporarily select hand tool</td>
<td>Spacebar</td>
</tr>
<tr>
<td>First page</td>
<td>Home</td>
</tr>
<tr>
<td>Last page</td>
<td>End</td>
</tr>
<tr>
<td>Delete/clear</td>
<td>Del</td>
</tr>
<tr>
<td>Previous page</td>
<td>Left Arrow</td>
</tr>
<tr>
<td>Next page</td>
<td>Right Arrow</td>
</tr>
<tr>
<td>Scroll up</td>
<td>Up Arrow</td>
</tr>
<tr>
<td>Scroll down</td>
<td>Down Arrow</td>
</tr>
<tr>
<td>Show/Hide full screen</td>
<td>Ctrl + L</td>
</tr>
<tr>
<td>Go to page</td>
<td>Ctrl + N</td>
</tr>
<tr>
<td>Previous page</td>
<td>Left Arrow</td>
</tr>
<tr>
<td>Go to Previous View</td>
<td>Alt + Left Arrow</td>
</tr>
<tr>
<td>Go to Next View</td>
<td>Alt + Right Arrow</td>
</tr>
<tr>
<td>Next page</td>
<td>Right Arrow</td>
</tr>
<tr>
<td>First page</td>
<td>Shift + Ctrl + Page Up</td>
</tr>
<tr>
<td>Last page</td>
<td>Shift + Ctrl + Page Down</td>
</tr>
<tr>
<td>Go to Previous Document</td>
<td>Alt + Shift + Left Arrow</td>
</tr>
<tr>
<td>Go to Next Document</td>
<td>Alt + Shift + Right Arrow</td>
</tr>
<tr>
<td>First page</td>
<td>Shift + Ctrl + Up Arrow</td>
</tr>
<tr>
<td>Last page</td>
<td>Shift + Ctrl + Down Arrow</td>
</tr>
<tr>
<td>Next tab in Navigation pane, Next toolbar in menu mode, Next tab in tabbed dialog boxes, Next window in document view</td>
<td>Ctrl + Tab</td>
</tr>
</tbody>
</table>
# Function Keys

<table>
<thead>
<tr>
<th>Result</th>
<th>Keystroke</th>
</tr>
</thead>
<tbody>
<tr>
<td>Help</td>
<td>F1</td>
</tr>
<tr>
<td>Show/Hide bookmarks</td>
<td>F5</td>
</tr>
<tr>
<td>Next pane</td>
<td>F6</td>
</tr>
<tr>
<td>Spell check</td>
<td>F7</td>
</tr>
<tr>
<td>Show/Hide toolbars</td>
<td>F8</td>
</tr>
<tr>
<td>Find Again</td>
<td>F3</td>
</tr>
<tr>
<td>Menu mode</td>
<td>F10</td>
</tr>
<tr>
<td>Context menus</td>
<td>Shift + F10</td>
</tr>
<tr>
<td>In Navigation pane, goes to document view and leaves Navigation pane open</td>
<td>Shift + F6</td>
</tr>
<tr>
<td>Next window</td>
<td>Ctrl + F6</td>
</tr>
<tr>
<td>Next secondary window</td>
<td>Alt + F6</td>
</tr>
<tr>
<td>Rename</td>
<td>F2</td>
</tr>
<tr>
<td>Show/Hide thumbnails</td>
<td>F4</td>
</tr>
<tr>
<td>Show/Hide Menu Bar</td>
<td>F9</td>
</tr>
</tbody>
</table>

# Editing Documents

<table>
<thead>
<tr>
<th>Result</th>
<th>Keystroke</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select all</td>
<td>Ctrl + A</td>
</tr>
<tr>
<td>Copy</td>
<td>Ctrl + C</td>
</tr>
<tr>
<td>Zoom to</td>
<td>Ctrl + M</td>
</tr>
<tr>
<td>Open</td>
<td>Ctrl + O</td>
</tr>
<tr>
<td>Print</td>
<td>Ctrl + P</td>
</tr>
<tr>
<td>Quit</td>
<td>Ctrl + Q</td>
</tr>
<tr>
<td>Rotate page(s)</td>
<td>Ctrl + R</td>
</tr>
<tr>
<td>Save</td>
<td>Ctrl + S</td>
</tr>
<tr>
<td>Crop page(s)</td>
<td>Ctrl + T</td>
</tr>
<tr>
<td>Paste</td>
<td>Ctrl + V</td>
</tr>
<tr>
<td>Result</td>
<td>Keystroke</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>-----------------</td>
</tr>
<tr>
<td>Close</td>
<td>Ctrl + W</td>
</tr>
<tr>
<td>Cut</td>
<td>Ctrl + X</td>
</tr>
<tr>
<td>Undo</td>
<td>Ctrl + Z</td>
</tr>
<tr>
<td>Fit in window</td>
<td>Ctrl + 0</td>
</tr>
<tr>
<td>Actual size</td>
<td>Ctrl + 1</td>
</tr>
<tr>
<td>Fit width</td>
<td>Ctrl + 2</td>
</tr>
<tr>
<td>Fit visible</td>
<td>Ctrl + 3</td>
</tr>
<tr>
<td>Zoom-in</td>
<td>Ctrl + +</td>
</tr>
<tr>
<td>Zoom-out</td>
<td>Ctrl + -</td>
</tr>
<tr>
<td>Previous (search)</td>
<td>Ctrl + [</td>
</tr>
<tr>
<td>Next (search)</td>
<td>Ctrl + ]</td>
</tr>
<tr>
<td>Zoom-in temporarily</td>
<td>Ctrl + Spacebar</td>
</tr>
<tr>
<td>Zoom-out temporarily</td>
<td>Alt + Ctrl + Spacebar</td>
</tr>
<tr>
<td>Switch scripts</td>
<td>Ctrl + F1</td>
</tr>
<tr>
<td>Deselect all</td>
<td>Shift + Ctrl + A</td>
</tr>
<tr>
<td>Delete page(s)</td>
<td>Shift + Ctrl + D</td>
</tr>
<tr>
<td>Insert page(s)</td>
<td>Shift + Ctrl + I</td>
</tr>
<tr>
<td>Page setup</td>
<td>Shift + Ctrl + P</td>
</tr>
<tr>
<td>Save as</td>
<td>Shift + Ctrl + S</td>
</tr>
<tr>
<td>Word Assistant</td>
<td>Shift + Ctrl + W</td>
</tr>
<tr>
<td>Use local fonts</td>
<td>Shift + Ctrl + Y</td>
</tr>
<tr>
<td>Show/Hide Grid</td>
<td>Ctrl + U</td>
</tr>
<tr>
<td>Snap to Grid</td>
<td>Shift + Ctrl + U</td>
</tr>
<tr>
<td>Proof Colors</td>
<td>Ctrl + Y</td>
</tr>
<tr>
<td>Rotate Clockwise</td>
<td>Shift + Ctrl + +</td>
</tr>
<tr>
<td>Rotate Counterclockwise</td>
<td>Shift + Ctrl + -</td>
</tr>
<tr>
<td>Add new bookmark</td>
<td>Ctrl + B</td>
</tr>
</tbody>
</table>
# Searching

<table>
<thead>
<tr>
<th>Result</th>
<th>Keystroke</th>
</tr>
</thead>
<tbody>
<tr>
<td>Find</td>
<td>Ctrl + F</td>
</tr>
<tr>
<td>Find again</td>
<td>Ctrl + G</td>
</tr>
<tr>
<td>Find first suspect</td>
<td>Ctrl + H</td>
</tr>
<tr>
<td>Query</td>
<td>Shift + Ctrl + F</td>
</tr>
<tr>
<td>Search results</td>
<td>Shift + Ctrl + G</td>
</tr>
<tr>
<td>Previous document (search)</td>
<td>Shift + Ctrl + [</td>
</tr>
<tr>
<td>Next document (search)</td>
<td>Shift + Ctrl + ]</td>
</tr>
</tbody>
</table>

# Document Information and Preferences

<table>
<thead>
<tr>
<th>Result</th>
<th>Keystroke</th>
</tr>
</thead>
<tbody>
<tr>
<td>Document Summary dialog box</td>
<td>Ctrl + D</td>
</tr>
<tr>
<td>General Preferences dialog box</td>
<td>Ctrl + K</td>
</tr>
</tbody>
</table>

# Windows

<table>
<thead>
<tr>
<th>Result</th>
<th>Keystroke</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cascade</td>
<td>Shift + Ctrl + J</td>
</tr>
<tr>
<td>Tile horizontally</td>
<td>Shift + Ctrl + K</td>
</tr>
<tr>
<td>Tile vertically</td>
<td>Shift + Ctrl + L</td>
</tr>
<tr>
<td>Close all</td>
<td>Alt + Ctrl + W</td>
</tr>
</tbody>
</table>

# Miscellaneous

<table>
<thead>
<tr>
<th>Result</th>
<th>Keystroke</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open Web Page</td>
<td>Shift + Ctrl + O</td>
</tr>
<tr>
<td>Summarize Comments</td>
<td>Shift + Ctrl + T</td>
</tr>
<tr>
<td>Select Indexes</td>
<td>Shift + Ctrl + X</td>
</tr>
</tbody>
</table>
Mac OS Shortcuts

Selecting tools

<table>
<thead>
<tr>
<th>Tool</th>
<th>Keystroke</th>
</tr>
</thead>
<tbody>
<tr>
<td>Article</td>
<td>A</td>
</tr>
<tr>
<td>Crop</td>
<td>C</td>
</tr>
<tr>
<td>Form</td>
<td>F</td>
</tr>
<tr>
<td>Hand</td>
<td>H</td>
</tr>
<tr>
<td>Link</td>
<td>L</td>
</tr>
<tr>
<td>Movie</td>
<td>M</td>
</tr>
<tr>
<td>Pencil</td>
<td>N</td>
</tr>
<tr>
<td>TouchUp object</td>
<td>O</td>
</tr>
<tr>
<td>Notes tool</td>
<td>S</td>
</tr>
<tr>
<td>TouchUp text</td>
<td>T</td>
</tr>
<tr>
<td>Highlight text</td>
<td>U</td>
</tr>
<tr>
<td>Text select tool</td>
<td>V</td>
</tr>
<tr>
<td>Zoom in tool</td>
<td>Z</td>
</tr>
<tr>
<td>Zoom out tool</td>
<td>Shift + Z</td>
</tr>
<tr>
<td>Hidden Pencil tools: line, rectangle, ellipse</td>
<td>Shift + N</td>
</tr>
<tr>
<td>Hidden Notes tools: text comment, audio comment, stamp, file comment</td>
<td>Shift + S</td>
</tr>
<tr>
<td>Hidden Text Select tools: column select, graphics select, table select</td>
<td>Shift + V</td>
</tr>
<tr>
<td>Hidden Highlight tools: strikethrough, underline</td>
<td>Shift + U</td>
</tr>
<tr>
<td>Hidden TouchUp Text tools: touch up object</td>
<td>Shift + T</td>
</tr>
<tr>
<td>Graphics Select</td>
<td>G</td>
</tr>
</tbody>
</table>
## Navigation

<table>
<thead>
<tr>
<th>Result</th>
<th>Keystroke</th>
</tr>
</thead>
<tbody>
<tr>
<td>Previous screen</td>
<td>Page Up</td>
</tr>
<tr>
<td>Next screen</td>
<td>Page Down</td>
</tr>
<tr>
<td>Temporarily select hand tool</td>
<td>Spacebar</td>
</tr>
<tr>
<td>First page</td>
<td>Home</td>
</tr>
<tr>
<td>Last page</td>
<td>End</td>
</tr>
<tr>
<td>Delete/clear</td>
<td>Del</td>
</tr>
<tr>
<td>Previous page</td>
<td>Left Arrow</td>
</tr>
<tr>
<td>Next page</td>
<td>Right Arrow</td>
</tr>
<tr>
<td>Scroll up</td>
<td>Up Arrow</td>
</tr>
<tr>
<td>Scroll down</td>
<td>Down Arrow</td>
</tr>
<tr>
<td>Show/Hide full screen</td>
<td>Cmd + L</td>
</tr>
<tr>
<td>Go to page</td>
<td>Cmd + N</td>
</tr>
<tr>
<td>Previous page</td>
<td>Left Arrow</td>
</tr>
<tr>
<td>Go to Previous View</td>
<td>Cmd + Left Arrow</td>
</tr>
<tr>
<td>Go to Next View</td>
<td>Cmd + Right Arrow</td>
</tr>
<tr>
<td>Next page</td>
<td>Right Arrow</td>
</tr>
<tr>
<td>First page</td>
<td>Shift + Cmd + Page Up</td>
</tr>
<tr>
<td>Last page</td>
<td>Shift + Cmd + Page Down</td>
</tr>
<tr>
<td>Go to Previous Document</td>
<td>Option + Shift + Left Arrow</td>
</tr>
<tr>
<td>Go to Next Document</td>
<td>Option + Shift + Right Arrow</td>
</tr>
<tr>
<td>First page</td>
<td>Shift + Cmd + Up Arrow</td>
</tr>
<tr>
<td>Last page</td>
<td>Shift + Cmd + Down Arrow</td>
</tr>
<tr>
<td>Next tab in Navigation pane, Next toolbar in menu mode,</td>
<td>Cmd + Tab</td>
</tr>
<tr>
<td>Next tab in tabbed dialog boxes, Next window in</td>
<td></td>
</tr>
<tr>
<td>document view</td>
<td></td>
</tr>
</tbody>
</table>
Function Keys

<table>
<thead>
<tr>
<th>Result</th>
<th>Keystroke</th>
</tr>
</thead>
<tbody>
<tr>
<td>Help</td>
<td>F1</td>
</tr>
<tr>
<td>Show/Hide bookmarks</td>
<td>F5</td>
</tr>
<tr>
<td>Next pane</td>
<td>F6</td>
</tr>
<tr>
<td>Spell check</td>
<td>F7</td>
</tr>
<tr>
<td>Show/Hide toolbars</td>
<td>F8</td>
</tr>
<tr>
<td>Find/Find Again</td>
<td>Cmd + F, Cmd + G</td>
</tr>
<tr>
<td>Context menus</td>
<td>Control + click</td>
</tr>
<tr>
<td>In Navigation pane, goes to document view and leaves Navigation pane open</td>
<td>Shift + F6</td>
</tr>
<tr>
<td>Next secondary window</td>
<td>Option + F6</td>
</tr>
<tr>
<td>Show/Hide thumbnails</td>
<td>F4</td>
</tr>
<tr>
<td>Show/Hide Menu Bar</td>
<td>F9</td>
</tr>
</tbody>
</table>

Editing Documents

<table>
<thead>
<tr>
<th>Result</th>
<th>Keystroke</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select all</td>
<td>Cmd + A</td>
</tr>
<tr>
<td>Copy</td>
<td>Cmd + C</td>
</tr>
<tr>
<td>Zoom to</td>
<td>Cmd + M</td>
</tr>
<tr>
<td>Open</td>
<td>Cmd + O</td>
</tr>
<tr>
<td>Print</td>
<td>Cmd + P</td>
</tr>
<tr>
<td>Quit</td>
<td>Cmd + Q</td>
</tr>
<tr>
<td>Rotate page(s)</td>
<td>Cmd + R</td>
</tr>
<tr>
<td>Save</td>
<td>Cmd + S</td>
</tr>
<tr>
<td>Crop page(s)</td>
<td>Cmd + T</td>
</tr>
<tr>
<td>Paste</td>
<td>Cmd + V</td>
</tr>
<tr>
<td>Close</td>
<td>Cmd + W</td>
</tr>
<tr>
<td>Cut</td>
<td>Cmd + X</td>
</tr>
<tr>
<td>Undo</td>
<td>Cmd + Z</td>
</tr>
<tr>
<td>Result</td>
<td>Keystroke</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>--------------------</td>
</tr>
<tr>
<td>Fit in window</td>
<td>Cmd + 0</td>
</tr>
<tr>
<td>Actual size</td>
<td>Cmd + 1</td>
</tr>
<tr>
<td>Fit width</td>
<td>Cmd + 2</td>
</tr>
<tr>
<td>Fit visible</td>
<td>Cmd + 3</td>
</tr>
<tr>
<td>Zoom-in</td>
<td>Cmd + +</td>
</tr>
<tr>
<td>Zoom-out</td>
<td>Cmd + -</td>
</tr>
<tr>
<td>Previous (search)</td>
<td>Cmd + [</td>
</tr>
<tr>
<td>Next (search)</td>
<td>Cmd + ]</td>
</tr>
<tr>
<td>Zoom in temporarily</td>
<td>Cmd + Spacebar</td>
</tr>
<tr>
<td>Zoom out temporarily</td>
<td>Option + Cmd + Spacebar</td>
</tr>
<tr>
<td>Deselect all</td>
<td>Shift + Cmd + A</td>
</tr>
<tr>
<td>Delete page(s)</td>
<td>Shift + Cmd + D</td>
</tr>
<tr>
<td>Insert page(s)</td>
<td>Shift + Cmd + I</td>
</tr>
<tr>
<td>Page setup</td>
<td>Shift + Cmd + P</td>
</tr>
<tr>
<td>Save as</td>
<td>Shift + Cmd + S</td>
</tr>
<tr>
<td>Word Assistant</td>
<td>Shift + Cmd + W</td>
</tr>
<tr>
<td>Use local fonts</td>
<td>Shift + Cmd + Y</td>
</tr>
<tr>
<td>Show/Hide Grid</td>
<td>Cmd + U</td>
</tr>
<tr>
<td>Snap to Grid</td>
<td>Shift + Cmd + U</td>
</tr>
<tr>
<td>Proof Colors</td>
<td>Cmd + Y</td>
</tr>
<tr>
<td>Rotate Clockwise</td>
<td>Shift + Cmd + +</td>
</tr>
<tr>
<td>Rotate Counterclockwise</td>
<td>Shift + Cmd + -</td>
</tr>
<tr>
<td>Add New bookmark</td>
<td>Cmd + B</td>
</tr>
</tbody>
</table>
### Searching

<table>
<thead>
<tr>
<th>Result</th>
<th>Keystroke</th>
</tr>
</thead>
<tbody>
<tr>
<td>Find</td>
<td>Cmd + F</td>
</tr>
<tr>
<td>Find again</td>
<td>Cmd + G</td>
</tr>
<tr>
<td>Find first suspect</td>
<td>Cmd + H</td>
</tr>
<tr>
<td>Query</td>
<td>Shift + Cmd + F</td>
</tr>
<tr>
<td>Search results</td>
<td>Shift + Cmd + G</td>
</tr>
<tr>
<td>Previous document (search)</td>
<td>Shift + Cmd + [</td>
</tr>
<tr>
<td>Next document (search)</td>
<td>Shift + Cmd + ]</td>
</tr>
</tbody>
</table>

### Document Information and Preferences

<table>
<thead>
<tr>
<th>Result</th>
<th>Keystroke</th>
</tr>
</thead>
<tbody>
<tr>
<td>Document Summary dialog box</td>
<td>Cmd + D</td>
</tr>
<tr>
<td>General preferences dialog box</td>
<td>Cmd + K</td>
</tr>
</tbody>
</table>

### Windows

<table>
<thead>
<tr>
<th>Result</th>
<th>Keystroke</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cascade</td>
<td>Shift + Cmd + J</td>
</tr>
<tr>
<td>Tile horizontally</td>
<td>Shift + Cmd + K</td>
</tr>
<tr>
<td>Tile vertically</td>
<td>Shift + Cmd + L</td>
</tr>
<tr>
<td>Close all</td>
<td>Option + Cmd + W</td>
</tr>
</tbody>
</table>

### Miscellaneous

<table>
<thead>
<tr>
<th>Result</th>
<th>Keystroke</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open Web Page</td>
<td>Shift + Cmd + O</td>
</tr>
<tr>
<td>Summarize comments</td>
<td>Shift + Cmd + T</td>
</tr>
<tr>
<td>Select Indexes</td>
<td>Shift + Cmd + X</td>
</tr>
</tbody>
</table>
Index

A
accessibility
  changing focus areas 5
custom color scheme 7
dialog box keystrokes 6
document box keystrokes 5
floating palette keystrokes 6
focus areas 5
Menu bar keystrokes 5
Microsoft Internet Explorer 5
navigation pane keystrokes 6
preferences 7
screen reader options 7
screen readers 5
tagged PDF files 4
toolbar keystrokes 6
Accessibility preferences 17
Acrobat Reader, as a helper application 15
Actual Size command 9
articles, navigating 14
Asian fonts
downloading 17
printing as bitmap images 17

B
bookmarks
  font (UNIX) 34
  Hide After Use command 13
  levels 13
  navigating with 12
  palette 12
Boolean operators 23, 26
byte-serving. See Fast Web View

C
clearing forms 29
color scheme, accessibility 7
comments
  preferences 28
  reviewing 28
Continuous layout 9
Continuous-Facing layout 9
copying
  and selecting text 30
  graphics to Clipboard 30

D
Date Info fields 25
dialog box keystrokes 6
digital signatures 29
Display preferences
  Application Language 18
  Default Page Layout 18
  Default Zoom 18
  Display Pate To Edge 18
  Display Transparency Grid 18
  Max Fit Visible 18
  Page Units 18
  Smoothing 18
  Use CoolType 18
  Use Greek Text Below 18
Document First Page command 12
Document Info fields
  Boolean operators in 26
  searching with 25
  wild-card characters in 27
Document Last Page command 12
document pane, keystrokes 5
Document Properties, Summary 20
downloading from the Web, page-at-a-time 15
F
Fast Web View, enabling 15
Find Again command 20
Find Backwards 21
Find button 20, 21
Find command 20, 21
Find Current Bookmark command 13
Find options
  Ignore Asian Character Widths 21
  Match Case 21
  Match Whole Word 21
First Page button 12
Fit in Window button 9
Fit Visible command 9
Fit Width button 9
floating palette keystrokes 6
focus areas, changing 5
fonts
  information on 20
  UNIX 33
Forms preferences 18
forms, clearing in a browser 29
Full Screen command 10
Full Screen preferences 10, 18
Full Screen view
  about 8
  preferences 10

G
general document information 20
General preferences, setting 17
Go Back button 14
Go Forward button 14
Go To Next View button 14
Go To Page command 12
Go To Previous View button 14
graphics select tool 30

H
hand tool 8, 13
Help 1
  helper application, Acrobat as 15
  Hide After Use command, for bookmarks 13
  Highlight Next/Previous button 15
  identity preferences 18
  information about documents 20
  jumping to pages 12
  Last Page button 12
  license files 31
  links, following 13
  Magnification
    decreasing 8
    increasing 8
  Menu bar, keystroke access 5
  Microsoft Internet Explorer
    accessibility 5
    Tab key navigation 5
  movies
    playing 28
    system requirements 28

N
navigation pane, keystrokes 6
navigational structures
  articles 12
  bookmarks 12
  links 12
  thumbnails 12
Next Page button 11, 12
nppdf32.dll file, installing 16

O
online Help 1
Open button 8
Open command 8
opening PDF files 7
Options preferences
  Allow Background Downloading 18
  Allow Fast Web 18
  Allow File Open Actions 19
  Certified Plug-ins Only 19
  Check Browser Settings 18
  Display PDF In Browser 18
  Display Splash Screen At Startup 19
  Open Cross-Document Links In Same Window 19
  Reset All Warnings 19
  Use Logical Page Numbers 19
  Use Page Cache 19
orientation, changing 10

P
Page Down/Up button 12
page layouts
  Continuous 9
  Continuous-Facing 9
  setting 9 9
  Single Page 9
page orientation 9
page-at-a-time downloading 15
PDF documents
  finding words in 20
  getting information on 20
  locked 31
PDFViewer plug-in, installing 16
PICT format 30
plug-ins, UNIX 33
preferences
  Accessibility 7
  Full Screen 10
  General 17
Previous Page button 11
Print button 16
printing
  general options 16
  general page setup 16

general, download Asian fonts 17
general, font substitution 17
general, printing as images 17
UNIX 34
Proximity option 23
Proximity option in searches 23

Q
queries
  Boolean operators in 26
  expanding 27
  limiting searches 27
  terms or phrases 26
  Word Assistant 25
query command 22

R
reading articles 13
relevancy ranking 23
resizing
  magnifying and reducing 8
  page views 9
  pages 9
  using thumbnails 9
resources, UNIX 33
Rotate View Clockwise button 10
Rotate View Counter-Clockwise button 10
rotating pages 10
rotation tools 10

S
screen reader, delivery options 7
Search command
  full-text search 22
  using 22
search results
  document title or filename 20
  PDF documents in Web site 15
  viewing 23
Search Results window 24
searching indexes
  Boolean operators in 23, 26
customizing index selection 22
expanding a search 27
full-text search 22
limiting searches 27
queries 25
Query command 22
query defined 21
refining searches 24
relevancy ranking 23
Search command 22
selecting an index 22
terms or phrases 26
using Word Assistant 24
viewing results 23
wild-card characters 23
with Date Info 25
with Document Info 25
searching, in Web browsers 15
Select All command 9, 30
Select Indexes command 22
selecting and copying text 30
Show Clipboard command 30
Single Page layout 9
sound, system requirements 28
Sounds Like option 22, 25
system requirements for movie and sound files 28

T
text select tool 30
Thesaurus 23, 25
Thumbnails palette, opening 9
thumbnails, resizing view 9
tips
expanding an index search 27
limiting index searches 27
toolbar keystrokes 6

U
Update preferences 19
Use Logical Page Numbers option 12

V
viewers, multiple (UNIX) 33
viewing path, retracing 14
viewing PDF documents
magnification 8
on the Web 15

W
Web browsers
configuring 15
displaying PDF documents 14
installing 16
searching in 15
Web Buy
downloading plug-in 32
Other Identifier 31
preferences 31
Select Other Identifiers 31
setting preferences 31
updating plug-in 32
Web Buy preferences 19
wild-card characters 23
WMF format 30
Word Assistant command 24
Word Assistant, using in searches 24
word search options
expanding a search 27
limiting searches 27
Match Case 23
Proximity 23
selecting 25
Sounds Like 22
Thesaurus 23
Word Stemming 22
Word Stemming option 22, 25

X
Xdefaults 33
XPIXMAP format 30

Z
zoom tools 9
Legal Notices

Copyright

© 2000 Adobe Systems Incorporated. All rights reserved.

Adobe® Acrobat® 5.0 User Guide for Windows® and Macintosh

This manual, as well as the software described in it, is furnished under license and may be used or copied only in accordance with the terms of such license. The content of this manual is furnished for informational use only, is subject to change without notice, and should not be construed as a commitment by Adobe Systems Incorporated. Adobe Systems Incorporated assumes no responsibility or liability for any errors or inaccuracies that may appear in this documentation. Except as permitted by such license, no part of this publication may be reproduced, stored in a retrieval system, or transmitted, in any form or by any means, electronic, mechanical, recording, or otherwise, without the prior written permission of Adobe Systems Incorporated.

Please remember that existing artwork or images that you may want to include in your project may be protected under copyright law. The unauthorized incorporation of such material into your new work could be a violation of the rights of the copyright owner. Please be sure to obtain any permission required from the copyright owner.

Any references to company names in sample templates are for demonstration purposes only and are not intended to refer to any actual organization.

Adobe, the Adobe logo, Acrobat, Acrobat Catalog, Acrobat Distiller, Acrobat Exchange, Acrobat Reader, Acrobat Search, Adobe Type Manager, ATM, FrameMaker, Illustrator, ImageReady, PageMaker, Photoshop, and PostScript are either registered trademarks or trademarks of Adobe Systems Incorporated in the United States and/or other countries. ActiveX, Microsoft, Windows and Windows NT are either registered trademarks or trademarks of Microsoft Corporation in the United States and/or other countries. Apple, ColorSync, Mac, Macintosh, Power Macintosh, QuickTime, and TrueType are trademarks of Apple Computer, Inc. registered in the U.S. and other countries. QuickTime and the QuickTime logo are trademarks used under license. Pentium is a registered trademark of Intel Corporation. Java, Java Applet, and JavaScript and are trademarks or registered trademarks of Sun Microsystems, Inc. in the United States and other countries. All other trademarks are the property of their respective owners.

The TWAIN Toolkit is distributed as is. The developer and distributors of the TWAIN Toolkit expressly disclaim all implied, express or statutory warranties including, without limitation, the implied warranties of merchantability, noninfringement of third party rights and fitness for a particular purpose. Neither the developers nor the distributors will be liable for damages, whether direct, indirect, special, incidental, or consequential, as a result of the reproduction, modification, distribution, or other use of the TWAIN Toolkit.

Portions of Adobe Acrobat include technology used under license of Verity, Inc. and are copyrighted.
Contains an implementation of the LZW algorithm licensed under U.S. Patent 4,558,302.
Adobe Systems Incorporated, 345 Park Avenue, San Jose, California 95110, USA.

Notice to U.S. government end users. The software and documentation are “commercial items,” as that term is defined at 48 C.F.R. §2.101, consisting of “commercial computer software” and “commercial computer software documentation,” as such terms are used in 48 C.F.R. §12.212 or 48 C.F.R. §227.7202, as applicable. Consistent with 48 C.F.R. §12.212 or 48 C.F.R. §§227.7202-1 through 227.7202-4, as applicable, the commercial computer software and commercial computer software documentation are being licensed to U.S. government end users (A) only as commercial items and (B) with only those rights as are granted to all other end users pursuant to the terms and conditions set forth in the Adobe standard commercial agreement for this software. Unpublished rights reserved under the copyright laws of the United States.